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INTRODUCTION

Thank you for choosing the Mitsubishi MELSOFT Series Integrated FA software.
Read this manual and make sure you understand the functions and performance of MELSOFT series
thoroughly in advance to ensure correct use.
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1 Introduction MELSOFT

1 Introduction

GX Configurator-ST is used for the configuration and diagnosis of SLICE systems.

MELSEC-ST systems consist of a head module (ST1H-PB for PROFIBUS-DP systems or
ST1H-BT for CC-Link systems) and a number of power supply or I/O modules assembled in
a rack.

These systems provide an easy and modular way to add 1/0 to a PROFIBUS-DP or CC-Link
system, without having to install separate wiring to many separate I/O modules. The 1/O
from each module is grouped into individual data input/output areas for transmission to/from
the network master station.

GX Configurator-ST connects to the communication port of the ST1H-PB or ST1H-BT head
module using an appropriate programming cable. The head module will independently act as
a slave station on a PROFIBUS-DP or CC-Link network.

. ST1H-BT
GX Configurator-ST II RS232 cable W
| | ol
= -l_ . : J{ a0 0
— K Setting/Status
monitor 1[ :
Master station @NE%EEE%EEE
MELSEC-5T system
CC-Link dedicated cable

Example CC-link system
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1.1  Safety Precautions

® SAFETY PRECAUTIONS @

(Read these precautions before using.)

When using Mitsubishi equipment, thoroughly read this manual and the associated manuals
introduced in this manual. Also pay careful attention to safety and handle the module properly.

The precautions given in this manual are concerned with this product. Refer to the user's manual of
the network system to use for a description of the network system safety precautions.

These SAFETY PRECAUTIONS classify the safety precautions into two categories: "DANGER" and

"CAUTION".

. Indicates that incorred handling may cause hazardous conditions, :
: |~ DANGER rezulting in death or severe injury. :
1 |
I |
L Indicates that incorrect handling may cause hazardous conditions, i
I |
¥ :i CAUTION resulting in medium or =light perzonal injuny or physical damage. ___'

Depending on circumstances, procedures indicated by . CAUTION may also be linked to serious
results.
In any case, it is important to follow the directions for usage.

Store this manual in a safe place so that you can take it out and read it whenever necessary. Always
forward it to the end user.

[Design Instructions]

& DANGER

¢ For data change and status control made to the MELSEC-ST system which is running from a
Personal computer, configure the interlock circuit externally so that the system safety is
ensured. The action to be taken for the system at the occurrence of communication errors
caused by such as loose cable connection must be determined for online operation of
MELSEC-ST system from Personal computers.

4 CAUTION

» Be sure to read the manual careful and exercise an appropriate amount of caution
connecting to MELSEC-ST system and performing online operations (head module
resetting, forced output test, etc.) while the personal computer is operating.

¢ When replacing the module online, make sure to observe the procedure specified for the
module.
For I/0 module, refer to the chapter of online module change in the head module user's
manual; for each intelligent function module, refer to the same chapter in the corresponding
intelligent function module user's manual.
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1.2

Documentation layout

MELSOFT

Each topic is divided in sections as shown below.

—d ({I;rj PURPOSE

Purpose of operation explained in
each chapter. section or paragraph.

BASIC OPERATION

Operation to be performed until the
actual operation screen appears.

10.1 Transfer setup

COM Fait
Tramsmizsian Speed |
Timenit
\ Ok i

s ~
- {-{) PURPOSE
\ Sets the connection with the head module ¥
4 i i
wF

¥

BASIC OPERATION

(1) Click the [Online] = [Transfer Setup] menu.
i {2) Make setting and click :ne hutton.

-

Transfer Setup

DISPLAY/SETTING SCREEN

.@ DISPLAY/SETTING DATA

# B

Item Description
~OM Port .Selm.:t the COM port connectsd with the |'1_|=?ad maodule.
{Setting range: COM1 to COM10, default - COM1T)
i Select the fransmission spesd.
Transmission Speed ; ; -x
{Setting rangs: 9.6kbps, 19.2kbps, 38 4kbps, 57.6kbps, defaull ' 9.8kbps)

DISPLAY/SETTING SCREEN

Screen used to make setting or

provide display for the purpose
being described.

;@ DISPLAY/SETTING DATA

Explains the displayfsetting screen items =
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In addition, there are also the following explanations.

i#' HELPAUR OPERATION

Describes application operation if there are multiple purposes and the basic operation and
display/setting data do not provide enough information.

D

Provides information relevant to that page, e.g. the items you should be careful of and the functions
you should know.

The following table lists the symbols used in this manual and their definitions.

Symbol Description

Represents the menu name of the menu bar.
[ ] [ 171 ] indicates a drop-down menu.

Example: [File] — [New] menu

Represents the tool button on the toolbar corresponding to the drop-down menu.

Example: [File] — [Save] menu (E)
Represents the item name in the dialog box.

Example: "File name”

Represents a button.
Example: button

Represents the tab in the dialog box.

<< >>
Example: <<Verify All Modules>> tab
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How to read manual (For CC-Link)
(1) Data symbol
<Example :[Cr] Commard result aree>
Cr. 0 (7-0)
B S, 1
— Range
In the case of 1-word {16bit) data, this shows the
comesponding range.
{0} :Shows 0 bl posttion.
{7-0) : Shows -7 bit range.
— Datall data No.
—— Abbreviated data symbol
For detalls of deta1 data No. and abbreviated data symbol,refer to {2} and (3)
(2) Head Module > Master Station
(a) Remote input (RX)
Data symbol Area name Unit Detail data No. notation
to Bit input area 1 bit / symbol Hexadecimal
(b) Remote register (RWr)
Data symbol Area name Unit Detail data No. notation
W00 1o [Wrn Word input area 1 word / symbol Hexadecimal
(c) Message transmission
Data symbol Area name Unit Detail data No. notation
Cr0 to [Crn Command result area | 1 word / symbol Decimal
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(3) Master station > Head module

(a) Remote output (RY)

Data symbol Area name Unit Detail data No. notation
[Bw.00] 1, [BW.N Bit output area 1 bit / symbol Hexadecimal
(b) Remote register (RWw)

Data symbol Area name Unit Detail data No. notation
[Ww.00] 1, | YWW.n Word output area 1 word / symbol Hexadecimal
(c) Message transmission

Data symbol Area name Unit Detail data No. notation
to Command execution | 1 word / symbol Decimal

area

How to read manual (For PROFIBUS-DP)

(1) Data symbol
<Example :[Cr] Commard result aree>

Cr.0(7:0)

In the casa of 1-word {16bit) data, this shows the
comesponding range.

{0} :Shows 0 bl posttion.

{70} : Shows 0-7 bit rnge.

— Datall data No.

L Abbreviated data symbol
For detalls of data-1 data No. and abbreviated data symbol,refer to {2) and (3}
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(2)

Input send data

Data symbol Area Unit Detail data No. notation
to Bit Input Area 1 bit / symbol Hexadecimal
to Error Information Area 1 bit / symbol Hexadecimal
[Mr] to LMr.127 | IModule Status Area 1 bit / symbol Decimal
*1 Command Result Area 1 word / symbol Decimal
W0 g Word Input Area 1 word / symbol Hexadecimal

*1: The detailed area of the command result area uses the following symbols.
Data symbol Area
Cr.f (15-8}| JCommand Execution Result
: :

Cr.0(7-0 Start Slice No. of Execution Target

Executed Command No.

Response Data 1

Cr.3 Response Data 2

(3) Output receive data

Data symbol Area Unit Detail data No. notation
[Bw| |[Bw.00]o [Bw.FF]|Bit Output Area 1 bit / symbol Hexadecimal
| Ew| Ew B0 | (o |[EW.FF| |Error Clear Area 1 bit / symbol Hexadecimal
| Sw | [Sw.0] to LSw.7| JSystem Area 1 word /symbol Decimal
*1 Command Execution Area 1 word / symbol Decimal
Ww 00| 1o [ WWw 33 [JWord Output Area 1 word / symbol Hexadecimal

execution area.

Data symbol Area
Cw.[ Start Slice No. of Execution Target
Cw.1 Command No. to be executed
Cw.2 Argument 1
Cw.3 Argument 2

*1: Following shows the data symbols and the corresponding detail areas within the command
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1.3

Terms and Abbreviations

Unless otherwise specified, this documentation uses the following terms and abbreviations to explain

the head module.

Term/Abbreviation

Description

Head module

Generic term for the ST1H-PB MELSEC-ST PROFIBUS-DP head module,
ST1H-BT MELSEC-ST CC-Link head module.

PROFIBUS-DP Abbreviation for PROFIBUS-DP network.

CC-Link Abbreviation for Control & Communication Link system.
Master module Abbreviation for the QJ61BT11N used as a master station.
RDMSG Generic term for G.RDMSG and GP.RDMSG.

Bus refreshing module

Module that distributes external system power and auxiliary power to the head
module and slice modules.

Power feeding module

Module that distributes external auxiliary power to slice modules.

Power distribution module

Generic term for the bus refreshing module and power feeding module.

Base module

Generic term for a module that transfers data between the head module and slice
modules, and between the slice modules and external devices (including wiring).

Input module

Generic term for modules that handle input data in units of bits.

QOutput module

Generic term for modules that handle output data in units of bits.

Intelligent function module

Generic term for modules that handle input/output data in units of words.

I/0 module

Generic term for input modules and output modules.

Slice module

Generic term for power distribution modules, I/O modules, and intelligent function
modules that can be mounted on base modules.

MELSEC-ST system

Generic term for a system that is that is composed of a head module, slice
modules, an end plate and end brackets.

External power supply

Generic term for external system power and auxiliary power.

GX Configurator-ST

Generic product name for SWnD5C-STPB-E. (“n” denotes Version 1 or later.)

Configuration software

Software used to set slave parameters for head modules and slice modules in
PROFIBUS-DP. (e.g. GX Configurator-DP).

MELSOFT
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Term definition for CC-Link

The following explains the meanings and definitions of the terms used in this documentation when

using CC-Link.

Term/Abbreviation

Description

Cyclic transmission

A communication method by which remote I/O data and remote register data are
transferred periodically.

Master station

This station controls the entire data link system.
One master station is required for one system.

Local station

A station that has a programmable controller CPU and can communicate with the
master station and other local stations.

Remote I/O station

A remote station that can only use bit data. (Input from or output to external
devices)
(AJ65BTB1-16D, AJ65SBTB1-16D or others).

Remote device station

A remote station that can use both bit and word data. (Input from or output to
external devices, analog data conversion) (ST1H-BT, AJ65BT-64AD,
AJ65BT-64DAV, AJ65BT-64DAI or others)

Remote station

Generic term for remote 1/O stations and remote device stations.
Controlled by the master station.

SB

Link special relay (for CC-Link).
Bit data that indicate the module operating status and data link status of the
master/local station.

SwW

Link special register (for CC-Link).
Data in units of 16 bits, which indicate the module operating status and data link
status of master/local station.

RX

Remote input (for CC-Link).
Bit data that are input from remote stations to the master station.

RY

Remote output (for CC-Link).
Bit data that are output from the master station to remote stations.

RWr

Remote register (Read area for CC-Link).

Data in units of 16 bits, which are input from remote device stations to the master
stations.

RWw

Remote register (Write area for CC-Link).
Data in units of 16 bits, which are output from the master station to remote device
stations.

Remote net Ver. 1 mode

Select this mode when extended cyclic setting is not needed or when the
QJ61BT11 is replaced with the QJ61BT11N.

Remote net Ver. 2 mode

Select this mode when creating a new system with extended cyclic setting.

1/0 data

Data transferred between the head module and the master station.

Bit input area

Bit input data of each module.
Input data are sent from the head module to the master station through remote
input (RX).

Bit output area

Bit output data of each module.
Output data are received from the master station to the head module through
remote output (RY).

Word input area

Word (16-bit) input data of an intelligent function module.
Input data are sent from the head module to the master station through remote
register (RWr).

Word output area

Word (16-bit) output data of an intelligent function module.
Output data are received from the master station to the head module through
remote register (RWw).

Command result

area

Information that indicates a command result.
This information is stored in Setting data (area starting from (D1) + 1) of the

RDMSG instruction of the master station.
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Term/Abbreviation

Description

Command

execution area

Information for executing a command.
This information is stored in Setting data (area starting from (S2) + 1) of the
RDMSG instruction of the master station.

Number of occupied /O
points

The area, which is equivalent to the occupied I/O points, is occupied in Bit
input area / Bit output area.

Slice No.

The number assigned to every 2 occupied I/O points of each module.

The numbers are assigned in ascending order, starting from “0” of the head
module. (The maximum value is 127.)

This is used for specifying a command execution target.

Slice position No.

The number that shows where the slice module is physically installed.

The numbers are assigned in ascending order, starting from “0” of the head
module. (The maximum value is 63.)

This is used for specifying a command execution target.

Start slice No.

The start slice No. assigned to the head module and slice modules.

Command

Generic term for requests that are executed by the master station for reading each
module’s operation status, setting intelligent function module command parameters
or various controls.

Command parameter

Generic term for parameter set in commands or GX Configurator-ST.
All of the parameters set for the head module and slice modules are command
parameters.

ST bus cycle time

Processing time for the head module to refresh the input or output status of each
slice module.

10



1 Introduction

MELSOFT

Term definition for PROFIBUS-DP

The following explains the meanings and definitions of the terms used in this documentation when

using PROFIBUS-DP.

Term/Abbreviation

Description

QJ71PB92V Abbreviation for the QJ71PB92V PROFIBUS-DP master module.
QJ71PB92D Abbreviation for the QJ71PB92D PROFIBUS-DP interface module.
A1SJ71PB92D Abbreviation for the A1SJ71PB92D PROFIBUS-DP interface module.
AJ71PB92D Abbreviation for the AJ71PB92D PROFIBUS-DP interface module.

PROFIBUS-DPVO

A basic version of PROFIBUS-DP.
The following functions are executable:
* 1/O data exchange

* Diagnostic information notification
etc.

PROFIBUS-DPV1

A PROFIBUS-DP version for which the following functions have been added to the
basic functionality of PROFIBUS-DPV0
* Acyclic communication

* Alarm function
etc.

PROFIBUS-DPV2

A PROFIBUS-DP version for which the following functions have been added to the
PROFIBUS-DPV1 functionality

* Time stamping

etc.

GX Configurator-DP

SWnD5C-PROFID-E type products. ("n" means version 4 or later.)

Master station

Class 1 master station that communicates I/O data with slave stations.

Slave station

A device that exchanges 1/O data with a DP-Master (Class 1). (ST1H-PB, etc)

Repeater

Device that connects PROFIBUS-DP segments.

Bus terminator

Terminator that is connected to both ends of each PROFIBUS-DP segment

FDL address

Address assigned to the master station/slave station.
The FDL address is set within the range from 0 to 99.

Extended diagnostic
information

Diagnostic information specific to each DP-Slave
Each of DP-Slaves notifies of it to the DP-Master when an error is detected.

Slave parameter

The slave station parameter (including user parameter) set by the master station.
The setting items are described in the GSD file.

GSD file

The electronic file that includes description of the slave station parameter.
The file is used when setting slave parameters by configuration software, which is
supported by the master station.

Input data

Data sent from the head module to the master station.
The data consists of the following areas.

. Bit Input Area

* Information Area
Error Information Area
Module Status Area
Command Result Area

- Word Input Area

11
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Term/Abbreviation

Description

Output data

Data that the head module receives from the master station.
The data consists of the following areas.

[ Bw] Bit Output Area
* Request Area

Error Clear Area

System Area

Command Execution Area
. Word Output Area

I/0 data

Data (input data, output data) transferred between the head module and the master
station.

Global control

This function enables synchronization command transmission for /O data from a
DP-Master (Class 1) to DP-Slaves.

Bit input area

Bit input data of each module.

Bit output area

Bit output data of each module

Word input area

Word (16-bit) input data of an intelligent function module.
In the case of analog input module, the digital output data value is stored.

Word output area

Word (16-bit) output data of an intelligent function module.
In the case of analog output module, the digital setting data value is stored.

Information area

Bit/Word input data for checking each module status and command execution
results.

Request area

Bit/Word output data for requesting each module to clear errors/to execute
commands.

Number of occupied 1/0O
points

The area, that is equivalent to the occupied I/O points, is occupied in Bit Input
Area/ Bit Output Area.

No. assigned to every 2 occupied I/O points of each module. This humbering starts
by assigning "0" to the head module and then proceeds in ascending order. (The

Slice No. maximum value No. is 127).

The No. is used for specifying the execution target.

Requesting from the master station in order to read the module status, to
Command

set/control the intelligent function module command parameters.

ST bus cycle time

Processing time for the head module to refresh the input/output status of each slice
module.

Bus cycle time

PROFIBUS-DP processing time for the master station to perform cyclic transfer

with each slave station.

12
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What's new in version 1.06G?

Version 1.06G introduces a number of new features to improve the functionality and usability
of GX Configurator-ST, such as:

Support for the ST1H-BT head module for CC-Link networks as well as the ST1H-PB
head module for PROFIBUS-DP systems. Configurations can easily be changed from
one head module type to the other.

A new 'wizard' interface to guide you through the configuration of the system. Graphical
display of modules to be added reduces the chance of accidentally adding the wrong
type of module.

A new graphical display of the rack configuration showing how the configured system will
look, making it possible to see instantly that the configuration matches the hardware,
and allowing modules to be rearranged using 'drag and drop'.

Usability improvements - for example, when configuring PROFIBUS-DP systems, the
point mode can be changed automatically when the number of I/O points for the current
mode is exceeded, instead of having to select the next point mode manually.

Instant feedback on configuration errors such as higher power consumption than the
configured power supply modules can provide, by showing modules with errors with a
red background in the module list and displaying the error description in the right mouse
button context menu for the module.

13
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Notes for upgrading users

If you have upgraded from the previous version of GX Configurator-ST, you can still reuse
the files that you created with the last version. These files can be opened normally, and will
be upgraded automatically when they are saved.

B

Although PROFIBUS-DP files created in this version can be reopened in
the last version of the software, it is generally advisable not to switch
between versions of the software when configuring a file. After saving a
file once in the current version of GX Configurator-ST, opening it in earlier
versions is not recommended.

The user interface is very similar to the versions that you have used before, but now when
you start the application you will be taken through the first configuration steps with a ‘wizard
interface. In the main configuration display, the module list from the previous version is now
just the bottom left section of a larger 'module configuration' window, which also shows a
graphical display of the configured system, a list of modules for addition and details of the
module selected to be added.

To read more about these features, see the sections shown below:

Feature PROFIBUS-DP description
First steps using the wizard Creating a new project|ss|

The module configuration window  |Screen layout and display switching|sz]

If you are stuck while using the application, press to show the relevant section of the
help file.

14
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2 Overview
GX Configurator-ST is the configuration software dedicated to the MELSEC-ST system.

2.1 Features

(1) Project creation of MELSEC-ST system

(a) Uploading module data to create project
A project can be created easily by uploading the system configuration and parameters from
the MELSEC-ST system.

g )

MELZEC ST syslem
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(b) Changing system configuration to edit project

A project can be edited by changing the system configuration, e.g. adding or rearranging
modules.

Nizer fm b o cici Red
£ enove Fe comed nodue. telec et

Rearrange
afte:Pean | Omeri%c | MocusMame |~
1 1 STIFSD [~
2 5 STIVIETEZ
3 2 STIVIETEZ
; ; 5T "?"‘[‘E Comn

(2) Monitoring MELSEC-ST system

(@)

16

MELSEC-ST system status can be easily checked.

GX Configurator-ST provides an image to show the statuses of the head/slice modules that
comprise the MELSEC-ST system on the “System Monitor” screen. Therefore, these
module statuses can be checked easily.

M System Monitor |z|@\g|
Module Information - - Gelect Madule
Module Name : STTH-PB Display

Foslion
Label Name
Base Module Ol NV |
Communication Status With Master Station - - ;
Ho Communication ‘ B |
| Bkl
- Module Staty s |
[l Modue SpstemEner - [] Module Warming [ Module Change ‘ |
[ No [o0] 1 gd j
Module Stalus

Moritor Suitch —
| Siall Stop ‘
—Farced Dutput Test Mode- -

OFF ON OFF
Input/Output | Forced Output
Monitor Test,
Offset/Gain todule Detail
Setting Information..
Ornline Module: Prarameter
Change... Sefting

Close

16
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(b) 1/0 module or intelligent function module can be changed online from
GX Configurator-ST
By using online module change, the faulty I/O module or intelligent function module can be
changed with normal module without the PROFIBUS-DP or CC-Link network being stopped.
GX Configurator-ST allows online module change to be made easily by screen-guided
operation without operation of the head module switches.

PROFIBUS-DP
or CC-Link
netwark

PROFIBLIS
or CC-Link

(c) Output test can be done without affecting PROFIBUS-DP or CC-Link
network

In a forced output test, outputs can be tested using the Bit Output, Word

Output and Error Clear of the head module or slice module ( Error Clear bits
are available for PROFIBUS-DP only).

The user can specify any Bit Output, Word Output and Error Clear.
As only the Bit Output, Word Output and Error Clear are used for the

forced output test, output data not used in the test are not affected.

In the forced output test, therefore, an output test can be conducted without affecting the
PROFIBUS-DP or CC-Link network.

MELSEC-ST sygetem

Haad module or slica madule

Quitput test i done on
PROFIBUS-DP

or CC-link
netwark

PROFIBUS
or CC-link
. Bit Curiput
+[Wwi.n | Word Output
= [Ew.n] Exror Clear
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(3) Parameter setting of slice module

(a) Parameter setting of intelligent function module
The "Parameter Setting" screen displays a list of module parameters.
Parameter setting can be made on this list.
As it includes functions to upload and verify data, and to check the setting errors, the
parameters can be confirmed easily.

M Parameter Setting No.3

Madule Information
Slice No. 5
Module Name ST1ADZ]
Label Marme:

Ease Module STIE-4IR2

Online

Salect All Release Al

Upload

Download

| Veily

Cancel

Select Data ; TagetMemow [Rat ¥

J

DX

Channel CH1 - Default Enor Check.
Select Item Setting Walue *
"1 |input range setting £ ta 20 md, ~
oI |Setting range 4to 20 mé -
C1 | Time/number of times specification Number of times b
I |Sampling process/averaging process setting Sampling -
T1 | @larm output setting Disable =
—I |Disconnection detection setting Disable -
I |A/D conversion enable/disable setting Enable -
=1 |50/E0Hz notch fiter specification Disable -
1 |Average time/average number of times setting 4
I |Upper upper limit value 4000
1 |Upper lower limit value 4000
1 | Lowwer upper limit value 0
0 |Lower lower limit «alue o -
| v

MELSOFT
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(4) Power supply capacity check

A check can be made to see if the sum of 5VDC internal current consumption required by
each module is within the 5VDC maximum rated output current of the bus refreshing
module.

A power supply capacity check example is shown below.

Power. Distribution Check
a
Mo | SupplyCurentis] | Consumptionfs) | Resul | o=k
1 2.000 1.800 0K <&
16 2.000 2,230 ERROR4——F—(b)
43 2.000 1.145 Ok “\‘_

Cloge

(&) The check result is "OK" since the sum 1.800A of 5VDC internal current consumption
required by the head module No. 0 and slice modules No. 2 to 15 is not greater than
the 5VDC maximum rated output current 2.000A of the bus refreshing module.

(b) The check result is "ERROR" since the sum 2.280A of 5VDC internal current
consumption required by the slice modules No. 17 to 42 is greater than the 5VDC
maximum rated output current 2.000A of the bus refreshing module.

(c) The check result is "OK" since the sum 1.145A of 5VDC internal current consumption
required by the slice modules No. 44 and later is not greater than the 5VDC maximum
rated output current 2.000A of the bus refreshing module.
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Howdol...?

This section will list things that you may wish to achieve with the software, and the different
ways in which these can be done. There may be several ways to get the same result, for
example modules can be added or deleted using several different methods.

How do I...?

Instructions

Create a new system

Creating a new project|ss|

Set up the communication port

Transfer setup dialog]s|

Read the configuration from the SLICE
hardware

Get system ||

Use the module configuration window

Details of module configuration window|ss]

Add modules to the configuration

Adding the module with the "Add module"
screen| 77|

Adding the module with the "Wizard area"|s]

Delete modules from the configuration

Deleting a module/ss]

Deleting all modules|es]

Rearrange the modules in the configuration
Drag and drop modules

Rearrange modules|ss]
Drag and dropleo]

Set module parameters

Parameter setting|o2]

Download parameters to several modules at
once

Parameter block write 1]

Compare parameter details with those stored
in another project file

Verifying the projects|eo]

Compare parameter details with those on the
SLICE hardware

Uploading / downloading the parameters|ss|

Copy modules from another configuration file

Copying the module information|es|

Use GX Configurator-ST for diagnostics

System monitor sl

Show module details (address ranges)

Module detail information|szol

View module input/output data

Input/Output monitorli:|

Test / calibrate module outputs

Forced output testlur]

Set offset/gain settings for a module

Offset/gain settingslus|

Change the head module type after the
system has been configured

Change head module type ]

20
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How do I...?

Instructions

Swap modules while the system is running
(Online module change)

Online module changels!

Set module options

Option setting/ss]

Change module labels

Option setting|ss]

Print the configuration

Printing the project datale7]

Check the total power consumption

Power distribution checklw2)

Use the toolbar

Details of toolbar|s]

Use the status bar

Status barls3]

Change to/from edit/online mode

Edit mode operation procedures|zs/
Diagnosis mode operation procedures|s]

Reset the head module

Reset the head modulelss|

View the PROFIBUS-DP network parameters

PROFIBUS-DP network parameter monitor
(PROFIBUS-DP only)lsxl

Read the point mode and 'without Wr' /
‘without Ww' settings from a connected
system

Reading input/output data settings
(PROFIBUS-DP only)lul

View the master station data communication
parameters / data area

Master station data communication monitor
l130]

Rearrange the open windows

Display switching and window rearranging
operations|ss]

Find out what an error means

Error messages ||
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System Configuration

System Configuration

MELSOFT

The following shows the configuration where a personal computer is connected to the MELSEC-ST

system.

-

G Configuraler-5TiC !‘;-'L-JC”‘-‘-EE

Pz ol G fuler

*1 : Use either of the following cables as the RS-232 cable.

Manufacturer name Model name
Mitsubishi Electric QC30R2
Beijer ELECTRONICS SC-Q QC30R2

22
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Operating Environment

The operating environment of GX Configurator-ST is indicated below.

Item

Description

Computer main unit

CPU

Required
memory

Refer to the following table "Used operating system and performance required for
personal computer".

Hard disk free space

60MB or more*2

Disk drive

CD-ROM disk drive

Display

800 x 600 dot or more resolution °

Operating system

Microsoft® Windows® 95 Operating System (English version)

Microsoft® Windows® 98 Operating System (English version)

Microsoft® Windows® Millennium Edition Operating System (English version)

Microsoft® Windows NT® Workstation Operating System Version 4.0 (English version) ™
Microsoft® Windows® 2000 Professional Operating System (English version)

Microsoft® Windows® XP Professional Operating System (English version) 1

Microsoft® Windows® XP Home Edition Operating System (English version) 1
Microsoft® Windows Vista® Home Basic Operating System (English version)
Microsoft® Windows Vista® Home Premium Operating System (English version)
Microsoft® Windows Vista® Business Operating System (English version)
Microsoft® Windows Vista® Ultimate Operating System (English version)
Microsoft® Windows Vista® Enterprise Operating System (English version)

*1: "XP compatibility mode" and "Fast user switching" are not supported.

*2: Free space of at least 15GB is needed for use of Windows Vista®.

*3: For Windows Vista®, resolution 1024 x 768 dots or more is recommended.
*4: Service Pack 4 or later is needed for use of Windows NT® Workstation 4.0.
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Used operating system and performance required for personal computer

Operating system

Performance Required for Personal Computer

CPU Required memory
Windows® 95 Pentium® 133MHz or more 32MB or more
Windows® 98 Pentium® 133MHz or more 32MB or more

Windows® Me

Pentium® 150MHz or more

32MB or more

Windows NT® Workstation 4.0 (Service Pack 4 or more)

Pentium® 133MHz or more

64MB or more

Windows® 2000 Professional

Pentium® 133MHz or more

64MB or more

Windows® XP Professional |"xp compatibility mode"”

and "Fast user switching"

Windows® XP Home
are not supported.

Edition

Pentium® 300MHz or more

128MB or more

Pentium® 300MHz or more

128MB or more

Windows Vista® Home Edition

Pentium® 1GHz or more

1GB or more

Windows Vista® Home Premium

Pentium® 1GHz or more

1GB or more

Windows Vista® Business

Pentium® 1GHz or more

1GB or more

Windows Vista® Ultimate

Pentium® 1GHz or more

1GB or more

Windows Vista® Enterprise

Pentium® 1GHz or more

1GB or more

— int

 The following features are not available for use with Windows® XP and Windows

Vista®. If used, this product may not function normally.

Application startup in Windows® compatibility mode

Fast user switching
Remote desktop

Large fonts (detailed setting in Screen properties)

Note that 64-bit version Windows® XP and Windows Vista® are not supported.

» On Windows Vista®, authority of USER or higher level must be used.
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Function list

Function list

The functions of GX Configurator-ST are indicated below.

Function

Description

Reference Section

System configuration
setting

Registers modules into the system by model name.

"Editing the project[771

Parameter Setting

Sets the parameters to the intelligent function module.

'Parameter setting'/9?)

Option Settings

Sets the label name, base module etc. for the module.

'Option setting'/99]

Power Distribution
Check

Checks whether the 5VDC internal current consumption
of the bus refreshing module is sufficient.

'Power distribution check'f03!

System Monitor

Monitors the statuses of the head and slice modules.

'System monitor' 6]

Module configuration,
parameter
upload/download

Uploads/downloads the module configuration and
parameters.

'Downloading and uploading
the parameters'liosl

Input/Output Monitor

Monitors the input data and output data.

'Input/Output monitor’[12a]

Forced Output Test

Tests the Bit Output, Word Output and

Error Clear of the head module or slice module
without stopping the PROFIBUS-DP or CC-Link network (

Error Clear bits are available for PROFIBUS-DP
only).

"Forced output test'[127]

Offset/Gain Setting

Sets the offset and gain values of the intelligent function
modules (ST1AD2-V, etc.).

'Offset/Gain setting of
intelligent function modules'
J113)

Reset Head Module

Resets the head module.

'Reset head module' s8]

Change head module
type

Changes the head module type (in edit mode).

'‘Change head module type'

‘104

Module Detail Shows the module detail information and monitors the . g -
Information corresponding module error status. Module detail information’ 20
Online Module Changes the I/O module or intelligent function module 'Online module chanae'
Change online from GX Configurator-ST. g
PROFIBUS-DP Monitors the slave parameters and PROFIBUS-DP

Network Parameter
Monitor

network parameters sent from the master station of
PROFIBUS-DP to the MELSEC-ST system to show the
results for confirmation.

'PROFIBUS-DP network
parameter monitor'|1z4)

Master Station Data
Communication

Monitor

Monitors 1/0O data between the master station and head
module.

'Master station data
communication monitor' 120
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Menu list

This section explains the menus of GX Configurator-ST.

int

The menu screens in this section are different from the actual ones.
Actually, some menu items are not selectable depending on the operation status of

GX Configurator-ST.

For the purpose of explanation, all the menu items are shown as selectable.

[File] menu
The [File] menu includes project file operation, print and other
functions. For more information, refer to the following sections:
Mew, ., Chrl+n
pen... Chr+O New!s5! - create a new project
Close Open@ﬁ - open an existing project
Save Ctr5 Close/571 - close the project
Save fs... Savels8] - save the project
o Save as/591 - save the project with another name
arify,.. - R .
= Verify|60] - compare modules with another project
apy. . R .
Copy!8s1 - copy module information from another project
Print... Chrl+p Print/671 - print the project data
e Recent files - open a recently-used project
ample, st ] m .

2 Sample. st Exit/40] - close GX Configurator-ST
3 Sample. st
4 Sample, st
Exit

[Edit] menu

Undo Chrl+2Z
Redo Chrl+y
add. . Chrl+Insert
Rearrange. .,

Delete Chrl+Delete
all Delete shift+Del
Parameter Setking... F2
Sptian. .. F10
Zhange head module

Power Distribution Check

[View] menu

The [Edit] menu includes the functions for module configuration
setting and parameter setting. For more information, refer to the
following sections:

Undol87) - reverse the last edit operation
Redols8) - reverse the last undo operation
Add[771 - add a module to the configuration

@irran%e@ﬁ - change the order of modules

Delete|s4] - delete a module

All delete/ss) - delete all modules

Parameter setting@ - change module parameter settings
Optionled] - change module options

Change head modulei01] - change head module type
Power distribution check/2! - test power consumption

Madule Configuration

Initialize Module Configuration Yiew Position
System Manitor

Toolbar

Statusbar

The [View] menu includes the function to display/hide each
screen.

Refer to 'Display switching and window rearranging operations'
[43) for details of each menu item.
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[Mode] menu

e

* Edit Fz
Diagniosis F3

[Online] menu

The [Mode] menu includes the functions to switch between the
edit mode and diagnosis mode.

Refer to 'Edit mode operation procedure'@ for details of the
[Edit] menu item.

Refer to 'Diagnosis mode operation procedureﬁﬁ for details of
the [Diagnosis] menu item.

online

Transfer Setup...

Gek Syskemn
Gek Inputfoutput Data Settings

InputiCutput Monitor,
Forced Qutput Test...
Ciffset/Gain Setting. ..

Parameter Block Wwrite..,

Reset Head Module

[Diagnostics] menu

The [Online] menu includes the functions for connection to the
head module and online operation of the head module. For more
information, refer to the following sections:

Transfer setuplsl - select communication port to use

Get system@ - read configuration from connected MELSEC-
ST system

Get input/output data settingsm - read input/output data
settings from MELSEC-ST system (PROFIBUS-DP only)

Input/Output monitorl21] - monitor module input/output data
Forced output testl27) - test outputs / error clear

Offset/Gain settingm - change offset/gain settings
Parameter block write 111l - download parameters as a batch
Reset the head modulel:3 - restart the head module

Module Dekail Information..,
Online Module Change. ..

PROFIBUS-DP Metwark Parameter Monitor. ..
Master Skation Data Communication Maonitar,

[Window] menu

The [Diagnostics] menu includes the functions to diagnose the
system. For more information, refer to the following sections:

Module detail information:201 - show more details of a module
‘Online module change'@ - swap out a module

'PROFIBUS-DP network parameter monitor' 134 - view or export
network parameter data

'Master station data communication monitor'l3! - view head
module data areas

it I

Cascade

Tile Yertically

Tile Horizankally
Arrange Icons
Close Al Windows

v 1 Swstern Monikor
2 Parameter Setting MNo.4

[Help] menu

The [Window] menu includes the functions to change the screen
layout of GX Configurator-ST.

Refer to 'Display switching and window rearranging operations'
[43) for details of each menu item.

Conkenks

Keyw Operation List...

about,

27

The [Help] menu includes the functions to show the online help,
operate the GX Configurator-ST keys and confirm the software
version.

Contents Shows the help file starting at the contents
page.

Key Operation List Shows the key operation listha?l page.

About Shows the version number, copyright and

licence information.
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5 Operation Procedures

5.1 Precautions when using GX Configurator-ST
This section provides precautions when using GX Configurator-ST.

(1) A communication error may occur if communication is made with the MELSEC-ST system after
setting of the resume function, suspend setting, power-saving function or standby mode of the
personal computer.

For this reason, do not set any of these functions before starting communication with the
MELSEC-ST system.
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5.2  Edit mode operation procedure

Create a new project, and edit and download it to the MELSEC-ST system.

}

Start GX Configurator-ST

.. Refer to 'Starting GX Configurator-ST'38

}

Is a new project No
created? l
Yes . L.
... Refer to 'Opening an existing
Open the existing project project‘\ 56
Connect the personal computer and Refer to
head module T \
Transfer setup'[108]

l Setthe system configuration .. Refer to 'Editing the project [771

Get various information from the

head module -~ Refer to

'Get system'[108)

Set the parameters of the intelligent .
i o el el g .. Refer to 'Parameter setting'[921
Set the parameters of the intelligent ... Refer to
function module 'Parameter setting'
192
Connect the personal computer and
l e ... Refer to 'Transfer setup'[108)

Download the various information to , .
the MELSEC-ST system ... Refer to 'Parameter block write Eﬁ

}

Print the project data

.. Refer to 'Printing the project data'[67)
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5.3 Diagnosis mode operation procedure
Confirm the error status and take corrective action, or perform the monitor/test, etc. of I/O data.

(1) Preparations for diagnosis mode
Make preparations for operation in the diagnosis mode.
Perform the following operation before starting operation in the diagnosis mode.

}

Start GX Configurator-ST

}

Connect the personal computer and - Refer to w‘m&
head module

}

Get various information from the .. Refer to w“‘ﬁ
head module

}

Change to the diagnosis mode

.. Refer to 'Starting GX Configurator-ST'|38)

... Refer to 'System monitor’ 1161

(2) Diagnosis mode operation procedure
Perform the operation explained in the reference section for each purpose of use.
Before starting the diagnosis mode operation, perform the operation in (1) of this section.

Purpose of use Reference section
To monitor the MELSEC-ST system. 'System monitor [
To confirm the module where an error occurred. ~>yslem monitor
To confirm the error definition. '"Module detail information' 20l

'Offset/Gain setting of intelligent

To set the offset and gain values. - :
function modules'/3]

To confirm the 1/O data. 'Input/Output monitor' |24
To conduct the forced output test. "Forced output test'|127]

'Master station data communication
monitor'[z30]
'PROFIBUS-DP network parameter
monitor'[134]

To monitor the master station data communication.

To monitor the PROFIBUS-DP Network Parameters.

To reset the head module. 'Reset head module'|13s]
To change the module online. 'Online module change'@
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Installation and uninstallation

This chapter explains how to install and uninstall GX Configurator-ST.

Installation

Installation procedure

( Installation start 5

Installation of product
- Register the user name and company
name
- Register the product ID

}

Start of GX Configurator-ST
- Check that GX Configurator-ST has been
installed correctly.

)

.. Refer to 'Installing GX Configurator-ST'[32)

.. Refer to 'Starting GX Configurator-ST'[38

MELSOFT
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Installing GX Configurator-ST

The following indicates how to install GX Configurator-ST.
Microsoft® Windows® XP Professional Operating System is used for explanation in this section.

MELSOFT

P

(1) Before starting installation, exit all other applications operating on Windows®.
(2) The installer may not work normally because the update program of the

settings of the update program not to start automatically.

log on using an administrator account (computer manager).

« Microsoft® Windows NT®Workstation Operating System Version 4.0
« Microsoft® Windows® 2000 Professional Operating System

« Microsoft® Windows® XP Professional Operating System

« Microsoft® Windows® XP Home Edition Operating System

« Microsoft® Windows Vista® Home Basic Operating System

« Microsoft® Windows Vista® Home Premium Operating System

« Microsoft® Windows Vista® Business Operating System

« Microsoft® Windows Vista® Ultimate Operating System

« Microsoft® Windows Vista® Enterprise Operating System

(4) Check whether or not GX Configurator-ST has been installed on the personal
computer. Ifit has already been installed, uninstall it, restart the personal
computer, and then install this software.

operating system or another companies software such as Windows® Update and
Java Update may start automatically. Please install the driver after changing the

(3) When installing GX Configurator-ST on any of the following operating systems,

(1) Installing GX Configurator-ST

8 GX.ST Installer @EkEl 1) After powering on the personal computer,

Ele Edt View Favortes ook Help

start Windows®.
- ) @ Oseadh [Brodes [T

[ it poiterar gtﬁh 2) Start Windows® Explorer and click the drive
=L — . MR R where the disk is inserted. Double-click
%] c:;:gsh this Falder to the J

N & Share this folder | "Setup'exe" ( .).

Other Places

(& Desktop
) My Documents EXp |Ore r] .

o My Computer
\'g My Network Flaces

Details

(To the next page)

To display Windows® Explorer, choose
[Start] = [All Programs] = [Windows
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(From the previous page)

User Accourt Cantrol 2| 3) (When using Windows Vista®)
@ An unidentified program wants access to your computer \({\lllglfq,;\ngvs’?reen on the left is displayed,

Don't run the program unless you know where it's from or you've used it
before.

|F|| setup.exe
— Unidentified Publisher

< Cancel

Idon't know where this program is from or what it's for,

< Allow

Itrust this program. [ know where it's frem or I've used it before,

V Details

User Account Control helps stop unauthorized changes to your computer,

'

18 GX Configurator ST 1.06G - InstaliShield Wizard x] 4) On the left screen, click the Next button.

Welcome to the InstallShield Wizard for GX
Configurator 5T 1.06G

The InstallShield(R) Wizard will install 5% Configurator 5T 1.06G
on your computer, To continue, click Next,

WARNING: This program is protected by copyright lsw and
international treaties.

Baick [ hext > ] [ Cancel

152 GX Configurator ST 1.06G - InstaliShield Wizard 5) Enter a user name, a company name, and
Costomer Information serial number, and click the [N&Xt| putton.

Please enter wour information.

User Name:

]Llsar Mame

Organization:

iCompany

Serial Mumber |

| <Back || Mext > ] [ Cancel J

'

(To the next page)
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(From the previous page)

i# GX Configuratar 5T 1.06G - InstallShield Wizard

Destination Folder

Click Mext ta install ta this falder, ar click Change ta install ko & different Folder. b = i

Install G Configurator 5T 1,066 ta:
CAMELSEC)GX Configurator 5T 1.06G)

[ < Back ][ Next = .] [ Cancel

'

i GX Configurator 5T 1.06G - InstallShield Wizard

Ready to Install the Program

The wizard is ready to begin installation.

Click Install to begin the installation.

IF wou wank to review or change any of your inskallation settings, click Back. Click Cancel to
it the wizard,

[ < Back. ][ Install ] [ Cancel ]
8 GX Configurator 5T 1.06G - InstallShield Wizard X

InstallShield Wizard Completed

The Installshield Wizard has successfully installed Gx
Configurator 5T 1.06G, Click Finish to exit the wizard.

(Compiletion)

34

MELSOFT

6) Specify an installation destination folder.

Then, click the button.

The default is set to "C:\MELSEC\GX
Configurator ST 1.**". ("**" represents a
version number.)

To change the default setting, click the
i button and specify a preferred

drive and folder.

7) Clicking the LInstall| pytton will start

installation.

8) The left screen indicates that the installation
is completed.

Click the button.
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Installing GX Configurator-ST registers the icon as shown below.

&Z‘x Windeves Mosie Makd

ﬂ. Software Setup
1 Windows Defender
@ Windows Meda Plaver
,&. “Windows Messenger
A windows Mervie Maker

B GT Desigrerz

B a7 simulatorz

& aT SoftEoTIom

§ G Developer

] ToMELFANGweh Homepegs

L

AllPrograms  * | B MELSOFT Acclication v | G G CofigwalorST L0686 » | &7 GX ConfiguatorST 1.06G

- . : £ To MELFANSwel Homepsgs

REMARK

When any of the following operating systems is used, the registered icon is placed in the menu that
appears by selecting [Start] > [Programs] - [MELSOFT Application].

« Microsoft® Windows® 95 Operating System

« Microsoft® Windows® 98 Operating System

+ Microsoft® Windows® Millennium Edition Operating System

« Microsoft® Windows NT®Workstation Operating System Version 4.0

« Microsoft® Windows® 2000 Professional Operating System
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6.2 Uninstallation

This section explains the operation for removing GX Configurator-ST from the hard disk.

The screens used for explanation in this section are those of Windows® XP Professional.

Though they differ slightly from the screens of Windows® 2000 Professional or like, refer to REMARKS
and perform installation.

T G00  1) Double-click "Add or Remove Programs” on
the Control Panel.
- 82 To display the Control Panel, choose [Start]
f|  Pick a category - [Control Panel].
;"ﬁ’ Q; REMARKS
F romsimens s 1§ e When using any of the following operating
Eé..m.,mg,..,m i‘ o systems, double-click "Add or Remove
i Programs". To display the control panel,
J e B choose [Start] = [Settings] = [Control Panell].
) i s » Windows® 95

» Windows® 98

» Windows® Me

» Windows NT®Workstation 4.0
+ Windows® 2000 Professional

For Windows Vista®, click "Uninstall a
program” on the Control Panel. To display the
Control Panel, select [Start] - [Control Panel].

B Add o Remaye Programs A=) 2) Choose "Change or Remove Programs™

alled programs and updates: Shomupikiios gmhy“mi and then "GX Configurator ST Version 1.**..
("**" represents a version numberi.
After selection, click the | Remove

button.

REMARKS
e (a) When using any of the following
@ operating systems, choose
"Install/Uninstall" and then
R "GX Configurator-ST Version 1.**"
("**" represents a version number)".
After selection, click the [Add/Remove]
button.
2 » Windows® 95
» Windows® 98
l « Windows® Me
» Windows NT®Workstation 4.0
(b) When using Windows® 2000
Professional, choose "Change or
Remove Programs" and then
"GX Configurator-ST Version 1.**"
("**" represents a version numberi.
After selection, click the

button.

(To the next page)
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(From the previous page)

3) Confirm that the files have been removed.

Clicking the button starts

uninstallation.

e [ x Clicking thebutton stops
bt S uninstallation.

Add or Remove Programs

= 4) (When using Windows Vista®)

User Account Cantral

= 3 When the screen on the left is displayed

F ) An unidentified ram wants access to your computer . " " !

@ prog et o click "Allow”

Don't run the program unless you know where it's from or you've used it

before,
FE setup.exe
|i—| Unidentified Publisher

¥ Cancel

I'don't know where this program is from or what it's for.

< Allow

Itrust this program. I know where it's from or 've used it before,

() Details

User Account Control helps stop unauthorized changes to your computer,

(Completion)
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6.3  Starting GX Configurator-ST

This section explains how to start GX Configurator-ST from the start menu.

M Vkon b fler W TpsiEatnd e 1) Move the cursor from [Start] -
AllPrograms * | G MELSOFT Application Al ) G Configurator-5T 1,066 *1.
[All Programs ] >

[Bwocrt [@]shsoom [MELSOFT Application].

*1: [Programs] is displayed when any
of the following operating systems
is used.

» Windows® 95

» Windows® 98

» Windows® Me

» Windows NT®Workstation 4.0
» Windows® 2000 Professional

2) Click [GX Configurator ST **]
("**" represents a version number).

All programs ™ | T

3) GX Configurator-ST starts.

| ™ Module Configuration

For the new system, do you want to

|v Head the system uration from the:

I~ Open an eisting file

I Buidthe system configuration affine
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REMARK

Multiple GX Configurators-ST can be started to use.

Since different projects can be opened on multiple GX Configurators-ST, multiple projects can be
browsed simultaneously.

The same project cannot be opened from multiple GX Configurators-ST.

When multiple GX Configurators-ST are started, GX Configurators-ST started second and later have
the following restrictions.
1) The diagnosis mode cannot be used.

The [Mode] - [Diagnosis] menu ( ) cannot be clicked.
2) Get System cannot be executed.

b |
The [Online] - [Get System] menu ([E ) cannot be clicked.
3) Parameter Block Write cannot be executed.
The [Online] - [Parameter Block Write] menu cannot be clicked.
4) Parameter upload, download and verify cannot be executed on the Parameter Setting screen.

The | Upload ‘ | Download | 4nq | Verify | huttons cannot be clicked.

GX Configurator-ST started first can perform the following operation since the above restrictions do
not apply.

Even when GX Configurator-ST started first is exited, the above restrictions still apply to all

GX Configurator-ST instances that have started.

To remove the restrictions, restart GX Configurator-ST after exiting all the remaining

GX Configurator-ST instances.
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6.4

40

Exiting GX Configurator-ST

This section describes how to exit GX Configurator-ST.

(1) From menu

=" MELSOFT GX Configu
GICW Edit Yiew Mode Onli

New... Chrn L
Open... Chrl+O

on F Click the [File] > [Exit] menu.
GX Configurator-ST ends.

e

1 samplel
2 sample2

Exit

|
(2) From "Titlebar"

&' MELSOFT GX Configurd
?\inu
::::B E._J Click 28 and choosﬁCIose].
- Minimize Alternatively, click @ at the right end of the
[ Maximize "Titlebar".

X Close Alt+F4 |l

MELSOFT

— fBun

(1) While the print Qreview\%ﬁ is displayed, GX Configurator-ST cannot be exited.
Exit GX Configurator-ST after closing the print preview.

(2) Do not restart or shut down your personal computer during GX Configurator-ST

operation.
Exit GX Configurator-ST before restarting or shutting down the personal computer.
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REMARK

When a project is newly created, or modified but not yet saved, a dialog box appears asking whether
the project will be saved or not.

When not saving it, click the button.

When saving it, click the button.
When saving a new project, name the project.
Refer to 'Save as'[ss] for details.
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-

7.1

42

Screen layout and display switching

This chapter explains the screen layout of GX Configurator-ST and the display switching of each area.

Screen layout

The screen layout of GX Configurator-ST is shown below.

Titlebar

Screen minimize button

Screen maximize button
Exits
GX Configurator-ST

Menubar

Dropdown menu

Toolbar

0 0601 ki dsin
Wi e b B

Module
configuration | window
window ol L | o
= E] 2 Wi b He G| & Mo £}
wub el w| Spoccstiy drge Sl 2 .
M':x o:.uih-:t | BHE [BE] wibE | =whED | Lo hae G_: . e
= Statusbar
Name | Description
Displays the file name of the open project.
When two or more GX Configurator-STs have been started, "Edit Mode only" is displayed
before each file name of the second and later ones.
=" MELSOFT GX Configurator-ST Edit Mode only
Titlebar - ' ' ' '
When "Window" on GX Configurator-ST is maximized, the name of that "Window" is
ldisplayed.
&' MELSOFT GX Configurator-ST (Untitlad) - [Parameter Setting No.3]
Menubar lCIicking each menu opens the corresponding "Dropdown menu". Then clicking a

I"Dropdown menu" item will execute the corresponding function of GX Configurator-ST.

Dropdown menu Refer to 'Menu list/[261 for details.

ICIick any of the buttons to execute the corresponding function of GX Configurator-ST.

Toolbar Refer to 'Details of toolbar'[44] for more information.

Screen minimize button JClick this button to minimize GX Configurator-ST.

Screen maxmize button |Click this button to maximize GX Configurator-ST.

Exits Click this button to exit GX Configurator-ST.

GX Configurator-ST
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Name

Description

Module configuration

This initially shows a configuration wizard. Once a configuration is being edited it will display
a list of modules registered to the project, graphically and as a list.

Double-click a module to set the parameters.

Right-click the module to display the menu, and select a menu item to execute the

window corresponding function.
Use ‘drag and drop’ in the graphical display to rearrange modules.
Use the ‘Wizard’ area to add modules.
Refer to 'Details of module configuration window'[43) for more information.
Window IDispIays the "Parameter Setting" screen, "Result Verify" screen, etc. Use | Ctrl]Fo] to
switch to the next window, or ++ to switch to the previous window.
When the mouse pointer is moved over each "Dropdown menu" item, the corresponding
explanation is displayed.
The following information is also displayed.
Statusbar

* Current mode of GX Configurator-ST
» Station number or FDL address of the connected head module in the diagnosis mode

Ready D'iagnosis Maode FDL Address 42

7.2  Display switching and window rearranging operations
The following table shows how to display/hide bars and how to arrange windows.
Operation I Description

Displays or hides the "Module Configuration

[View] = [Module Configuration \Window" screen.

Window] This operation can be performed in the edit mode
only.
Returns the display position of the "Module

[View] => [Initialize Module Configuration Window" screen to the initial status.

Configuration View Position] This operation can be performed in the edit mode
only.
Displays or hides the "System Monitor" screen.

[View] = [System Monitor] This operation can be performed in the diagnosis
mode only. -

[View] = [Toolbar] |Displays or hides the "Toolbar"[441,

[View] = [Statusbar] |Displays or hides the "Statusbar"[43),

. Overlays multiple "Windows" opened on

[Window] -> [Cascade] GX Configurator-ST.

[window] = [Tile Vertically] |Displays multiple "Windows" vertically.

[window] => [Tile Horizontally] |Displays multiple "Windows" horizontally.

[Window] - [Arrange Icons] IAr.rang.es the icons to which windows have been
minimized.
Closes all "Windows".

[Window] = [Close All Windows] [when a "Window" is being edited, a confirmation
message is displayed.

43
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7.3

44

Details of toolbar

The buttons included in the Toolbar will be explained.

DE & || 2elm 1@ 0@ & i
Button Name Description Reference Section

‘Creating a new

D New Creates a new project. W
Tu - . '‘Opening an existing
E- Open Opens the existing project. project]st]
E Save Saves the open project, whether it is new or existed 'Save' (58]
previously.
% Print Prints the module configuration, module information list,| 'Printing the project
and module detail information of the open project. data'ls7]
K Undo Restores to the status prior to the last operation. 'Undo'[7)
i Redo Restores to the status prior to the "Undo" operation. 'Redo’[s8]
+E Add Adds a slice module to the project. 'Adding the module'[77)
:E: Delete Deletes the slice module from the project. 'Deleting a module'[s4]
E All Delete |Deletes all slice modules from the project. Deleting @Isljmodules'
ggtr?rrlgeter Sets the parameters of the intelligent function module. |'Parameter setting'[e2]
f Edit Switches to the edit mode. —
@ Diagnosis [Switches to the diagnosis mode. —
o Get Uploads the system configuration and the parameters of \ '
[E System |each module from the head module. M@
i About Displays the software version of GX Configurator-ST. —
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7.4  Details of module configuration window

The module configuration window provides a ‘wizard’ to guide the user through the system
configuration. When GX Configurator-ST is first started, this will show the options for creating a
system:

B Module Configuration

Far the new spstem, do pou want to:

[v Head the spstem configuration from the communication port

[ Open-an esisting fils

[ Build the system configuration affline

Creating a new configuration is described in 'Creating a new project'/ss\.

When the configuration is being edited, the window changes to show four separate panes:

B kodale Configuration

To adc amecu = balos o dter e coven! posson. seed |
e tha ke e chek A’
1o pemice il moculls asdert The e

STICE™- Lo i

“rameT T

. ' T add belge & ad sty
e =)
aga 4
a " Denn 5 S

10 Oecwnatior Forks B0 52 tetoed L T p— -l Hem=! ATLOAL
- - Cezorpton; &nsog Dutpu; modue, | Ouspat, Current, 12 B 1 Module wacks

Ha | Sics]  Mocu=Hawe | EAHED | BepER] WHHET | WwiodHDT | Labe Name
0% 00

] 1] 5]

12 e E M5 S 1

73 057  E 5 z

1 n 15-18 1619 O0.00 . :

o = : ot = |Information

a 13 A 1E 7 h s 1

g <y ; area
S — W 2 .
_:vl!-ﬁﬁ-['_EJ 3-8 |3 a5 Y ’

7 18 STIYIE-TE2 k-3 M-33
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Name | Description

Displays a graphical representation of the assembled system. It can be used to edit
Rack display module details or rearrange modules using drag and drop.

The display items are described in 'Details of rack display’ /47,

Shows the details of the modules, with the address ranges that they will use and any
Module list label names assigned to them. The display items are described in 'Details of module

list'[48],

This is a continuation of the wizard screen shown when GX Configurator-ST first starts,
Wizard area and can be used to add or delete modules. For more information, see 'Details of wizard

area'[52),

. This shows the details of the module selected for addition in the wizard area. The

Information area . - ; O - 8 . :

display items are described in 'Details of information area 531,

:'i#' HELPAN OPERATION

You can resize the areas by selecting the bars between them, and then clicking and dragging
with the mouse. The size of each area will be saved when the application exits, and restored the
next time the program starts. It can be reset from the 'View' menu 'Initialize module configuration
view position'r%sﬁ item.

The following shortcut keys are available for use when the module configuration window is
active:

Key Description

+ Switch to the rack display.

Switch to the module list

Switch to the wizard area

2 1z (=] (=
+
[w]fr]i[=]

Switch between panes, in the order:

Rack display = Module list >Wizard area = Rack display
F Switch between panes in reverse order:
Rack display = Wizard area = Module list 2 Rack display

w
+
E
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7.4.1 Details of rack display

Displays a graphical representation of the assembled system. This can be useful to provide a quick
visual check for errors, as the graphical display should look like the physical hardware.

DISPLAY/SETTING SCREEN

m Head p
i moduls

First power
supply

Scrall

\Dlaiscrs :

| IEOE @@ mm

@ DISPLAY/SETTING DATA

Iltem Description

The rack starts at the left side with the head module, which always occupies slot
number zero. This should normally be followed by an ST1PSD bus refreshing
module, which is always required to provide power to the head module and the first
modules immediately after it.

The graphic for each module is shown in two parts; the upper half depends on the
module type, and the lower half shows the ‘base module' which may be different
depending on the type of wiring used.

Left click on a module to select it. It will automatically be selected in the module list
as well. Many actions in the [Edit] menu require a module to be selected first.

Right click on a module to select it and show a menu similar to the [Edit] menu —
refer to 'Editing the project'Fﬁ for details of each menu item. If the module has a
configuration error (such as consuming more power than the last power supply will
provide), this will be shown at the top of the menu. Clicking on the item will show
help on the error.

If there are more modules in the configuration than the window can display, there
Scroll bar . : - g
will be a scrollbar under the rack which can be used to view the remaining modules

Modules

a7 a7



7 Screen layout and display switching MELSOFT

7.4.2 Details of module list

This shows a list of modules in the configuration.

fCC-Link systems]

DISPLAY/SETTING SCREEN

=
B

Optimization
mode

!

Occupied

bits / wards Ocoupied

bit # vaord limit -

S 4 MaBit| 48 MeTod 6

7 2 | 3 ST1D414 00-03 | 00-03 Y praan
1/ 3 & | STIYIETPE3 = 04 . sl
i 4 | 13 STIX4DE1 | 04-07 S\ selting 8
5 ST1TDZ - OB A00-01 ol Selected
e |IBG 5T1%4-DET -OF e (I - moduh; >

- 7 ST1%2-DET : : -

g | 20 ST14D2Y 12-15 | 18-18 | 02-03 . -

o | v

' : [
1/0 Occupation Poinks Bt 28
Mode “:'_naﬁhigh speed L] Exp. cyclic setting Single Excl station count | 2 —= Exclusive
/ N station count
No_[Slice]  Modue Name | BiHEX) [BwHER] Wr[M\iw[HEX] | LabelName T

@ DISPLAY/SETTING DATA

Iltem

Description

I/O Occupation Points (Bit)

The total number of bits used by all the modules in the configuration.

I/O Occupation Points

The total number of words used by all the modules in the configuration.

(Word)
Max. Bit The limit on the number of input/output bits with the current optimisation mode,
' extended cyclic and stations settings.
Max. Word The limit on the number of input/output words with the current optimization mode,
' extended cyclic and stations settings.
This gives the optimization mode currently selected, either ‘priority high speed’
(use more stations so data is read faster) or ‘priority min. stations’ (reduce the
number of stations used at the cost of reading the data more slowly). This can only
Mode be changed for the SLICE system by setting a DIP switch on the head module

itself, although the selection can be changed here to see what the effect of
switching mode would be. When you switch to diagnostics mode, the current DIP
switch setting will be read from the SLICE hardware.

Exp. cyclic setting

By increasing the number of cycles taken to read the data, the number of stations
used can be reduced, however this means that the data will take longer to read in
total. This value is calculated based on the optimization mode setting.

Excl. station count

The number of stations used for communications. Using more stations increases
the speed at which data is read, but reduces the number of other devices that can
be used on the CC-Link bus. This value is calculated based on the optimization

mode setting.
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Item

Description

List area

This shows a list of modules in the configuration.

Double click on a module to edit its parameter settings (see 'Parameter setting'@
for more details).

Left click on a module to select it — the same module will automatically be selected
in the rack display as well. Many actions in the [Edit] menu require a module to be
selected first.

Right click on a module to select it and show a menu similar to the [Edit] menu —
refer to 'Editing the project771 for details of each menu item. If the module has a
configuration error (such as consuming more power than the last power supply will
provide), this will be shown at the top of the menu. Clicking on the item will show
help on the error.

You can alter the widths of columns in the module list by moving the mouse pointer
over the dividing line between two column headings:

When the cursor changes to a vertical double line with arrows on each side, click
and hold the left mouse button, then drag the column divider to its new position
and release the mouse button. The changes you make to the column widths will be
remembered and reapplied each time the application is started.

No.

the position number for the module, starting with the head module at position 0
and the first ST1PSD power supply at position 1.

Slice

The Slice position of the module. Some modules can occupy more than one slice,
so this does not always match the number.

Module
Name

The type of module, for example ST1PSD.

Br(HEX)

The input bit range used by the module

Bw(HEX)

The output bit range used by the module

Wr(HEX)

The input word range used by the module

Ww(HEX)

The output word range used by the module

Label Name

A user-defined label for the module. This can be useful to identify modules when
there are several modules of the same type in the system. For example, two
similar input/output modules could be labelled 'Cabinet 1 wiring' and ‘Cabinet 2
wiring' to tell them apart.

In CC-link systems, the address ranges are sometimes referred to differently. CClink's|
'RX" and 'RY' ranges are equivalent to the 'Br' and 'Bw' ranges shown in
GX Configurator-ST and CC-link's 'RWr' and 'RWw' ranges are equivalent to "Wr' and

‘Ww',

int
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[PROFIBUS-DP systems]

DISPLAY/SETTING SCREEN

/

: Mo [Shice] Module Mame | BAHEX] [BuHERI] witHER) [ WwHEX) | LabelHame
A IE STTH-FE 00-0% | 00-03 : :
1|2 ST1PSD 04-05  04-05 : ;
f,-f'____ 2| 3 STIXIGDE1 | 05-15 | 05-15 : E
B 3N ST1AD2Y 1E-14 o - 01 oo-m Selected
4 |13 ST1%2-DE1 14- 1B ' 3 -
5 | 1 G710 : -—are03 | 02-03
§ | 16 ST1x%4-DE1 0-23 | 20-23 . :
7l 18| sTivieTER  24-33 | 2413
[ 18]

1]
i
i

170 Decupation Pointz -+ Bit R2 ‘word

Occupied
bits / words oA

4 2BE-pt mode

@ DISPLAY/SETTING DATA

ltem Description

The total number of bits used by all the modules in the configuration. This cannot
be more than the point mode limit (see 'Option Setting'@ﬁ).

I/0O Occupation Points The total number of words used by all the modules in the configuration. The limit
(Word) on the number of words used varies depending on the point mode.

This gives the number of points read when communicating with the PROFIBUS-DP
master station. Lower numbers mean that the data is read more frequently, but
less data can be read in total. Larger numbers allow more data to be read, but not
as often.

I/0O Occupation Points (Bit)

Point mode
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51

Item Description
This shows a list of modules in the configuration.
Double click on a module to edit its parameter settings (see 'Parameter setting'@
for more details).
Left click on a module to select it — the same module will automatically be selected
in the rack display as well. Many actions in the [Edit] menu require a module to be
selected first.
Right click on a module to select it and show a menu similar to the [Edit] menu —
refer to 'Editing the project771 for details of each menu item. If the module has a
configuration error (such as consuming more power than the last power supply will
provide), this will be shown at the top of the menu. Clicking on the item will show
List help on the error.
Istarea You can alter the widths of columns in the module list by moving the mouse pointer

over the dividing line between two column headings:
When the cursor changes to a vertical double line with arrows on each side, click
and hold the left mouse button, then drag the column divider to its new position
and release the mouse button. The changes you make to the column widths will be
remembered and reapplied each time the application is started.

No The position number for the module, starting with the head module at position 0

' and the first STIPSD power supply at position 1.

Slice The Slice position of the module. Some modules can occupy more than one slice,
so this does not always match the number.

Module

Name The type of module, for example ST1PSD.

Br(HEX) The input bit range used by the module

Bw(HEX) The output bit range used by the module

Wr(HEX) The input word range used by the module

Ww(HEX) The output word range used by the module
A user-defined label for the module. This can be useful to identify modules when

Label Name there are several modules of the same type in the system. For example, two
similar input/output modules could be labelled 'Cabinet 1 wiring' and ‘Cabinet 2
wiring' to tell them apart.
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7 Screen layout and display switching MELSOFT

7.4.3 Details of wizard area

The wizard area is a continuation of the wizard page which is shown when GX Configurator-ST first
starts. It can be used to add or delete modules.

DISPLAY/SETTING SCREEN

L5 el st ]

To add a module before or after the current position, select it
from the list and click ‘Add"
Ta remove the cument module; select 'Delats’

=} Inteligent modules \&m ~
ST1AD2] @ :
ST1AD 2 (without i) .
ST1AD2Y
BRI ' /
STADAT {without i) a | ; /

P
" &dd before Add after //
/
A
Delete S

buttonz ¥

@ DISPLAY/SETTING DATA

Item

Description

Information message

This shows advice on the current function of the buttons.

This shows the available modules for addition, categorised by type. When a
module is selected, its details are shown in the information area — see 'Details of

Module tree

information area’[s3)

Select this if new modules should be added before the currently selected module in
Add before > .

the rack display / module list.
Add after Select this if new modules should be added after the currently selected module in

the rack display / module list.

Back button [not shown]

If there are no modules left other than the head module and first bus refreshing
module, the button will allow you to return to the head module selection
page of the wizard.

Delete button

This can be used to delete the module which is currently selected in the module list
/ rack display.

Add button

Adds a module to the configuration.
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7.4.4 Details of information area

When a module is selected for addition in the wizard area tree, the information area shows the details
of the module.

DISPLAY/SETTING SCREEN

I] I
1
:f
I
i Pt 9
- Mame: ST1DwE-Y & I \\
== Description: Analog Qukput module, 2 Outputs, Yoltage, 12 Bit, 1 Module width ‘\\
Slats: 1 a N
Slices: 2 . \\
Er: 4 b | b
Bl Module ]
et araphic. J
Wi 2
4
[ 7 1| sTieoEt 1o
= —— ‘\.\\

@ DISPLAY/SETTING DATA

ltem Description
Name The module name (type)

A readable description of the module - this can be useful to identify a module when
two modules have similar names

A graphical representation of the top part of the module as it will appear in the

Description

The module graphic

rack.

Slots The number of slots that will be occupied by the module
Slices The number of slices that will be occupied by the module
Br The number of input bits occupied
Bw The number of output bits occupied
Wr The number of input words occupied
Ww The number of output words occupied

int

In CC-link systems, the address ranges are sometimes referred to differently. CClink's|
'RX" and 'RY' ranges are equivalent to the 'Br' and 'Bw' ranges shown in

GX Configurator-ST and CC-link's 'RWr' and 'RWw' ranges are equivalent to "Wr' and
"Ww',
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7 Screen layout and display switching MELSOFT

8 Project creation

This chapter explains how to create the project of GX Configurator-ST.
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8 Project creation MELSOET

8.1 Creating a new project

ﬂb PURPOSE

Creates a new project.

=) BASIC OPERATION

(1) When GX Configurator-ST is first started, a ‘wizard’ page is shown automatically. If you
have a configuration file open, you can also return to this page by clicking the [File] >

[New] menu ( ) or pressing the + E keys on the keyboard.

M Module Configuration E|E|

For the new syster, da you want ta:

¥ Read the system configuration from the communication port

[~ Oper an existing file

[ Build the system configlration affine

(2) Select ‘Build the system configuration offline’ and click to show the protocol
selection page.

B Module Configuration

Pleaze select the protocol used by the head module, then click Nest!

PROFIBUS-DF[ST1H-PE]
CC-Link [STTH-RT)

(3) Select the protocol used by the head module then click .

This displays a new project on the "Module Configuration Window" screen.
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8.2  Opening an existing project

ﬂb PURPOSE

Reads a saved project.

2} BASIC OPERATION

(1) Either:

|
Click the [File] > [Open] menu (Ii') or press the + @ keys on the keyboard, or
At the first wizard page (normalli shown when GX Configurator-ST starts), select ‘Open

an existing file’ and click .

(2) On the opened screen, select the project to be opened, and click the button.
This displays the selected project on the "Module Configuration Window" screen.

DISPLAY/SETTING SCREEN
Open E]

Look in: | =3 SLICE -] =F B~

_IBMP
i]samplel

o '
Files of type: |G ConfiguratorST Fie[*. ) -] Cancel

E DISPLAY/SETTING DATA

Item Description
Look in Select the directory that stores the project to be opened.
File name Set the file name of the project to be opened.
Open | putton IOpens the project specified at "File name".
Cancel | putton ICIoses this screen without opening the project.
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8.3  Closing the project

ﬂb PURPOSE

Closes the currently open project.

2} BASIC OPERATION

(1) Click the [File] = [Close] menu.

(2) When closing a project that includes unsaved changes, i.e., newly created project or

changed existing project, a screen appears asking whether the project will be saved or
not.

When not saving it, click the button.

When saving it, click the button.
When saving a new project, name the project.
Refer to 'Save as'[s] for details.

(3) When closing an unchanged existing screen, the following screen appears asking
whether the project will be closed or not.

MELSOFT GX Configurator-ST (B8]

|| ': D you want to eloss the File?
"

Click the button to close the project.
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8 Project creation

MELSOFT

8.4  Saving the project
8.4.1 Save

ﬂb PURPOSE

Saves the open project, whether it is new or existed previously.

=) BASIC OPERATION

Click the [File] > [Save] menu (E) or press the + keys on the keyboard.

For a new project, name and save it.
Refer to 'Save as'/s¢] for details.
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8 Project creation

8.4.2

59

Save as

ﬂb PURPOSE

To name and save the open project.

) BASIC OPERATION

(1) Click the [File] > [Save As] menu.
(2) On the opened screen, select the destination directory, set the file name, and click the
button.

DISPLAY/SETTING SCREEN

Save As .
Savejn | ) SLICE ~] ek B~
(SHEMP
| ]sampiet
File name:
Saveasyper | GX ConfiguralorST File[” s ] Cancel

E% DISPLAY/SETTING DATA

MELSOFT

Iltem Description
Save in Select the directory that stores the project.
File name Set the file name of the project to be saved.

Save | yutton

Saves the project with the file name specified at "File name".

Cancel | ptton

ICIoses this screen without saving the project.
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8 Project creation

8.5

60

MELSOFT

Verifying the projects
Verify two projects against each other to check whether the parameters are consistent or not.

There are the following two different verify methods.

(1) n:nverify
Verify all modules of the same No. between the open project and saved project.
Refer to 'n:n verify'[e1] for details of the verify operation.
Refer to 'Verify result's2 for details of the verify result.

(2) 1:nverify

Select one module from one of two projects, select multiple modules from the other project, and
verify the one module of the former project against the multiple modules of the latter project.
Refer to '1:n verifx‘@ for details of the verify operation.

Refer to "Verify result'|e3] for details of the verify result.
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8.5.1 n:nverify

PURPOSE

Verifies all modules of the same No. between the open project and saved project.

BASIC OPERATION

(1) Clicking the [File] = [Verify] menu displays the "Verify" screen.
(2) Open the <<Verify All Modules>> tab.

(3) Click the button and specify the verification destination project.

(4) Clicking the button starts verify, closes this screen, and displays the result.
Refer to 'Verify result'[e3] for details.

DISPLAY/SETTING SCREEN
Verify @

Yerification Destination File
Drive/Path :  |CAMELSECWSLICE
Cloze J
File Marme |VerifySampI33b Browse... |
Werify All Madules | Yerify Selected Modules ]
Werify all
modules tab Execute
~Veification Souce : Werification Destination
Mo, | Slice Module Mame i Mo, | Slice Module Mame £
I 1] ST1H-BT 1] 1] STIH-BT
1 2 STIRSD 1 2 STI1PSD
2 3 ST1DAZNY 2 3 ST1DAZY
3 5 STIRD2 3 5 STIRDZ
4 7Lt AD2Y 4 7 1402y
5 ¥ Souce R51 5 97" Destination S51
3 1 maodules 7] 3 1 modules §2
7 1j\[c:urrer'ut file ] 7 T [target file) o]
g |18 TST1551 g8 [ 15 | ™==%Tissd
| 17 ST1DAZNY 3 17 ST1DAZY
10 ] 19 STIRD2 10 | 18 STIRDZ
i 21 ST1DAZY A 11 21 ST1DAZY hd
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MELSOFT

62

E DISPLAY/SETTING DATA

Item

Description

Verification Destination File

Specify the verification destination project.

Displays the drive and directory that stores the verification destination project

Drive/Path

specified with the button.

Displays the file name of the verification destination project specified with the
File Name ﬂ

Browse | yytton.

Browse | ytton

Specifies the project.
Operation is the same as opening the existing project.
Refer to 'Opening an existing project'@ for detalils.

Close | yytton

Closes this screen without verifying the projects.

<<Verify All Modules>> tab

Performs n:n verify.

Execute | yiton

Verifies the projects, closes this screen, and displays the verify result.
Refer to 'Verify result'[63] for details of the verify result.

e B *
Verification Source 2

Displays a list of all modules of the open project.

*
Verification Destination 2

Displays a list of all modules of the verification destination project.

*1: The button cannot be clicked if the open project and verification destination project differ
in system configuration.
*2: As this verification is conducted to check parameter inconsistency, the module without parameters

is grayed out and is not verified.
The module with uploadable parameters is verified, even if the parameters are not editable.
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8 Project creation

MELSOFT

8.5.2

63

Verify result

PURPOSE

Confirms the verify result displayed by n:n verifylst] or 1:n verify/es),

1)

BASIC OPERATION

verified module list.
To display the inconsistent parameters, click the module displayed red.

)

the | Parameter Setting | putton.

3)

To close this screen, click the button.

DISPLAY/SETTING SCREEN

M Result Yerify 2

The module having inconsistent parameters in the verify result is displayed red in the

To change the parameters, double-click or select the corresponding module and click

1
2
3
4
5

Avverage nurmier

4000

Upper uppar imit vaiue

Upper lower fmit vahie 4000
Lower upper it vaiue -4000
Lower lowier mit vale 4000

Werification Source File; |Ur|tiued
Verfication Destination File: [c:\ME LSECASLICE vsample2
NofSrc) | ModueName(Sic] | MofDst] | ModuleMameDst] |  Mismatchltems | = 7 i
5 sTAbZY | 2 STIXIGDET = Verified module list
5 ST1ADEY 3 STIVIGTPES - +
5 ST1AD2Y 5 STIADZY 5
5 STIADZY g ST1DA2V - -
Parametes Setting...
Inconsistent parameter list
No. Iterm Wenfy Source Setting Value

Wenify Destir

2000
2000
2000
-2000
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MELSOFT

64

E DISPLAY/SETTING DATA

Item

| Description

Verification Source File

Displays the file name of the verification source project.
"Untitled" is displayed when a newly created and unsaved project has
been set.

Verification Destination File

IDisplays the file name of the verification destination project.

Verified module list

Displays a list of modules verified.

[The module having inconsistent parameters is displayed red.
Double-click that module to change its parameters.

Refer to 'Parameter setting'@ for details.

INo. (Src) IDisplays the No. of the verification source module.
IModule Name (Src) IDisplays the model name of the verification source module.
INo. (Dst) IDisplays the No. of the verification destination module.

IModule Name (Dst)

IDisplays the model name of the verification destination module.

Mismatch ltems

Displays the number of items whose verify result is inconsistent.
"----" indicates that the "Module Name(Src)" and "Module Name(Dst)" are
different modules.

| Parameter Setting | ption

Changes the parameters of the module selected in the verified module
list.

Refer to 'Parameter setting'[92) for details.

The target is an open project.

Inconsistent parameter list

Displays the parameters that were inconsistent as a result of verify in the
module selected in the verified module list.

INo. IDisplays the serial number.
litem IDisplays the parameter name.
xgﬂz Source Setting IDispIays the parameter value of the verification source module.

Verify Destination
Setting Value

|Disp|ays the parameter value of the verification destination module.
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8.5.3

1:n verify

PURPOSE

Selects one module from one of two projects, selects multiple modules from the other

project, and verifies the one module of the former project against the multiple modules of
the latter project.

(1)
)

(3)
(4)

(®)
(6)
(7)

BASIC OPERATION

Clicking the [File] = [Verify] menu displays the "Verify" screen.

Open the <<Veri¥ Selected Modules>> tab.

With the button, specify the verification destination project.

With the "Select Verification Source File" radio button, select the project that includes
the verification source module.

With the button, select the verification source module.

With the |Add] /| Delete| button, select the verification target module.

Clicking the button starts verify, closes this screen, and displays the result.
Refer to 'Verify result'[e3] for details.

DISPLAY/SETTING SCREEN

Select
werification

zournce file ﬁ!‘

WVerification Destination File
Diive/Path :  [CAMELSECMSLICE

Cloze

File Hame ; |Verify5amp|e3b

B
Werify selected M
miodules tab

Start

Werify Al Modules  Werify Selected Modules ‘1‘4’““”—-—"‘"

COMPaNsan g

Select Verification Source File

MELSOFT

&+ Opened File

Opened File - Select which file to uze Werification Source Module
= a3 the source Selected
No. | Slice Module Narig =] Mo, | Slice Module Name: | SOUCE
0| o ST1H-PB " | 11 ST1ADZ e fo
1] 2 ST1PSD Add ST
81 D y ~Werification Destination Module
i | 5 ST1RDZ Modules in :
current file 4 Mo, | Slice Maodule Wame
il E 1 | N ST1AD2

" Merification Target File

Executs

Werification T arget File

Modules in
S destination file .

Mo, | Slice Module Name - 4= rnodule(z] to
1] 0 ST1H-PB I Delete compare againzt
1 2k STIPSD :
| | ST1DAZY Add

Selected target
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MELSOFT

66

E DISPLAY/SETTING DATA

Item

Description

Verification Destination File

Specify the verification destination project.
Operation is the same as performing n:n verify.
Refer to 'n:n verify'@ for details.

Close | pytton

Closes this screen without verifying the projects.

tab

<<Verify Selected Modules>>

Performs 1:n verify.

Select Verification Source
File

Select the project that includes the verify source module.

* When "Opened File" is selected, select the verification source module from
the open project.

* When "Verification Target File" is selected, select the verification source
module from the project specified at "Verification Destination File".

Execute | piton

Verifies the projects, closes this screen, and displays the verify result.
Refer to 'Verify result'/e3] for details of the verify result.

Opened File 1

Displays a list of all modules of the open project.

button

Adds the selected module to the "Verification Source Module" or "Verification

Destination Module".

The addition destination changes depending on the selection of "Select

Verification Source File".

* When "Opened File" is selected, the selected module is added to
"Verification Source Module".

« When "Verification Target File" is selected, the selected module is added to
"Verification Destination Module".

*1: As this verification is conducted to check parameter inconsistency, the module without parameters

is grayed out and is not verified.
The module with uploadable parameters is verified, even if the parameters are not editable.

Item

Description

Verify Selected Modules

Verification Target File 1

Displays a list of all modules of the verification destination project.

button

Adds the selected module to the "Verification Source Module" or "Verification

Destination Module".

The addition destination changes depending on the selection of "Select

Verification Source File".

* When "Opened File" is selected, the selected module is added to
"Verification Source Module".

» When "Verification Target File" is selected, the selected module is added to
"Verification Destination Module".

Verification Source
Module

Displays the module selected as the verification source.
Only one module can be selected for this item.

Verification Destination
Module

Displays the modules to be verified.

button

Deletes the selected module.

*1: As this verification is conducted to check parameter inconsistency, the module without parameters

is grayed out and is not verified.
The module with uploadable parameters is verified, even if the parameters are not editable.
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8.6

67

Printing the project data

PURPOSE

MELSOFT

Prints the module configuration, module information list and module detail information of the

open project.

BASIC OPERATION

(1) Click the [File] = [Print] menu (é) or press the Ctrl | + P keys on the keyboard.
(2) Make settings on the opened screen, e.g. select the printing details (Module
Configuration, Module Information List or Individual Module Information (Module Detail

Information, Parameter)).

(3) Click the button to start printing.

Refer to 'Print examples'/7s) for the printing result.

DISPLAY/SETTING SCREEN

Print rodule
configuration
page 4

Print riodules
wertically / horizantally &

¥ Module Configuration

Module Tuming Pogition 45 Iignment

ﬁj_jj modules

: " Print the module name by columnar writing
Print rodule

infarmation
list

" Print the module name by honizantal writing

=|v  Module Infarmation List

Frint =& v |ndividual Madule [nfarmation [Madule Detail Information. Paramater)

individual

| Frint R ange
module 4

o+ Al Modules
1 Selected Modules The module to print

Modules to

print - al or Mo, [Siice|  Module Name Mo, [Slice|  Module Name
just selectzd 4 0 0 ST1H-PE 1] 0 ST1H-PE
5TIPSD

1 2 ST1PSD

Add madule
to print )
selection

Modules
selected for g
printing

ST1ADEA

3
4 ST1DAT

Remove
module from ¥
print zelaction 4

ﬂ

availableto
print A

Select}_f F'nnterSetupI Fage Setup I Print | Frint Presigw | Cloze I

setu
2 Show

s e
printer Setup page / Sendto :
: headings priter RIEVIEY .o
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E DISPLAY/SETTING DATA

Iltem Description
Module Configuration JCheck this item to print the module configuration.
Set the number of modules to be arranged horizontally when the module
Module Turning Position configuration is to be printed.
This item is available only when the "Module Configuration" is checked.
Module Information List ICheck this item to print the module information list.

Individual Module Information
(Module Detail Information,
Parameter)

Alignment Select the print orientation for the module names.
Print the module name byjPrints the module names vertically.

columnar writing BE

ICheck this item to print the detail information of the modules specified at
""Print Range".

| gl

=
=

(I8dLLE
130-9LX1LS

Print the module name byjPrints the module names horizontally.
horizontal writing

0 1 2

STIH-P ST1%16
= sTiesn |2

Set the modules to be printed when the detail information of individual
modules is to be printed.

Print Range This item is available only when the "Individual Module Information" is
checked.
All Modules JPrints the detail information of all modules.
Selected Modules Prints the detail information of the modules displayed in "The module to
rint".
button Adds the module selected in the left side list to the end of "The module to
| rint" as the module to be printed.
button \Withdraws the module selected in "The module to print" from the modules to
be printed, and deletes it from "The module to print".
Printer Setup | putton ISets the printer.
. Refer to 'Setting up the printer‘@ for detalils.
Page Setup | puit Sets the page layout.
utton Refer to 'Setting a page Iayout'Fﬁ for details.
Print| hutton Starts printing.
Print Preview button Closes this screen and displays a print image.
IRefer to 'Previewinc_; a print imac_;e' 741 for details.

Close | pytton |C|oses this screen without printing.
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8.6.1 Setting up the printer

ﬂb PURPOSE

Selects a printer for printing and sets the paper size, the printing orientation, and other
printing format-related items.

BASIC OPERATION

(1) Click the LPrinter Setup | hytton on the "Print" screen to display this screen.
(2) Select the printer for printing, and set the paper size, print orientation, etc.

(3) To close this screen, click the button.

DISPLAY/SETTING SCREEN

Print Setup

Prirter

Mame: Adobe LP-3200P53 Froperties..

Status; Ready

Type adobePS EPSON LP-3200PS 3
Where: =@ &

Commeni:

Paper Oriertation

S |A4 - ® Portiait

Source |Aut0rnaiicaHy Select L] " Lardscape

Networl. . 0K | Cancel

69 69



8 Project creation
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E DISPLAY/SETTING DATA

Item

Description

Printer

Selects a printer for printing.

Properties | putton

IClicking this button displays the properties dialog box.
The printer property option is used to make the basic settings of the printer.

Sets the size of the paper for printing and the paper feed method of the printer.

Paper The setting range depends on the printer.

Orientation —
IPortrait JCharacters will be printed along the paper feed direction.
ILandscape ICharacters will be printed across the paper feed direction.

Network | putton

Click this button when connecting to the shared network folder.
This item is displayed only when any of the following operating systems is
used.

« Microsoft® Windows® 2000 Professional Operating System

» Microsoft® Windows® XP Professional Operating System

» Microsoft® Windows® XP Home Edition Operating System
 Microsoft® Windows Vista® Home Basic Operating System

» Microsoft® Windows Vista® Home Premium Operating System
» Microsoft® Windows Vista® Business Operating System

» Microsoft® Windows Vista® Ultimate Operating System

» Microsoft® Windows Vista® Enterprise Operating System

OK button

ICIick this button after the printer setting is completed.

Cancel | pytton

|Cance|s the settings and closes this screen.

For the property setting of the printer, please read the manual of the used printer
carefully since the setting changes depending on the printer maker and model.
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8.6.2 Setting a page layout

PURPOSE

Makes settings related paper, page number, header, and so on.

BASIC OPERATION
(1) Click the button on the "Print" screen to display this screen.

(2) Set the paper, page number, header, etc.
(3) To close this screen, click the button.

DISPLAY/SETTING SCREEN

Paper
zelection J

Page Setup

Preview of

Paper page with J
: : these settings
SizelZ) I - (o A e—
i~ Print Orientation 17— Marginz [mm] ’
Riht Rl [200

Print i
@én ! * Portrait LeftiL)
Top(T] |25 Bottom (B] 25

" Landscape

Page Mo Setting | - Common Header Setting -
Howa tar Page Mo E [
print page S0EH g amal None x [~ Header Edit Header... |
nunbers -

I Ma. Position j[; b -
EIEEE Common Footer Setting -
Initial Y alue 11 :|___J ™ Eooter Edit Foater.

Page
| faoter test f

Setup
printer  §

(] | Cancel | Printer SetuplF)... J
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E DISPLAY/SETTING DATA

Iltem Description
Paper Sets paper size and paper feed method.
Print Orientation Sets the orientation of printing on paper.
Margins Sets the margins of the page.

Page No. Setting

Set the page number.

JPage No. Format

Select the page number format.

e "-**."indicates that a page number will printed on pages, starting from the
initial value.

e "-**[**_"indicates that a page number and the total number of pages will be
printed.

* Set "None" to print no page numbers.

INo. Position

Sets the position of page numbers.

Initial Value

Sets the page number to be printed on the first page. This can be useful if
lyou are printing the configuration as an appendix to another document.

Common Header Setting/
Common Footer Setting

IBy checking the check box, a header will be printed on each page.

Click the LEdit header |, ion, and the "Header Edit” dialog box as shown
Ibelow will be displayed.

Edit Header

Alternatively, clicking the LEAItheader | ion displays the "Footer Edit"

|dialog box like the Header Edit dialog box.

The header (or footer) can be edited within the range of 64 characters x
seven lines.

JLines and images cannot be edited, and characters cannot be decorated.

Preview This shows a graphical representation of how the page will look using the
current settings such as landscape / portrait, margins, etc.
OK button Click this button after the page setting is completed.

Cancel | ptton

ICanceIs the settings and closes this screen.

Printer Setup | putton

IBy clicking this button, the printer dialog box will be displayed.
Select the printer for printing and click the m button.

Page Setup
Frintes

Marne: 5. 30be LP-9200F: : Properties...

Status: Ready
Tupe: AdobePS EPSON LP-9200P53

where:
Comment:
MNetwark.,, Cancel
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gy

* If the print characters are small, reduce the value of margin setting.
» When the mouse button is clicked while the shape of the mouse pointer is @-, the

window zooms in.
When the mouse button is clicked while the shape of the mouse pointer is %, the

data is displayed in the standard scale.

MELSOFT
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8.6.3 Previewing a print image

ﬂb PURPOSE

The image of the entire page when it is printed will be displayed.

) BASIC OPERATION

(1) Clicking the button on the "Print" screen displays the print image of the
entire page.

(2) To return to the "Print" screen, click the button.
(3) To end the image display, click the button.

DISPLAY/SETTING SCREEN

&' MELSOFT GX Configurator-ST C:\MELSEC\SLICEWerifySample3a.st

et Page] Frey Page ] OnePage | Zoomln ] Foom Dt ] Llose

S [

Pages 1-2 (Edit Made
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E DISPLAY/SETTING DATA

Iltem Description
Print | pytton

JEnds the image display and starts the print.

Zoom In button The displayed image will be enlarged by clicking this button.
|Data will be displayed in three different scales.

Zoom Out | 1ton The displayed image will be reduced by clicking this button.

Close | yytton

When the mouse button is clicked while the shape of the mouse pointer is @, the
window zooms in.

When the mouse button is clicked while the shape of the mouse pointer is % the data
is displayed in the standard scale.

IEnds the image display.

8.6.4 Print Examples

Print examples are shown below.
(1) Module Configuration

(&) When "Print the module name by columnar writing" is set

Module Configuration
' 1 2 3 4"
IJ-:'
" m & I
i 121 — — -
= e} = = i
- [ =] B B
F15|E|E|B
o n ] (=)
1=
m | 2 )| '
3 = = =

(b) When "Print the module name by horizontal writing" is set

Hodule Conflgquration
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(2) Module Information List

Moduls Informaticn List

Input /Sutput Docupation Pointw

Bie L1

Kord L]

L L ETIH-PE LRl S 0002

.| @i [Mowtute Mame iy [ ey e e | i [ oot ama |

1 2 STLPED aq-n5 04-08

el e e e !p-l‘q_-.f
-

(3) Individual Module Information

Modsile Detail Infotmation

Module Hame 1 STIH-FB
Label Hame |
Bane Hoduls

He, o
Slica Ba. 1 0

Ex (HEX} + 00=03
B {HEX} | Be-03
W {HEX} g

Hw {HEX)

PArARSTAE

Ttem Sntting Yalus
Dueput status stk seddule srres frop
Exe_Diag informacion Enabls
SR LT T Tl

_qi_s:_h] - J

MELSOFT
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9 Editing the project

This chapter explains how to edit the project of GX Configurator-ST.

Always add the power distribution module to the project.

9.1 Adding the module

9.1.1 Adding the module with the "Add module" screen

ﬂb PURPOSE

Adds a slice module to the project.

BASIC OPERATION

(1) Execute any of the following operations to display the "Add Module" screen.
+

Click the [Edif] > [Add] menu (- ).

Press the + @ keys on the keyboard.

In the “Module Configuration Window”, right-click the list in the "Module list" or
“rack display” area, and click [Add] from the menu.
(2) Setthe addini position and model name of the module on the "Add Module" screen, and

click the LADd ] putton.
(3) To close the "Add Module" screen, click the button.

gy

Perform the operation with the "Module Configuration Window" screen open.

To display the "Module Configuration Window" screen, choose the [View] >
[Module Configuration] menu.

B

If adding the module would cause the power consumption to be exceeded for the
power supply module which serves the new module, you will be shown a warning
message which provides an opportunity to cancel the addition.

This warning is only shown once — it will not be shown if the power supply module
was already overloaded before the module was added.
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DISPLAY/SETTING SCREEN

Add Module

Inzert Position

Add at end
of rack 4
p— (* | ast Position

Select Module

7 Input/Dutput Module”

Type of
n'u:u:ll

e Inteligent Madule

™ Power Distribution Module Module
list

[ST1AD2H [withaut Y] e |
fidd | Class |

E DISPLAY/SETTING DATA

Item

Description

Insert Position

Set the position where the slice module will be inserted.

JLast Position

Sets the inserting position to the last line.
|[Example: When the module is added to the last line.

INo.

Select the "No." radio button and specify the inserting position with "No.".
JExample: When the module (ST1Y16-TPE3) is added to No. 3

Bafors addition After addition
odde Harma | BJHER] [ BaHER) BefiE] | WHHE] =
STk 001 00-0d | Vlﬂﬂ'l U'IS addlthI'l..
w1t X the medule Ha.3
w27 ot later will ba
AT h»r‘- Incremented by 1.

Select Module

Select the model name of the slice module to be added in the pull-down menu.

linput/Output Module

IDisplays the input/output modules in the pull-down menu to enable selection.

Iintelligent Module

IDisplays the intelligent function modules in the pull-down menu to enable selection.

IPower Distribution
Module

IDispIays the power distribution modules in the pull-down menu to enable selection.

button

Adds the slice module to the project.

Close | pytton

ICIoses this screen without adding the slice module.

*1: The slice module cannot be added in excess of the Maximum Input/Output points of the head

module.

Refer to 'Option setting'@ for the Maximum Input/Output points.
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9.1.2 Adding the module with the "Wizard area"

ﬂb PURPOSE

Adds a slice module to the project.

BASIC OPERATION

(1) Ensure that a module has been selected in the “rack display” / “module list” area — left
clicking on a module will select it.

(2) Select the type of module to be added from the tree in the "wizard area" of the “Module
Configuration Window” screen. When you have selected a module, its details will be
shown in the “information area” of the “Module configuration window”.

(3) Select either “Add before” or “Add after” to determine where the module will be inserted
relative to the selected module.

Click the button in the “wizard area”.

4)
— /@int
Perform the operation with the "Module Configuration Window" screen open.

To display the "Module Configuration Window" screen, choose the [View] >
[Module Configuration] menu.

gy

If adding the module would cause the power consumption to be exceeded for the
power supply module which serves the new module, you will be shown a warning
message which provides an opportunity to cancel the addition.

This warning is only shown once — it will not be shown if the power supply module
was already overloaded before the module was added.

79 79



9 Editing the project

MELSOFT

fCC-Link systems]

DISPLAY/SETTING SCREEN

To add a module before or after the current position, select it
frann the list and click Add
To remove the cunent module, select 'Delete’.

L 5TT<1B16-DE1-51-F/L ~
=1 Inteligent modules

- ST1AD2H

e ST1AD2Y

- ST1DAT
- 5T1DAY-

|-FO1

CTANAYE TOA

" Add before

Dielete

+ Add after

E DISPLAY/SETTING DATA

Item

Description

Insert Position

Set the position where the slice module will be inserted.

Inserts just before the currently selected module (to the left in the rack display).
Example: When the module ST1Y16-TPES is added before slot No. 4.

Bafors addition After addtion
| Modua Hers ||l.~4 E-Hl' WAHER] > w mammr
Add before < the module No.3
ot later will ba
- g | Incremented by 1.
Note: You cannot insert a module before the head module. A valid configuration
must always start with a head module followed by an ST1PSD bus refreshing
module.
Inserts just after the currently selected module (to the right in the rack display).
Example: When the module (ST1Y16-TPE3) is added after slot No. 2.
Bafors addition
Add after With this addition,
the medule Ha.3
ot later will ba
Incrementad by 1.

Select Module

Select the model name of the slice module to be added from the tree.

/0 module

JExpand this heading to show input/output modules.

Ilntelligent module

IExpand this heading to display the intelligent function modules in the tree.

IPower module

IExpand this heading to display the power distribution modules to enable selection.

button "t

Adds the slice module to the project.
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*1: The slice module cannot be added in excess of the Maximum Input/Output points of the head
module.
Refer to 'Option setting'/e9) for the Maximum Input/Output points.

[PROFIBUS-DP systems]

DISPLAY/SETTING SCREEN

To add a module befare or after the current position, select it
from the list and click ‘Add".
Toremove the cunent module, select Telets'

= Intelligent modules e
- BT1AD 2
o BT1AD 2 [without W]
- BT1AD2V
o BT1AD 24 without W]
T DA]
o BT1DAT - [without W)

FTARAA L FAA

(™ Add before (+ &dd after

Delete Add
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E DISPLAY/SETTING DATA

Item

Description

Insert Position

Set the position where the slice module will be inserted.

Add before

Inserts just before the currently selected module (to the left in the rack display).
Example: When the module ST1Y16-TPES is added before slot No. 4.

Before addidaon

T e | Wi =

Note: You cannot insert a module before the head module. A valid configuration
must always start with a head module followed by an ST1PSD bus refreshing
module.

Add after

Inserts just after the currently selected module (to the right in the rack display).
Example: When the module (ST1Y16-TPE3) is added after slot No. 2.

Before addition After addition

BefHE] | WAHE] =

Yytth this addition,

X the module No.3
or later will ba

© .| | Incremanted by 1.

Select Module

Select the model name of the slice module to be added from the tree.

/0 module

JExpand this heading to show input/output modules.

lintelligent module

Expand this heading to display the intelligent function modules in the tree.

In PROFIBUS-DP systems, some intelligent modules can be selected with the ‘Wr’
or ‘Ww’ range switched off. These modules will have an extra entry followed by
either “without Wr” or “without Ww".

JPower module

JExpand this heading to display the power distribution modules to enable selection.

Add button 1

Adds the slice module to the project.

*1: The slice module cannot be added in excess of the Maximum Input/Output points of the head

module.

Refer to 'Option setting'@ for the Maximum Input/Output points.
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If the module cannot be added because the resulting number of 1/0 bits, words or
intelligent modules would exceed the limits of the current point mode, the system will
check if there is another mode that would be suitable. For example, if more than 32
input/output bits are used in 32-point mode, it might still be possible to add the
module by switching to 64-point mode. If there is another suitable mode, a warning

will be shown:

MELSOFT GX Configurator-5T

< To make this chanage, the point mode must be set to '64-pk mode’s
H-'/ Do thiis now?

Answer to switch to the recommended mode and add the module, or to
cancel the addition of the module.
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9.2 Deleting a module

PURPOSE

Deletes the selected slice module from the project.

BASIC OPERATION

(1) Select the module to be deleted on the "Module Information List" screen.
(2) Execute any of the following operations.

* Click the [Edit] = [Delete] menu ( ).

* Press the | Ctrl] , [ Delete] keys on the keyboard.
* Right-click the module to be deleted on the "Module Configuration Window" screen
“Module list” or “Rack display”, and click [Delete] from the menu:

Toadd a modulg
ML fram the ligt and
Chrl+2 sthec

nodule:
add. ., Chrl+Insert [TTX1E
ITTH2-
T4
T1v18

All Delete

Trvie
Parameter Setking... ;TW2'
— [T
Option... Fi0 =fore
e Change head module
Power Distribution Check. D

¢ Click the button in the “wizard area”:

[IET | || rosddamcdis

from the list and
LR To remove the cul

LI LR LRt L L L I [
S LRSI LA T

= 10 modules
ST1x16-
ST1x2D
ST14D
ST1Y16-
ST1Y16-
ST1Y2HR

FTALA T

" Add before

» Delete D\ |

(3) On the opened screen, confirm the slice module to be deleted, and click the

button. This deletes the module.
The module Nos. greater than the deleted module No. are decremented by 1.
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9.3 Deleting all modules

ﬂb PURPOSE

Deletes all slice modules from the project.

) BASIC OPERATION

(1) Execute any of the following operations.

* Click the [Edit] = [All Delete] menu (E).
« Press the [ Shit] . [ Delete | keys on the keyboard.

* Right-click the list of the "Module Information List" screen, and click [All Delete] from
the menu.

(2) On the opened screen, click the button.

Perform the operation with the "Module Configuration Window" screen open.

To display the "Module Configuration Window" screen, choose the [View] >
[Module Configuration] menu.

9.4  Copying the module information

ﬂb PURPOSE

Copies the slice module from the saved project to the open project.
At this time, the parameters are also copied to the copied slice module.

=) BASIC OPERATION

(1) Click the [File] > [Copy] menu.

(2) Specify the copy source project with the button.
(3) Select the slice module to be copied, set the inserting position at the "Insert Position"
section, and click the button.

(4) To close this screen, click the button.
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int

Perform the operation with the "Module Configuration Window" screen open.

To display the "Module Configuration Window" screen, choose the [View] >
[Module Configuration] menu.

DISPLAY/SETTING SCREEN

Copy. E3)

Copu Source File

Diive/Path: |

File Mame: |- : Brawse...

Inzert Position-

Add

Lie Close

Copy source project

0 | corresponding module list
1 7 STIPSD
2 3 ST1X%16-DE1
3 il ST1Yv16-TPEZ
4 13 ST1PDD
5 20 ST1AD2Y
6 22 ST1DAZY
< | »

E DISPLAY/SETTING DATA

Item Description
Copy Source File Specify the copy source project.
Drive/Path Displays the drive and directory of the project.
File Name Displays the file name of the project.
Specifies the project.
The operation is the same as opening the existing project.
TOWSE | putton Refer to 'Opening an existing project'|s61 for details.

When the project is specified, the modules of the copy source project are
displayed in the "Copy source project corresponding module list".

Insert Position Set the position where the slice module will be inserted into the open project.
Last Position Sets the inserting position to the last line.
No. Select the "No." radio button and specify the inserting position with "No.".
Copies the slice module selected in the "Copy source project corresponding
button module list".

Copy is not executed when no slice module is selected.

Close | pytton Closes this screen.

Copy source project

corresponding module list Select the slice module to be copied.
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9.5

87

Undo

PURPOSE

Returns the following operations to the status prior to execution.
» Adding the module

* Deleting the module

* Deleting all modules

» Copying the module information

* Get System

BASIC OPERATION

MELSOFT

Executing any of the following operations returns to the status prior to the last operation.

* Click the [Edit] = [Undo] menu ('f-:I ).
* Press the + keys on the keyboard.

* Right-click the list of the "Module list" or “Rack display” areas of the
“Module Configuration Window”, and click [Undo] from the menu.
Repeating this operation returns to the status of up to the tenth preceding operation.

gy

The "Module Configuration Window" screen is displayed when the [View] >
[Module Configuration] menu is selected.
» The operation history is erased when the project is closed.

When the project is closed, the operation performed before closing the project
cannot be returned to the previous status.

» Perform the operation with the "Module Configuration Window" screen displayed.
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9.6 Redo

ﬂb PURPOSE

Returns to the status prior to the "Undo" processing in 'Undo'[s71.

BASIC OPERATION

Execute any of the following operations.

* Click the [Edit] > [Redo] menu ( i ).

* Press the + keys on the keyboard.

* Right-click the list of the "Module list" or “Rack display” areas of the
“Module Configuration Window”, and click [Redo] from the menu.

MELSOFT

Perform the operation with the "Module Configuration Window" screen open.

To display the "Module Configuration Window" screen, choose the [View] >
[Module Configuration] menu.

9.7 Rearranging the modules

9.7.1 Rearranging the modules with the Rearrange dialog

ﬂb PURPOSE

Rearranges the slice modules of the project.

The head module cannot be rearranged.

88
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BASIC OPERATION

(1) Execute either of the following operations.
* Click the [Edit] > [Rearrange] menu.
* Right-click the list of the "Module Configuration Window" screen “Rack display” or
“Module list” area, and click [Rearrange] from the menu.
(2) On the opened screen, select the slice module to be moved from among the slice
modules displayed in the list, and move it using the / button.

(3) To close this screen, click the button.

— fBun

Perform the operation with the "Module Configuration Window" screen open.

To display the "Module Configuration Window" screen, choose the [View] >
[Module Configuration] menu.

P

A valid system will always have an ST1PSD module immediately after the head module. If the
modules are rearranged in such a way as to leave another module type in the slot after the
head module, you will be prompted to rearrange the modules again.

L) pispLAY/SETTING SCREEN

Rearrange Oid

Mew pozition
positon . After Rear. | Current No. MB Mame = Morve up !
. 1 ] ST1PSD [leftinrack] A

5 ST1YV16-TEZ :
ST1Y16-TE2
JSTIX16-DE1 gl
“ sTIv2R2 4\(. I
CT1x2.D e
ST1x2-DET [right in rack]

ST1W16-TPE3 -

68 | Cancel |

89 89



9 Editing_] the project MELSOET

E DISPLAY/SETTING DATA

Iltem | Description
After Rearr. IDisplays the No. of the slice module after rearrangement.
Current No. IDisplays the No. of the slice module before rearrangement.
Module Name IDisplays the product model name of the slice module after rearrangement.

Changes the positions of the selected slice module with the one above that.
\When the selected slice module is at the top of the list, its position is not
changed.

button

Changes the positions of the selected slice module with the one below that.
oW button \When the selected slice module is at the bottom of the list, its position is not
changed.
OK button Validates the rearrangement and closes this screen.

Cancel | pytton

ICanceIs the rearrangement and closes this screen.

9.7.2 Rearranging the modules with drag and drop

In addition to the rearrange dialog, modules can be rearranged by dragging and dropping them directly
from the “Rack display” area of the “Module Configuration Window”.

ﬂb PURPOSE

Rearranges the slice modules of the project. Using this method allows several modules to
be moved at once.

The head module cannot be rearranged.

BASIC OPERATION

1. Click on the first
module to be moved. If
more than one module
needs to be moved,
keep the left button
held down.

" Click on the
2 first module 4
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2. If you want to move a

block of modules, keep

the left mouse button

held down and drag to
the last module in the

block.

The number field is
highlighted to show the
range of modules that
are currently selected.

3. Now all the modules
are selected, they can
be moved. Move the
mouse pointer over
one of the borders of
the selected modules,
so that the mouse
pointer changes to a
picture of a rack with
an arrow underneath it,
as shown.

Click and hold the left
mouse button - the
arrow will disappear.

4, With the left mouse
button still held down,
drag the modules to
their new position. An
outline border is drawn
around the position
where the modules will
be placed.

If the target position is
not visible, you can
drag the mouse pointer
near to the left or right
edge of the rack
display to scroll the
display.

91

Drag to zelect
more modules &

4 The no. field is
highlighted to show
the zelaction

Howver' over the
border of the
zelected modules,
then click the left
mouse button

Drag the
modules to their
rew position... 0

e elease the . 8
left mouse buttan

-

The outline

border shows the ¢
__ hew pozition .

MELSOFT
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5. When the left mouse
button is released, the
modules will be moved

tModules are

to the new position. moved to the )
new pogition, and .
They will be - selected

automatically selected
again, so that if the
target position was
'missed’, they can be
quickly dragged again
into the right position.

If you try to drag one or more modules to the left of the the head module or first power
supply module, the drag action will automatically be cancelled. A valid system must
always start with a head module and a power supply module.

9.8 Parameter setting

The following table shows the reference section for each parameter-related operation.
The operation can be performed on the "Parameter Setting" screen.
Refer to ""Parameter setting"” screen'/e3] for the operation to display the "Parameter Setting" screen.

Operation Reference Section
To set the parameters. 'Setting the parameters'@
To upload the parameters.
To download the parameters. 'Uploading / downloading /
To verify the parameters being edited and the parameters within the verifying'oe)
module.
To check the parameters being edited for errors and identify the 'Checking the parameters'
parameter errors. [98]
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9.8.1 'Parameter setting" screen displaying operation

) BASIC OPERATION

The "Parameter Setting" screen displaying operation differs among the following (1) to (3).

(1) Inthe edit mode

(@) When the "Module Configuration Window" screen is not displayed, choose the [View] >

[Module Configuration] menu to display the "Module Configuration Window" screen.

(b) On the "Module Configuration Window" screen “Rack display” or “Module list” area,
select the module whose parameters will be set.
(c) Execute any of the following operations to display the "Parameter Setting" screen.
=}

* Click the [Edit] > [Parameter Setting] menu ( I ).

* Press the key on the keyboard.

* On the "Module Configuration Window" screen “Rack display” or “Module list” area,
right-click the module whose parameters will be set, and click [Parameter Setting]
from the menu.

* On the "Module Configuration Window" screen “Rack display” or “Module list” area,
double-click the module whose parameters will be set.

(2) Inthe diagnosis mode

(&) When the "System Monitor" screen is not displayed, choose the [View] = [System
Monitor] menu to display the "System Monitor" screen.
(b) On the "System Monitor" screen, select the module whose parameters will be set.
(c) Execute any of the following operations to display the "Parameter Setting" screen.
=

:=]
* Click the [Edit] > [Parameter Setting] menu ( I ).

* Press the key on the keyboard.

» On the "System Monitor" screen, right-click the module whose parameters will be
set, and click [Parameter Setting] from the menu.

* On the "System Monitor" screen, select the module whose parameters will be set,

and click the | Parameter Setting | button.

(3) When the "Result Verify" screen is open after project verify

Execute either of the following operations to display the "Parameter Setting" screen.
» On the "Result Verify" screen, double-click the module whose parameters will be set.
» On the "Result Verify" screen, select the module whose parameters will be set, and

click the L Parameter Setting | ptton.
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9.8.2

94

Setting the parameters

ﬂb PURPOSE

Sets the parameters of the intelligent function module.

) BASIC OPERATION

MELSOFT

(1) When the module has the same parameters on multiple channels, select the channel

whose parameters will be set at "Channel”.
(2) Set the parameters in the "Parameter list".

(3) Click the button to close this screen.

DISPLAY/SETTING SCREEN

B Parameter Setting No.5

EEE

Module Infarmation
Slice Mo S5
~ Madule
Module Name - ST1AD2Y information y Eineg)
Label Name x
Baze Module :° ST1B-*4IR2
3 Orline
Online : operations &
Select Daba b Target Memory | Fam v
Selest Al Releass 41 |
- Upload | Download ‘ Werify Check for
Chanrel - BHYIE
Setto ;
Channel: CH1 - F'ar?n:eter defaulte = Default ‘ Enor Check.
[i3
Select Iterm ¥ o Setting ¥ alue
1 |Input range setting A0t 10 -
1 |Selting range 10t 104 -
1 |Time/nurmber of imes specification Murnber of timez -
1 |5ampling process/averaging process setting Sampling -
1 |Alarn output setting Dizable -
| |Disconnection detection setting Dizable -
1 |A/D conwversion enable/dizable setting Enable -
1 |B0/B0Hz notch filker specification Dizable -
1 |Average time/average number of times setting 4
1 |Upper upper limit value 4000
1 |Upper lower limit walue 4000
1 |Lower upper limit value -4000
1 [Lower lower limit value -4000
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95

E DISPLAY/SETTING DATA

Item

Description

Module Information

IDispIays the information (start slice No., module name, label name, base
module name) of the target intelligent function module.

button

\Validates the settings and closes this screen.

Cancel | pytton

ICanceIs the settings and closes this screen.

Specify the channel of the parameters to be displayed in the parameter list.

Channel Only when the intelligent function module has the same parameters on multiple
channels, this item is available.
Returns the parameters in the "Parameter list" to the default values.
elault | putton Only when the module has the parameters that can be changed, this item is

available.

Parameter list

A list of the parameters of the intelligent function module is displayed and can
be edited.

For the types and applications of the parameters of the module, refer to the
manual of the corresponding intelligent function module.

litem

IDisplays the parameter name.

Setting Value

Edit the parameter.
The parameter that cannot be edited is grayed out.
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9.8.3 Uploading/downloading the parameters or verifying the parameters being
edited and parameters within module
Uploads/downloads the parameters, or verifies the parameters being edited and parameters
within module.
(1) When the module has the same parameters on multiple channels, select the channel,
whose parameters will be uploaded, downloaded or verified, at "Channel".
(2) Select the parameters to be uploaded, downloaded or verified.
To make selection, mark the "Select" check box in the "Parameter list":
e s i v g g i -
e vﬁdisable 3etting Dizable -
1 »
(3) At"Target Memory", select the memory as the target of upload, download or verify.
(4) To upload the parameters, click the h button.
(5) To download the parameters, click the LDownload | pton.
(6) To verify the parameters, click the LYEMTY | putton.
(7) Click the i button to close this screen.
DISPLAY/SETTING SCREEN
B Parameter Seiting No.5
Madule Infarmation
Slice Mo gh
. todule
Module Mame - ST1AD2W ' information / Cancel
Label Mame
Baze Module - STI1B-"4IR2
Oriling Uueraliuns o
Select Data - Target Memony 'h‘
m M Upload | Download I WVerify ek for
Channel: cH1 ~ e F'anﬁgwlelar di?;tiﬁs = Default I Erer Check
Select Item . Setting Value
1 |lInput range setting S10to 10% -~
1 |Setting range 1010 10% -~
21| Timednumber of imes specification Wumber of times -~
1 |5ampling process/averaging process setting Sampling -
1 |Alarm output getting Diizable -
| |Dizconnection detection zetting Diizable -
L1 |A/D conversion enable/disable setting Enable -
1 |50460Hz notch filter specification Dizable -
| |Average time/average number of times sefting 4
I |Upper upper limit value 4000
I |Upper lower limit value 4000
I |Lower upper limit value -4000
1 |Lower loveer limit value -4000
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E DISPLAY/SETTING DATA

ltem | Description

Displays the information (start slice No., module name, label name, base
module name) of the target module.

Module Information

OK | putton ICIoses this screen.
Online [Perform operation for the target module.
Select Data Select the parameters to be uploaded, downloaded or verified.

Select All| pytton IChecks all "Select" check boxes in the "Parameter list".

Release All| hytton IUnchecks all "Select” check boxes in the "Parameter list".

Target Memory Select the memory as the target of upload, download or verify.
JUploads the parameters of the target module from the memory selected at

"Target Memory". )
button When the module has the same parameters on multiple channels, the
parameters of the channel selected at "Channel" are uploaded.
The uploaded parameters are displayed in the "Parameter list".

Checks the parameters for incorrect settings, and when they are correct,

downloads the parameters to the memory selected at "Target Memory".
button \When the module has the same parameters on multiple channels, the

parameters of the channel selected at "Channel" are downloaded.

If any parameter is incorrect, that parameter is not downloaded, and its name

under "ltem" is displayed red in the "Parameter list".

\Verifies the parameters of the memory selected at "Target Memory" and those
in the "Parameter List".
button \When the module has the same parameters on multiple channels, the
parameters of the channel selected at "Channel" are verified.
If any parameter is judged as inconsistent as a result of verify, its name under
"Item" is displayed red in the "Parameter list".
Specify the channel for which parameters will be uploaded, downloaded or
verified.
Only when the module has the same parameters on multiple channels, this
item is available.

|Displays a list of the parameters of the module.

Channel

Parameter list For the types and applications of the parameters of the module, refer to the

manual of the corresponding module.
Select Select the parameters used for the operation performed at "Online".
IDisplays the parameter name.
This item may be displayed red depending on the result of clicking the
Download | or | Verify | button.
JFor details, refer to the description of the corresponding button.
Displays the parameter value.

Downloading is not allowed to the items displayed in gray, however, uploading
and verification is available.

Jitem

Setting Value
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9.8.4 Checking the parameters for errors

ﬂb PURPOSE

Checks the parameters for errors and identifies the parameter errors.

) BASIC OPERATION

(1) When the module has the same parameters on multiple channels, select the channel,
whose parameters will be checked for errors, at "Channel".

(2) Click the LEITor Check | 1y jiton to start an error check.
(3) Click the button to close this screen.

DISPLAY/SETTING SCREEN
B Parameter Setting No.5 E| @@

Module Infarmation
Slice Mo S5
~ Madule
Module Name - ST1AD2Y ! infarmation y Eineg)
Label Name
Baze Module :° ST1B-*4IR2
3 Orline
Online : operations &
Select Daba b Target Memory | Fam v
Select Al Releaze Al
- Upload | Download ‘ Werify Check for
Chanrel - BHYIE
Setto ;
Channel: CH1 - F'ar?n:eter defaulte = Default ‘ Enor Check.
[i3
Select Item i Setting Walue
1 |Input range setting A0t 10 -
1 |Selting range 10t 104 -
1 |Time/nurmber of imes specification Murnber of timez -
1 |5ampling process/averaging process setting Sampling -
1 |Alarn output setting Dizable -
| |Disconnection detection setting Dizable -
1 |A/D conwversion enable/dizable setting Enable -
1 |B0/B0Hz notch filker specification Dizable -
1 |Average time/average number of times setting 4
1 |Upper upper limit value 4000
1 |Upper lower limit walue 4000
1 |Lower upper limit value -4000
1 [Lower lower limit value -4000
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E DISPLAY/SETTING DATA

Item

| Description

Module Information

Displays the information (start slice No., module name, label name, base module
name) of the target module.

OK | putton ICIoses this screen.
Specify the channel of the parameters to be checked for errors.
Channel Only when the module has the same parameters on multiple channels, this item

is available.

Error Check | putton

Checks the parameters for incorrect settings.
If any parameter has an incorrect setting, its name under "ltem" is displayed red
in the "Parameter list", as in the example below.

| AT | el PILILS s Seirng |L,II:,'CII -
il D48 conversion enable/dizable setting Digzable -
335333335 | =]
el

Parameter list

Displays a list of the parameters of the module.
For the types and applications of the parameters of the module, refer to the
manual of the corresponding module.

jitem

IDisplays the parameter name.

This item may be displayed red depending on the result of clicking the
Error Check | putton.

[For details, refer to the description of the Error Check | ytton.

9.9  Option setting

ﬂb PURPOSE

Sets the label name, base module, etc.

2 BASIC OPERATION

(1) Execute any of the following operations.
* Click the [Edit] = [Option] menu.
* Press the key on the keyboard.
« On the "Module Configuration Window" screen “Rack display” or “Module list” area,
right-click the module, where option settings will be made, and click [Option] from

the menu.

(2) On the opened screen, make option settings and click the button.

Perform the operation with the "Module Configuration Window" screen open.

To display the "Module Configuration Window" screen, choose the [View] >
[Module Configuration] menu.
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fCC-Link systems]
DISPLAY/SETTING SCREEN
For head module For slice module
Option
Madule Name STIHBT Madule Name 5T1RDZ
Lahel Marne Head madule Label Marne |
Baze Module J Bass Module  |ST1B-4IR2 j
i i ] v ; i
ok | Cancel | ok ] Cancel
@ DISPLAY/SETTING DATA
Item Description
Model Name Displays the product model name of the module for which option settings will
be made.
Enter any character string within 32 alphanumeric characters.
Label Name As the label name is displayed on the "Module Configuration Window" screen

or is output for printing, it is useful for module management, etc.

Base Module "+

Select the base module for the slice module.

Use Word Input Data

When the module has M word input, this box will be checked. If the M
word input data is optional for a module, it will automatically be unchecked in
CC-Link systems.

Use Word Output Data

When the module has ¥#n] word output, this box will be checked. If the [Ww.n]
word output data is optional for a module, it will automatically be unchecked in
CC-Link systems.

OK button

Validates the settings and closes this screen.

Cancel | pytton

Cancels the settings and closes this screen.

*1: For applicable base modules, refer to the manual of the module used.

Unlike PROFIBUS-DP systems, there is no selectable 'maximum input/
output points' setting for CC-Link systems. The maximum number of input
/output points is always fixed at 252 for CC-Link systems.

100
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[PROFIBUS-DP systems]

DISPLAY/SETTING SCREEN

For head module

I asimum Input0utput Points |258-pt mode x

& ]

Canecel |

Madule Name ST1H-PB Madule Name ST1RDZ
Label Mame |Head madule Label Hame |
Base Module | ~| BassModule  |STIB4IR2 ~|

For slice module

I Useword Output Data

oK I Cancel

E DISPLAY/SETTING DATA

MELSOFT

Iltem | Description
Model Name alzgleays the product model name of the module for which option settings will be
IEnter any character string within 32 alphanumeric characters.
Label Name As the label name is displayed on the "Module Configuration Window" screen or is

output for printing, it is useful for module management, etc.

Base Module "t

Select the base module for the slice module.

Maximum Input/Output
Points

Set the Maximum Input/Output points for the head module.

Use Word Input Data

\When the module has M word input, check this check box to use the M
word input.

Use Word Output Data

\When the module has word output, check this check box to use the
word output.

OK button

Validates the settings and closes this screen.

Cancel | pytton

Cancels the settings and closes this screen.

*1: For applicable base modules, refer to the manual of the module used.
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9.10 Power distribution check

ﬂb PURPOSE

Checks whether the sum of 5VDC internal current consumption required by the modules is
within the 5VDC maximum rated output current of the bus refreshing module.

For details of the calculation method used for this function, refer to the MELSEC-ST
System User's Manual.

BASIC OPERATION

(1) Execute any of the following operations.
* Click the [Edit] = [Power Distribution Check] menu.
« On the "Module Configuration Window" screen “Rack display” or “Module list” area,
right-click a menu and click [Power Distribution Check] from the menu.
(2) On the opened screen, confirm the check result.

(3) Click the button to close this screen.

Perform the operation with the "Module Configuration Window" screen open.

To display the "Module Configuration Window" screen, choose the [View] >
[Module Configuration] menu.
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DISPLAY/SETTING SCREEN

Power Distribution Check

Moo | Supply Cumentfs) | Consumptionfs] | Resut |
1 2.000 1.005 0K
g 2.000 2075 ERROR

Claze

E DISPLAY/SETTING DATA

Item I Description
No. IDisplays the mounting position of the bus refreshing module.
Supply Current (A) Displays the 5VDC maximum rated output current of the bus refreshing

module.

Consumption (A)

Displays the sum of 5VDC internal current consumption of the modules
owered by the bus refreshing module.

Result

Displays the check result.

"OK" : The sum of 5VDC internal current consumption is not greater than
the 5VDC maximum rated output current of the bus refreshing
module.

"ERROR" : The sum of 5VDC internal current consumption is greater than the
5VDC maximum rated output current of the bus refreshing module.

Close | yytton

Closes this screen.

To find the exact slot where the power consumption was exceeded (i.e. the
slot which needs another power supply module installed just before it), look at
the module listlss], where the module will be highlighted in red.
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9.11 Change head module type

ﬂb PURPOSE

Changes the head module type, i.e. from PROFIBUS-DP to CC-Link, or from CC-Link to
PROFIBUSDP. This is not the same as 'online module change', and cannot be used to

change the head module while the system is live. It only changes the configuration that is
being edited.

An alternative way to perform this change is to simply connect to a MELSEC-ST
system where the head module has already been replaced. If GX Configurator-ST
detects that the connected system is identical except for the head module, you will be
prompted to read the head module details from the system and continue.

) BASIC OPERATION

(1) Execute any of the following operations.
* Click the [Edit] - [Change head module] menu.

» On the "Module Configuration Window" screen “Rack display” or “Module list” area,
right-click a menu and click [Change head module] from the menu.

(2) In the confirmation dialog, select the new head module type from the list and then click
the button.

Change head module

Select the new head module bype from the lisk and
then click ‘Change’ to confirm,

e

Change | Close |

(3) A warning will be shown about the Wr and Ww ranges. Read this carefully and then
select either to continue or to cancel.
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gy

When you change from a PROFIBUS-DP head module to a CC-Link head module,
the parameter settings will be reset to defaults and all the modifiable 'without Wr' and
'without Ww' settings for intelligent modules will be reset to 'without' (as this feature is
not used on CC-Link systems). This change is not reversible, so if you change back to
a PROFIBUS-DP head module later, you will need to re-enter these settings.

gy

Perform the operation with the "Module Configuration Window" screen open.

To display the "Module Configuration Window" screen, choose the [View] >
[Module Configuration] menu.

MELSOFT
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10 Downloading and uploading the parameters

This chapter explains how to download or upload the parameters of each module.

10.1 Transfer setup

ﬂb PURPOSE

Sets the connection with the head module.

=22 BASIC OPERATION

(1) Click the [Online] = [Transfer Setup] menu.
(2) Make setting and click the button.

DISPLAY/SETTING SCREEN

Transfer Setup
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E DISPLAY/SETTING DATA

Item

Description

COM Port

Select the COM port connected with the head module.
|(Setting range: COM1 to COM10, default L COM1)

Transmission Speed

Select the transmission speed.
(Setting range: 9.6kbps, 19.2kbps, 38.4kbps, 57.6kbps, default "1, 9.6kbps)

Timeout 2

\When the external power supply of the MELSEC-ST system is switched off or
the head module is reset during communication with the head module, it will
take some time before a communication error is displayed.

The monitor displays Executing until the error is displayed.

The maximum time until the error is displayed can be found by the following
expression.

(Specified "Timeout" period) x 4

For example, when 5s was specified for "Timeout", (5s) x 4 = 20s and the error
is displayed in a maximum of 20s.

(Setting range: 1 to 9, default "L, 2)
J.rang

button

\Validates the settings and closes this screen.

Cancel | yytton

ICIoses this screen without making settings.

*1: When this screen is used the second or later time after installation of GX Configurator-ST, the
default is the value set when this screen was used the last time.

*2: If a communication error occurs during write to the ROM of each module, a maximum of 30s is
required before the error is displayed.

When a transmission speed of 19.2kbps or higher is set to "Transmission Speed",
some personal computers may be unstable, fail the communication and display the
following screen.

In this case, set a lower transmission speed.

int

p

- Cannot communicake with Head module for one of the Following reasons:
3
* Communications bmeouk,
* The preparation of communication environment is bad.
* Cable error.
* Cannok communicate with the transmission speed set up now,
To fiz this, try:
* Checking the cable and selected port number
* Setting transmission speed to 3 lower value,
* Closing other communication software applications and trying again.

<ES:0180840b

oK
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P

This setting only applies to communications between GX Configurator-ST
and the communication port on the head module. It is independent from
the transmission speed used for communications between the master
device and the PROFIBUS-DP or CC-Link communication port on the
head module.

10.2 Getsystem

ﬂb PURPOSE

Uploads the module configuration and the parameters from each module. This can be useful
if you have a configured SLICE system, but do not have the configuration file that was
originally used to build it.

BASIC OPERATION

(1) Either:

+ o
e Click the [Online] & [Get System] menu ([E ), or
e On the first wizard page (shown when GX Configurator-ST is started or after
selecting [File] = [New] ), select "Read the system configuration from the

communication port" then click the button.
(2) When the project is open, uploading the module configuration and the parameters of

each module erases the project information uploaded previously.
Hence, a screen appears asking whether data will be uploaded or not.

e Click the button to display the "Get System" screen.
In this case, the project information uploaded previously is erased.

e Click the button to stop processing.

(3) Set the data to be uploaded on the "Get System" screen, and click the button to
upload the module configuration and the parameters of each module.

(4) When upload is completed, the "Completed" message is displayed.
Click the button.
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DISPLAY/SETTING SCREEN

Get System

imformation?

[v Read Parameter
{* Rk
ROM

o]

Execute to read the Module canfiguration

" [The module without RO
will be read from Rk |

Cancel |

E DISPLAY/SETTING DATA

Item

Description

Read Parameter

Check this check box to upload the parameters of each module.
[The module configuration is uploaded regardless of the setting of this item.

IRAM

Uploads the parameters from the RAM of each module.
This item is available only when the "Read Parameter" check box is checked.

ROM

Uploads the parameters from the ROM of each module.

\When the target module does not have the ROM, the parameters are uploaded
from the RAM.

This item is available only when the "Read Parameter" check box is marked.

oK button

Validates the settings and closes this screen. On completion, the new
configuration will be available for editing.

Cancel | pytton

|Closes this screen without making settings.
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10.3 Get input/ output data settings (PROFIBUS-DP only)

ﬂb PURPOSE

Uploads the input/output data settings made using GX Configurator-ST from each module.
The following two different input/output data settings are uploaded.

» Maximum Input/Output points of the head module

« Setting of whether the word input/ word output of the intelligent function
module are used or not

BASIC OPERATION

(1) Click the [Online] = [Get Input/Output Data Settings] menu.

(2) A screen appears asking whether the settings will be uploaded or not.
Click the button to upload the input/output data settings.

(3) When upload is completed, the "Completed" message is displayed.

Click the button.
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10.4 Parameter block write

PURPOSE

Downloads the parameters to the modules in a block.

BASIC OPERATION

(1) Click the [Online] = [Parameter Block Write] menu to display the "Parameter Block
Write" screen.

(2) Select the target memory and parameters, and click the button.
(3) When download is completed, the "Download Completed" message is displayed.

Click the [OK] button,
(4) To close this screen, click the button.

DISPLAY/SETTING SCREEN

Preparing to download Downloading

Parameter Block Write Parameter Block Write @
Degelect all "
oot N Select Data s, mdles > { Select Data Target Memary |F|AM =
modules S e Al Relegse Al Stop wite Select Al Rel All
f et ‘ it | Download cEl = inprogress A | = ‘ == I Eancel(\J
"Write ta ! el
Select | Mo Module Namé modules tatus Select | Mo todule M ame Stal E:\l?irt}ﬁzl }
I 0 5T1H-FE 3l 0 ST1H-FB 5
%fTCtt\\‘ & 1 STIPSD . i 1 ST1PSD
T il 2 ST1DAZY ®m |2 ST1DA2Y Complete
il ) ST1AD2- e 3 ST1AD24 wiiting... s |
] 4 4 STIDAT I 4 ST1DAT it P “rite status )
Module list
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E DISPLAY/SETTING DATA

Item

| Description

Select Data

IBatch-select the modules whose the parameters will be downloaded.

Select All| putton

Selects all modules.

Release All| putton

IDeselects all modules.

Target Memory

Select the memory where the parameters will be downloaded.

* When "RAM" is selected, the parameters are downloaded to the RAM of
each module.

* When "ROM" is selected, the parameters are downloaded to the ROM of
each module.

* When "RAM/ROM" is selected, the parameters are downloaded to both RAM
and ROM of each module.

Download | ptton

Downloads the parameters of the module specified at "Select".
\While the parameters are downloaded, this button cannot be clicked.

Cancel | ptton

Stops download.
Only while the parameters are downloaded, this button can be clicked.

Select 1

Select the module whose parameters will be downloaded, by clicking on the
'Select' button to the left of the module name, so that it appears checked:

No.

JDisplays the module No.

Module Name 1

IDispIays the module name.

Status 1

Displays the download execution status.
Refer to (1) in this section for details of the execution status.

Close | pytton

Closes this screen.
\While the parameters are downloaded, this button cannot be clicked.

*1: For the module whose parameters cannot be edited, this item is grayed out and is not available,
as parameter download is not necessary.

(1) Download execution status
Details of the download execution status are described below.

Display I Description
. Iljndicates the module that does not have parameters or to which
arameters are not downloaded.
Wait Indicates the status prior to download.
Writing... lindicates that download is in progress.
Complete lindicates that download is completed.
Error Jindicates a failure in download.
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10.5 Offset/Gain setting of intelligent function modules

‘ For details of this function, refer to the manual of the used intelligent function module.

ﬂb PURPOSE

Sets the offset value or gain value of the intelligent function module’*.

*1: The following gives the examples of the intelligent function modules to which the offset
or gain value can be set.

* ST1AD2-V * ST1AD2-I
* ST1DA2-V * ST1DA1-|
* ST1IDA2-V-FO1 » ST1DA1-I-FO1

For details, refer to the manual of the used intelligent function module.
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1)

(2)

3)

(4)

()

(6)

(7)

) BASIC OPERATION

On the "System Monitor" screen, select the intelligent function module for which the
setting will be made.

On the "System Monitor" screen, click the button of "Forced Output Test Mode" to
change the MELSEC-ST system to the forced output test mode.

When the MELSEC-ST system is changed to the forced output test mode, the RUN
LED of the head module flickers.

Execute any of the following operations.
* Click the [Online] - [Offset/Gain Setting] menu.

« Right-click the module selected in (1), and click LOffset/Gain Setting | from the menu.
* Click the [Offset/Gain Setting] button on the "System Monitor" screen.
The dialog box appears asking whether or not the MELSEC-ST system will be changed

to the offset/gain setting mode.

Click the i button to change the system to the offset/gain setting mode.

When the system changes to the offset/gain setting mode, the RUN LED of the target
intelligent function module flickers (at 0.5s intervals) and the module's operation is
stopped.

Select the channel to be set at "Select Channel", choose the wiring method of the base
module at "Connection Method", and select the value to be set from "Offset" or "Gain".

Set the offset or gain value adjustment amount, and click the button.
Repeat the operation in Step (6) until the desired value is reached.

Click the button to download the offset or gain value to that intelligent function
module.

(8) To close this screen, click the button.
(9) The dialog box appears asking whether or not the MELSEC-ST system will be released

from the offset/gain setting mode.
Click the button to release the system from the offset/gain setting mode.

REMARK

(@)

If the MELSEC-ST system is not in the forced output test mode after the operation in
Step (3) is performed, the dialog box appears asking whether or not the MELSEC-ST
system will be changed to the forced output test mode.

Click the button to change the system to the forced output test mode.

(b) If the MELSEC-ST system is changed to the forced output test mode in (a), the dialog

114

box appears asking whether or not the MELSEC-ST system will be released from the
forced output test mode after the operation in Step (9) is performed.

Click the button when releasing the system from the forced output test mode.
Click the button when not releasing the system from the forced output test mode.

114



10 Downloading and uploading the parameters

DISPLAY/SETTING SCREEN

OffsetfGain Setting

Madule Information

No B

Slice Mo, S

Module Mame :  ST1DAZN
Label Mane

Baze Module : STI1B-*4IRZ

Select Channel

MELSOFT

Clear
rodule
eI

[~ CH2

Kalle /

Mew offzet

value
& ofiset | 00

Save | Cloge |

o
Save allto

E DISPLAY/SETTING DATA

Item

I Description

Module Information

Displays the information (No., start slice No., module name, label name, base
module) of the target intelligent function module.

Select Channel

Select the channel to which the offset or gain value will be set.

\When multiple channels are checked, the offset or gain values will be set to all
the corresponding channels.

The channels displayed in this item change depending on the module of the
setting target.

For details, refer to the manual of the used intelligent function module.

Set the offset value adjustment amount.

Offset This item is available only when the "Offset" radio button is selected.
For details, refer to the manual of the used intelligent function module.
Set the gain value adjustment amount.

Gain This item is available only when the "Gain" radio button is selected.

For details, refer to the manual of the used intelligent function module.

button

Turns ON the Error Clear to clear the error of the intelligent function
module.

Set button

Applies the set value to the target module.

Save | yutton

\Validates the value set with the button.

Close | yytton

Closes this screen and releases the system from the offset/gain setting mode.
Releases the MELSEC-ST system from the forced output test mode if it was
not in the forced output test mode when this screen was opened.
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11 Monitor, Test

This chapter explains how to monitor and test the modules.

11.1 System Monitor

ﬂb PURPOSE

Monitors the statuses of the head module and slice modules.

S

BASIC OPERATION

(1) When the "System Monitor" screen is not displayed, click the [View] = [System Monitor]
menu to display the "System Monitor" screen.
This menu item is only available when the system is in “Diagnosis” mode. To switch to
“Diagnosis” mode, [Mode] - [Diagnosis].

(2) Monitor starts as soon as the "System Monitor" screen is displayed.

(3) To close this screen, click the button.

B

The "System Monitor" screen is not displayed if the module configuration of the

MELSEC-ST system connected to the personal computer differs from that of the
project.

There is one exception to this - if the configurations are identical except for the head
module type, a message is shown giving the option to copy the head module details
from the live system and continue. This is intended to make it easier to reuse
configuration projects when changing the protocol type for a MELSEC-ST system.

Display the "System Monitor" screen after confirming that their module
configurations are the same.

i#' HELPAUR OPERATION

To identify the module where an error has occurred, execute the following operation on the
"System Monitor" screen.

(1) At"Select Module", confirm the area displayed red or yellow.

(2) Click the | Display Position | pton corresponding to the area confirmed in (1).
(3) The module whose "Module Status" in the "Module display" is displayed red or yellow is
where the error occurred.

Scroll the "Module display" to identify the module whose "Module Status" in the "Module
display" is displayed red or yellow.
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DISPLAY/SETTING SCREEN

[ Mudube Inlometrn N GoectModde )
bhodule Hame = 5T 1ADZY Dropday
Ll Haiire " Module = Fealion
TannModkie G710 ik, dEtES 4 Communication 1w
el shatus O
Cammunizanion Shalus Wik Magie: Claice : 1
Ho Commurscshion Fodule D =
shatus =
Muadule: Stabun |
[l Moo S Ene E] Hrrj:k".u"l‘.'nq [T Wedde Change D )
Ha | H Start / stop
Madkis Seanii e J manitaring
Moo Selch “
Elop
Forced

Faseed Dutput Tatt bads
[FF oN | OFF

output test
mode

It Cutoul | Fomed O

L] Tel

- : Other
Ditant/Gan | ocdn Diotad |1 commands #
Geltirg Indoiratior s

Ordne Mockds | Pavomnler
Change Setting

todule
dizplay

Cloee W,

E DISPLAY/SETTING DATA

Item | Description

IDispIays the information (module name, label name, base module) of the
module selected in the "Module display".

Indicates the status of communication between the head module and master

station.

"Communicating"” : Communicating with the master station

""Communication suspended" : Communication with the master station
suspended (Interruption)

"No communication” : Communication with the master station
stopped (No communication)

Displays the samples of the colors displayed under "Select Modules" and
under "Module Status" in the "Module display".
Module Status B Red System error
[vellow : Warning
E=] Purple : Module being changed online

Displays the illustrative image of the MELSEC-ST system being monitored.
\When using the function specific to a certain module, click and select the
module from this item.

At "Module Status" above the module, the operating status of the slice
module is displayed.

Refer to (1) in this section for details of the module status.

[The currently selected module is shown with the slot number coloured in
rey. Click on a module to select it.

[The numerals indicate the module Nos., and the color shows the statuses of
the modules in that range. The modules displayed in the "Module display"
can be changed.

Refer to (1) in this section for details of the module status.

Module Information

Communication Status With
Master Station

Module display

Selected module

Select Module Range
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Item

Description

| Display Position |
button

The numerals on the left of this button indicates the module Nos., and the
fcorresponding modules are displayed in the "Module display".

Monitor Switch

Starts/stops monitor.

button

Starts monitor.
This button is usable only while monitor is at a stop.

\While monitor is executed, " * * flickers on the left side of this button.

Monitar Switch

J Stop

Monitoring
indicator

[Stop] putton

oy St e Stop
monitaring ; momtonng"__
Stops monitor.

This button is usable only while monitor is executed.

Forced Output Test Mode

Sets/releases the MELSEC-ST system to/from the forced output test mode,
Jand displays the current mode status.

Farced Output Test Made

ON button

Sets the MELSEC-ST system to the forced output test mode.

|OFF | putton

IReIeases the MELSEC-ST system from the forced output test mode.

[Input/Gutput Monitor | 1tton

Monitors the input data and output data of the module selected in the "Module
display".

Refer to 'Input/Output monitor'[24) for details.

\When no module has been selected, the error message is displayed and
monitor cannot be executed.

[ Forced Cutput Test| putton

Runs a forced output test on the head module, output module or intelligent
function module selected in the "Module display".

Refer to 'Forced output test'[127] for details.

\When no module has been selected, the error message is displayed and the
forced output test cannot be executed.

[ Offset/Gain Setting | yton

selected in the "Module display".

Refer to 'Offset/Gain setting of intelligent function modules' [1:3) for details.
\When no module has been selected, the error message is displayed and the
offset or gain value cannot be set.

[ Module Detail Information |
button

Monitors the detail information and error status of the module selected in the
"Module display".

Refer to 'Module detail information'[120) for details.

\When no module has been selected, the error message is displayed and
monitor cannot be executed.

[ Gnline Medule Change | putton

Performs the online change of the 1/0O module or intelligent function module
selected in the "Module display".

Refer to 'Online module change'@ for details.

\When no module has been selected, the error message is displayed and
online module change cannot be executed.

‘Sets the offset or gain value to the target intelligent function module which is

| Parameter Setting | ptton

Sets the parameters to the head module, I/O module or intelligent function
module selected in the "Module display".

Refer to Section 'Parameter setting'@ for detalils.

\When no module has been selected, the error message is displayed and
parameter setting cannot be executed.
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ltem Description

Close | yytton ICIoses this screen.

(1) Module status
Details of the module status are described below.

Display Description
& System error occurred.
Red For details of the error, refer to the manual of the corresponding
module.

& Warning occurred.
Yellow For details of the warning, refer to the manual of the corresponding

[ module.
B purple IModuIe being changed online

O Gray IModu_Ie not mounted
Gray is displayed for "Select Module" only.

L] white IOperating normally

If the slice module is changed for another type of module during a monitor stop on this
screen and the monitor is then resumed, the items corresponding to the new module
and modules of the following Nos. are displayed red in the "Module Status" section.
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11.2 Module detail information

120

Modube Detail Information

PURPOSE

Shows the module detail information, and monitors the corresponding module operation
status and error status.

BASIC OPERATION

(1) On the "System Monitor" screen, select the module to be monitored.
(2) Execute any of the following operations to display the "Module Detail Information™ screen

and start monitor.

* Click the [Diagnostics] - [Module Detail Information] menu.
* Right-click the module selected in (1), and click [Module Detail Information] from the

menu.

« Click the [ Module Detail Information| pytton on the "System Monitor" screen.

(3) To update the operation status or error status, click the button.
(4) To close this screen, click the button.

[CC-Link systems]
DISPLAY/SETTING SCREEN

Mochbe Detad Inormabon

Mokl Mans
Lkl Fne
1o o

Esil sigten couil
Esp. oo smiibog
Venan

Caytmare Emmer/Shshis

1
1
[rauble
244

ST1HeT

For head module

Module
infarmation &

Commerse shon Baud Faie

Bl

ha BIE)

Custer! EreeSagen

[HEHH Mo m
Active
enar

Enisi/Status Lug
Mo HE=)

Emad5tahe Log

Mode . Pricsity min_ stalions

Update : i
information f Cee |

ClaaiLog |
e |

Clear emar ™y
histary

For power distribution module, 1/0
module or intelligent function module

Module Detail Information @
todule Detsil Infarmation
Slice Mo, AT
S Module
tdodule Mame ST1DAT details
Label Hame S
Baze Module 1 STIB-4IR2
Wersion D BAA
BrHEX] : OE-11
B(HEX) COE-TT
WHEX] x 07
. Update
Wn[HEX) o 02-03 .
Current Error 1 2
Refresh
Mo, (HEX) Current Error 2
chive
0000 Mo error w Bl
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E DISPLAY/SETTING DATA

Item

| Description

Module Detail Information

IDisplays the information of the module to be monitored.
This item includes the following information.

 Start slice No. 1

e Module name
* Label name

- Station No. 2
"---" is displayed if the Station No. set with the address setting switches of the
head module is outside the setting range.
For details, refer to "Current Error/Status" or "Error/Status Log" on this screen.
- Base module name -
« Excl. station count 2 - the number of stations used for communications.
* Exp. cyclic setting 2 _ the number of cycles taken to read the data.
* Version
The module version is displayed.
If a module does not support this, "- - -" is displayed instead.
« Mode 2

« Communication baud rate "
"--"is shown if the MELSEC-ST system is not communicating with the master
station.

g Bit Input 1 Bit Output Ly Word Input 1,73 Word

Output 1,73

2

Current Error/Status "2, "4

IDisplays the current operation status or error information of the head module.

Current Error

INo. (HEX) IDisplays the error code in hexadecimal.
ICurrent Error/Status IDisplays the operation status or error definition.
*l‘ *4

IDispIays the current operation status or error information of the target module.

INo. (HEX)

IDisplays the error code in hexadecimal.

ICurrent Error/Status

IDisplays the operation status or error definition.

Error/Status Log "2, "4

Displays the operation status or error history of the head module.

The latest log is displayed in the top line (descending order).

This item displays up to five status or error logs. When information is added as
the sixth status or error, the information is deleted in the order from the oldest to
the newest.

Switching off the external power of the MELSEC-ST system or resetting the
head module erases the data of this item.

INo. (HEX)

IDisplays the error code in hexadecimal.

[Error/Status Log

IDisplays the operation status or error definition.

Refresh| yton

IUpdates the data of "Current Error/Status" and "Error/Status Log".

Close | yytton

|C|oses this screen.

M button 2

The data of "Current Error/Status" are not erased.

|Erases the data of "Error/Status Log".

*1: This item is available for the power distribution module, 1/0O module or intelligent function module.
*2: This item is available for the head module.

*3: “-" is displayed for the Bit Input / Bit Output / Word Input / Word Output

when the target module does not occupy the corresponding area.
*4: For details of the errors, refer to the manual of the corresponding module.
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int

In CC-link systems, the address ranges are sometimes referred to differently. CClink's|
'RX" and 'RY' ranges are equivalent to the 'Br' and 'Bw' ranges shown in
GX Configurator-ST and CC-link's 'RWr' and 'RWw' ranges are equivalent to "Wr' and

‘Ww',

[PROFIBUS-DP systems]
DISPLAY/SETTING SCREEN

For head module For power distribution module, 1/0

module or intelligent function module

Module Detall Information x| Module Detail Information

Moduie Dietad ndpemaptaon

todule Detsil Infarmation

Madde Hams :© STIH-PE
Lated Hame 7 MDdU|E r
FOlAddwss | 42 information _Updatg Slice Na. R Wodul
b e il - = I '”fO'mat'D Module Name ST1DATY detalls J
Cumert Enos/Slihus J Label Name : e
Ha, (HEX) Lurran ErrorfSume Pt Base Module i ST1B-4IR2
OG0 Mo errar
Active O | Wergion BAA
ot - BiHEX) R
: BiIHEX) S OE-TT .
WilHE:] 22

Emore/Stahus Log

Ho (HEX ErrorfStanss Log = el WlHEX) o 02403 e

_/_—K\_\ 1~ Current Error 1
T Refresh

lear erar } Mo, (HEX) Current Error

histary Active
“'\a—_-n# 0000 Mo error w Cloze
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E DISPLAY/SETTING DATA

Item

| Description

Module Detail Information

IDisplays the information of the module to be monitored.
This item includes the following information.

» Start slice No. 1
* Module name
* Label name

* FDL Address
"---"is displayed if the FDL address set with the FDL address setting
switches of the head module is outside the setting range (100 or later).
For details, refer to "Current Error/Status" or "Error/Status Log" on this
screen.

. Base module name -
* Version
The module version is displayed.
If a module does not support this, "- - -" is displayed instead.

* Maximum Input/Output points "2
* Transmission speed 2

"--" is displayed when the MELSEC-ST system is not communicating with the
master station.

A Bit Input "%/ Bit Output Y/ Word Input 1 "3 [ W¥wn

Word Output 1,73

2

Current Error/Status > 2

IDisplays the current operation status or error information of the head module.

Current Error

INo. (HEX) IDisplays the error code in hexadecimal.
ICurrent Error/Status IDisplays the operation status or error definition.
*11 *4

IDispIays the current operation status or error information of the target module.

INo. (HEX)

IDisplays the error code in hexadecimal.

ICurrent Error/Status

IDisplays the operation status or error definition.

Error/Status Log 2,74

Displays the operation status or error history of the head module.

The latest log is displayed in the top line (descending order).

This item displays up to five status or error logs. When information is added as
the sixth status or error, the information is deleted in the order from the oldest
to the newest.

Switching off the external power of the MELSEC-ST system or resetting the
head module erases the data of this item.

INo. (HEX)

IDisplays the error code in hexadecimal.

|Eror/Status Log

IDisplays the operation status or error definition.

Refresh| yton

IUpdates the data of "Current Error/Status" and "Error/Status Log".

Close | pytton

ICIoses this screen.

[Clear Log| pytton 2

The data of "Current Error/Status" are not erased.

|Erases the data of "Error/Status Log".

*1: This item is available for the power distribution module, /0O module or intelligent function module.
*2: This item is available for the head module.

*3: For the Word Input/ Word Output, "-" is displayed when the target module does not
occupy the corresponding area.
*4: For details of the errors, refer to the manual of the corresponding module.
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11.3 Input/Output monitor

ﬂb PURPOSE

Monitors the input data and output data of the module.

=) BASIC OPERATION

(1) On the "System Monitor" screen, select the module to be monitored.

(2) Execute any of the following operations to display the "Input/Output Monitor" screen and
start monitor.
* Click the [Online] = [Input/Output Monitor] menu.
* Right-click the module selected in (1), and click [Input/Output Monitor] from the menu.

« Click the [InputfGutput Monitor | htton on the "System Monitor" screen.
(3) To close this screen, click the button.

— /@int
In CC-Link systems, the following areas are not available for I/O monitoring:
. Error Clear area

. Word Input area of intelligent output modules
. Word Output area of intelligent input modules
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DISPLAY/SETTING SCREEN

M [nput/Uutput Manitor No.4

Mo |réormabion

Momitor Swich
" Start / stop
5 Step | =™ monitoring 2

Shee o CR todule
Moduls Name STIDAT details” &
Bit Data
Diuitpast Dl lkerm Walue |nput Daba Hhem
B Dutpist frea Consven teitirg iegue Mo reguetl  |B Irput Ares Mocdhle resdy
CHT carlpodt s sbda/dizable fagl Dicable Conrveit selling compleled i
Eien Clesi frea Entor clesi raguest Mo reguetl  |Encd [nhoamarion Asesi CHT seroe silosmation

# Bitinput £y
output data

1 J L3
\Word Diata
& DEC T HEX
it Diata | Ihem [ vaie |  (mowtData | Ihem [ value

aoed Oluilpest Auea | CH1 v ahus 2l

0

\word |

Ades CH1 degtal value |0

Word input # ™~
output data &

MELSOFT
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E DISPLAY/SETTING DATA

Item

Description

Monitor Switch

Starts/stops monitor.

Starts monitor.
This button is usable only while monitor is at a stop.

\While monitor is executed, " * " flickers on the left side of this button.

-Starl button Moritor Switch
k St
Monitaring 2 - J 2P
indicator & == Ctart e Sion
monitaring p } monitoring..__
[Stop | putton Stops monitor.

This button is usable only while monitor is executed.

Close | yytton

ICIoses this screen.

Module Information

Displays the information (start slice No., module name, label name) of the
module to be monitored.

Bit Data

IDispIays the input/output data of the target module in bit unit.

Word Data 1

\When the target module is the intelligent function module, displays the M

\Word Input values and Word Output values.

Selecting the DEC or HEX radio button displays the values displayed under
"Value" in decimal or hexadecimal.

DEC: Decimal

HEX: Hexadecimal

*1: For details of each data, refer to the manual of the corresponding module.
*2: When the MELSEC-ST system is in the forced output mode, the values entered on the "Forced
Output Test" screen are displayed.

gy

The rate at which values are updated on the "Input / Output Monitor" screen
depends on the following conditions:

e Transmission speed (refer to Transfer Setup el
e The number of open input/output monitor windows
e The status of the system monitor

To get the best input/output monitor performance:
e Do not open several input/output monitor windows
e Stop the system monitor
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11.4 Forced output test
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™ purrosE
Runs an output test on the Bit Output, Word Output and Error Clear

bits of the head module and slice modules without stopping the PROFIBUS-DP or CC-Link
network ( Error Clear bits are available for PROFIBUS-DP only).

BASIC OPERATION

(1) On the "System Monitor" screen, select the module to be monitored.

(2) On the "System Monitor" screen, click the button of "Forced Output Test Mode".
This displays a screen asking whether or not the MELSEC-ST system will be changed
to the forced output test mode.

Click the button to change the MELSEC-ST system to the forced output test
mode.

When the MELSEC-ST system is changed to the forced output test mode, the RUN
LED of the head module flickers.

(3) Execute any of the following operations to display the "Forced Output Test" screen.
* Click the [Online] - [Forced Output Test] menu.
* Right-click the module selected in (1), and click [Forced Output Test] from the menu.
« Click the Ferced Cutput Test| hytton on the "System Monitor" screen.

(4) On the "Forced Output Test" screen, select the forced output test item and set data, and
click the button to start the forced output test.

(5) When the forced output test is completed, the "Completed" message is displayed.

Click the button.
(6) To close this screen, click the button.

(7) On the "System Monitor" screen, click the button of "Forced Output Test Mode" to
release the MELSEC-ST system from the forced output test mode.

B

(1) If any of Convert setting request, (Bw.#3] [Bw.n+2| cHyO output

permission ON/OFF, and LY¥%.n] |Ww.n+1| cHO digital value setting is changed

in the forced output test, fully ensure safety before starting the test as the analog
output will change.

(2) When the communication between the MELSEC-ST system and master station is
disconnected, changing the Convert setting request of the intelligent
function module, whose CHL CLEAR/HOLD/PRESET setting is set to HOLD,

from ON to OFF in the forced output test turns the Word Output value to
0

In this case, the Word Output value will not return to the held value if the
forced output test mode is canceled.

127



11 Monitor, Test

MELSOFT

128

gy

. Error Clear area

In CC-Link systems, the following areas are not available for forced output tests:

. Word Output area of intelligent input modules

REMARK

(a) If the MELSEC-ST system is not in the forced output test mode when the

button is clicked in (4), a screen appears asking whether or not the MELSEC-ST
system will be changed to the forced output test mode.

Click the button to change the system to the forced output test mode and start the

forced output test.

(b)

When the MELSEC-ST system was changed to the forced output test mode in (a), a

screen appears asking whether or not the system will be released from the forced
output test mode after the operation in Step (6) is performed.

Click the button when releasing the system from the forced output test mode.
Click the button when not releasing the system from the forced output test mode.

DISPLAY/SETTING SCREEN

M Forced Dutput Test No.4

Select / Select AN |

deselect =
all items

Sl Closs

" Rolaase Al | ]
Matkde Iriesmakion Set output
values g

Shes Ho 7

CHY owpuat erlaber'-:l'rsaﬂ.e;iaum Dirzable

M . STIDAY ==
nchde Name STIDA s tMaodule
Ll Name detailz &
it Data :
Dulpul Dl Select. flern Hame Vi
Het Dlutpod Siss 4 |Corvesl setling requssl Mo isguest

- 1!1

Emroe Claar Arna Emor cloar mmquest No ragquest
Bit qutputs ™
word Data
~ DEQ (" HEX
Diitgndt Dala I Slleul[ | ity W aime I Vil
Joid Dutpud Aisa ] |U’|'| sl vl pelling ]
< |

Wword
Outouts
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E DISPLAY/SETTING DATA

Iltem Description
Checks all "Select" check boxes of "Bit Data" and "Word Data". A 'tick' is
shown to indicate that the parameter is selected, as shown in the picture
below.
Select All| putton

Release All| putton

IUnchecks all "Select" check boxes of "Bit Data" and "Word Data".

button

Runs a forced output test on the |Bw.n| g;; Output, [Ween ] \worg Output @

and (in PROFIBUS-DP only) Error Clear whose "Select" check boxes
are checked.

( Error Clear bits are available for PROFIBUS-DP only)
\When the forced output test is completed, the "Completed" message is
displayed.

Close | pytton

Closes this screen.

The screen to release the MELSEC-ST system from the forced output test
mode is displayed if the system was not in the forced output test mode when
this screen was opened.

Module Information

Displays the information (start slice No., module name, label name) of the
module on which a forced output test will be conducted.

Bit Data 1

Select the bit data on which a forced output test will be conducted by checking
the corresponding "Select" check box, and set the bit value to be output at
"Value".

Word Data *"?

Select the word data on which a forced output test will be conducted by
checking the corresponding "Select” check box, and set the word value to be
output at "Value".

Selecting the DEC or HEX radio button changes the input format of "Value" to
decimal or hexadecimal.

DEC: Decimal

HEX: Hexadecimal

*1: For details of each data, refer to the manual of the corresponding module.
*2: In CC-Link systems, word output data is not available for intelligent input modules.
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11.5 Master station data communication monitor

11.5.1 Master station data communication monitor

PURPOSE

Monitors the input/output data between the master station and head module of the
PROFIBUS-DP or CC-Link system.

BASIC OPERATION

(1) Click the [Diagnostics] > [Master Station Data Communication Monitor] menu to display
the "Master Station Data Communication Monitor" screen and start monitor.
(2) At"Select Area", select the I/O data to be displayed in the "Data display".

(3) To save the monitored data into a text file, click the button to stop monitor, and

click the LCopy to File | 5 ytton

Refer to 'Saving the communication data’ 1! for details.
(4) To close this screen, click the LCI0S€ | putton.

DISPLAY/SETTING SCREEN

Master Station Data Communication Monitor

Arza

filter
dizplay i _
format S'Wﬂfd Data- o Monitar _‘i Start / stop
: " DEC[signed) ( DEC[unsigned] & HEX ‘ Stop | =, moritaring

address | FlE[D] ]

Export datato
file

Copp tFiIe | Cloze ‘

Bit Input Avea

wrd Select Area

slalzlels]als]2]1]0] word Data
Ha440
HOOOO
HOOOO
HOOOO
HOOOO
HOOOO
HOOOO
HOOOO
HOOOO
HOOOO

ata
farmat

Lo Tl o o I o o o e o o

Diatain
ward 4
format £

ool olcleleiciclcie gl lelo
cococococococoooooo o oo
clocococococococo o oo oo
SR = == = == == P
clccococococococooocoo ool
e e e i e i = B i = i = R i = e
coocoococcoc oo oo cioco
Clololoolclcloiciclcle oo clo
coococoooocoocoo o oo
coloolblolcloololcoloiclclo

cloococolocococdoocoooco—
clooooloococolooooloo o
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[CC-Link systems]
@ DISPLAY/SETTING DATA

Item

I Description

Select Area 1

IFrom among the following items, select the I/O data to be displayed in the
"Data display".

Bit Output Area : Bit Output Area
Word Output Area : Word Output Area
Bit Input Area : Bit Input Area
Word Input Area : Word Input Area

Copy to Filg | p tton

Saves the monitored data into a text file.
JRefer to 'Saving the communication data’ 133 for details.
\While monitor is executed, this button is not usable.

Save the data after clicking the button to stop monitor.

Close | yytton

ICIoses this screen.

Changes the representation of the word values in the text file to be saved with
the

Word Data
button and in the "Data display".
IDEC(signed) IDisplays the values in signed decimal.
|IDEC(unsigned) [Displays the values in unsigned decimal.
JHEX IDisplays the values in hexadecimal headed by "H".
Monitor Starts/stops monitor.
Starts monitor.
This button is usable only while monitor is at a stop.
\While monitor is executed, " * " flickers on the left side of this button.
button Manitor Switch

J Stop

Monitaring
indicator

@PJ button

£ ey Stat New Stop
monitoring ; monltonng"__
Stops monitor.

This button is usable only while monitor is executed.

Data display 1

IDisplays the data in the data range selected at "Select Area".
"Address" is the offset address of the data selected at "Select Area", with
Address O set as the start address.

*1: For details of the I/O data, refer to the Head Module Manual.
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[PROFIBUS-DP systems]

E DISPLAY/SETTING DATA

Item

I Description

Select Area 't

IFrom among the following items, select the I/O data to be displayed in the
"Data display".

All Area : All'l/O data

Bit Output Area : Bit Output Area

Error Clear Area : Error Clear Area
System Area : System Area
Command Execution Area : Command Execution Area
Word Output Area : Word Output Area
Bit Input Area : Bit Input Area

Error Information Area : Error Information Area
Module Status Area -[Mr] Module Status Area
Command Result Area : Command Result Area
Word Input Area - [ word Input Area

Copy to Filg |y tton

Saves the monitored data into a text file.
[Refer to 'Saving the communication data’ (1231 for details.
\While monitor is executed, this button is not usable.

Save the data after clicking the button to stop monitor.

Close | pytton

Closes this screen.

Changes the representation of the word values in the text file to be saved with
lthe

Word data
button and in the "Data display".
IDEC(signed) IDisplays the values in signed decimal.
[DEC(unsigned) [Displays the values in unsigned decimal.
JHEX IDisplays the values in hexadecimal headed by "H".
Monitor Starts/stops monitor.
Starts monitor.
This button is usable only while monitor is at a stop.
\While monitor is executed, " * " flickers on the left side of this button.
button Manitor Switch

J Stop

Monitaring
indicator

[Stop] putton

£ e . Start T Stop
monitoring ; monltonng"__
Stops monitor.

This button is usable only while monitor is executed.

Data display 1

IDisplays the data in the data range selected at "Select Area".
"Address" is the offset address of the data selected at "Select Area", with
IAddress 0O set as the start address.

*1: For details of the I/O data, refer to the Head Module Manual.
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REMARK

When confirming the data for each module, use the "Input/Output Monitor" screen.
Refer to 'Input/Output monitor' 24l for details.

11.5.2 Saving the communication data

PURPOSE

Saves the /O data, which were monitored on the "Master Station Data Communication
Monitor" screen in 'Master station data communication monitor'[0, into a text file.

BASIC OPERATION

(1) On the "Master Station Data Communication Monitor" screen, click the button to

stop monitor, and then click the LCOPY to File| 1y ton.

(2) Set the destination directory and file name, and click the button to save the
monitored data into a text file and close this screen.

DISPLAY/SETTING SCREEN

Copy to file E'ﬂ

S e [ L SLICE

K
]
O

ke
= Magker

Fibe rame: | Save

Save 2s pe | Moo dalal” 14) = Carcel |

E DISPLAY/SETTING DATA

Iltem Description
Save in Select the directory that stores the monitored data.
File name Set the file name of the monitored data.

Save | ptton Saves the project with the file name specified at "File name".

Cancel | ptton

ICIoses this screen without saving the project.
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(1) Example of text file for saving data
The following shows an example of the text file for saving data.

B MasterStationCommsOutput.txt - Notepad g@@
File Edit Format View Help

G éuni‘:'ﬁ'"gurafur‘—ézrur'\ﬁasfer station Data communication Monitor ~
Monitor Data @ All area

0oo0 00 0000000000000 0 @ HOQOO
ool : 00 0000000000000 O0 @ HOOQO
goo2 1 0000000000000 000 @ HIQOO
Qo0 : 000 QO0CO0OQO0CO0OO0QO0O0OO0C0O0O0 @ HOOOQO
gop4 0000000000000 000 @ HIQOO

11.6 PROFIBUS-DP Network Parameter Monitor (PROFIBUS DP only)
11.6.1 PROFIBUS-DP Network parameter monitor

ﬂb PURPOSE

Confirms of the slave parameters and PROFIBUS-DP network parameters sent from the
master station of PROFIBUS-DP to the MELSEC-ST system.

) BASIC OPERATION

(1) Click the [Diagnostics] - [PROFIBUS-DP Network Parameter Monitor] menu to display
the "PROFIBUS-DP Network Parameter Monitor" screen and start monitor.

(2) To save the monitored data into a text file, click the button to stop monitor, and

click the LCopy to File | 5 yton

Refer to 'Saving the PROFIBUS-DP network parameter data'luss] for details.
(3) To close this screen, click the \% button.
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DISPLAY/SETTING SCREEN

Manitar
Start / stop L e i
monitoring - :

PROFIBUS-DP Network Parameter Monitor
Savedatatos %
fle o

| Stop | Copyto FiI | Cloze |

ol1lzlalalslelzlals]alelc]lole]s

00 |00 00 (00 |12 00 |00 00 00 00 00 00
00 |00 00 (00 00 00 |00 00 00 00 00 00
00 |00 00 (00 00 00 |00 00 |00 00 00 00
00 |00 00 (00 00 00 |00 00 00 00 00 00
00 Q0 |00 Q0 00 00 00 00 00 00 00 00
00 |00 00 (00 00 00 |00 00 |00 00 00 00
00 |00 00 (00 00 00 |00 00 00 00 00 00
00 Q0 |00 Q0 00 00 00 00 00 00 00 00
Q0 |00 00 (00 00 00 |00 00 00 00 00 00
00 |00 00 (00 00 00 |00 00 00 00 00 00
00 00 00 G0 00 00 00 00 00 00 00 00
00 |00 00 (00 00 00 |00 00 00 00 00 00
00 00 00 00 00 00 00 00 00 00 00 00

Metwork
parameter data 4

E DISPLAY/SETTING DATA

Item

Description

Monitor

Starts/stops monitor.

button

Starts monitor.
This button is usable only while monitor is at a stop.

\While monitor is executed, " * " flickers on the left side of this button.

Monitor Switch ‘

Monitaring
indicator

Stop
rmonitoring |

Start ’
monitonng 4

Laan

[Stop] putton

Stops monitor.
This button is usable only while monitor is executed.

Copy to Filg | p tton

Saves the monitored data into a text file.
JRefer to 'Saving the PROFIBUS-DP network parameter data’'[1s6) for details.
\While monitor is executed, this button is not usable.

Save the data after clicking the button to stop monitor.

Close | yytton

ICIoses this screen.

Data display 1

Displays the slice module parameters and PROFIBUS-DP parameters sent
from the master station of PROFIBUS-DP to the MELSEC-ST system.
"Address" is the offset address of the monitored parameter, with Address 0
set as the start address.

*1: For details of the data, refer to the manual of the used master station or configuration software.
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11.6.2 Saving the PROFIBUS-DP network parameter data

ﬂb PURPOSE

Saves the data, which were monitored on the "PROFIBUS-DP Network Parameter Monitor"
screen in 'PROFIBUS-DP network parameter monitor'[ into a text file.

BASIC OPERATION

(1) On the "PROFIBUS-DP Network Parameter Monitor" screen, click the button to
stop monitor, and then click the LCOPY to File | pytt0n,

(2) Set the destination directory and file name, and click the button to save the
monitored data into a text file and close this screen.

DISPLAY/SETTING SCREEN

Copy !uﬁh—l?ﬂ
Swowin | 3 SUCE B I s -
bt

= Masker

Florane: | o= |
e N " |

E DISPLAY/SETTING DATA

Iltem Description
Save in Select the directory that stores the monitored data.
File name Set the file name of the monitored data.

Save | pytton Saves the project with the file name specified at "File name".

Cancel | ptton

ICIoses this screen without saving the project.
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(1) Example of text file for saving data
The following shows an example of the text file for saving data.

B ProfibusDPnetParamMonitor. txt - Notepad |g@|@
File Edit Format View Help

= Configurator-sT PROFIBUS-DFP Wetwork Parameter Monitor
0000 @ 00 00 00 00 00 Q0 Q00 00 12 00 00 00 00 00 00 O
000l : 00 00 Q00 00 Q00 00 Q0 00 Q0 00 Q0 00 00 00 00 QO
0002 ¢ 00 00 00 00 00 Q0 Q0 Q0 00 00 00 Q0 00 00 00 00
Q003 : 00 00 Q00 00 Q0 00 Q0 00 Q0 00 Q0 00 00 00 00 Q0
0oo4 ¢ Q0 00 00 00 00 Q00 Q0 Q0 Q0 00 00 Q0 Q0 00 00 00
0005 @ 00 00 Q00 00 Q0 00 00 00 Q0 00 Q0 00 00 00 00 QO
0006 @ 00 00 00 00 00 Q00 Q0 00 00 00 00 00 00 00 00 00
Q007 @ 00 00 Q00 00 Q0 00 Q0 00 Q0 00 Q0 00 00 00 00 QO
0oos @ 00 00 00 00 00 Q0 Q0 Q0 Q0 00 00 Q0 Q0 00 00 O
000S% @ Q00 00 Q00 00 Q0 00 00 00 Q0 00 Q0 00 00 00 00 QO
000a 1 00 00 00 00 00 Q0 Q0 Q0 Q0 00 00 Q0 00 00 00 00
QO0B : 00 00 Q00 00 Q0 00 Q0 00 Q0 00 Q0 00 00 00 00 Q0
0oQc @ Q0 00 00 00 00 Q00 Q0 Q0 00 00 00 Q0 00 00 00 00
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12  Online module operation

This chapter explains the functions for operating each module from GX Configurator-ST in the online
mode (where the MELSEC-ST system and personal computer are connected).

12.1 Reset head module

ﬂb PURPOSE

Resets the head module from GX Configurator-ST.

BASIC OPERATION

(1) Click the [Online] - [Reset Head Module] menu.

(2) When there is a window being monitored, a screen appears asking whether monitor will
be stopped or not.

Click the button to stop monitor.

(3) A screen appears asking whether the head module will be reset or not.
Click the button to reset the head module, and check the LED status (on/off) to
see if the head module has been reset.

While the head module is reset, all LEDs are off. When reset is completed, the LEDs
turn on again.

Confirm that all LEDs turn on after they have turned off once.

(4) A screen appears asking whether a reset request has been issued to the head module
or not.

Click the button.

(5) When monitor is stopped in Step (2), a message appears asking whether monitor will be
resumed or not.

Click the button to resume monitor.
Click the button to keep monitor stopped.
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12.2 Online module change

12.2.1

139

(1) Online module change function

The 1/0 modules (except ST1X1616-DE1-S1) and intelligent function modules can be replaced
without stopping the MELSEC-ST system.

An online module change can be executed by operation of the head module buttons or from
GX Configurator-ST.

This section explains how to perform an online module change from GX Configurator-ST.

Precautions for online module change

The precautions for the online module change are given below.

1)

(2)

(3)

(4)

(5)

(6)

(7)

(8)

(9)

To perform the online module change, the system configuration must be appropriate for execution
of the online module change.

For details, refer to the MELSEC-ST System User's Manual, "3.4 Precautions for System
Configuration"”.

Executing the online module change in an inappropriate system configuration may result in
malfunction or failure.

In such a system configuration, shut off all phases of the external power supply for the
MELSEC-ST system to replace a slice module.

Be sure to perform an online module change in the procedure given in 'Procedures for online
module change’ .
Failure to do so can cause a malfunction or failure.

Before starting an online module change, confirm that the external device connected with the slice
module to be removed will not malfunction.

It is recommended to set 0 (OFF) to Bit output and Word output of the slice
module to be replaced in advance.

Only the slice modules of the same model name can be replaced online.
It is not possible to replace with/add the slice module of different model name.

Only one slice module can be replaced in a single online module change.
To replace multiple slice modules, perform an online module change for each module.

This function is available for I/O module (except ST1X1616-DE1-S1) and intelligent function
module; not available for power distribution module and base module.

Shut off all phases of the external power supply before installing or removing the power
distribution module and/or the base module.

Failure to do so may result in damage to all devices of the MELSEC-ST system.

While an online module change is in execution (while the head module's REL. LED is on), no
command can be executed to the slice module being replaced online.
If a command is executed to such a slice module, an error will occur.

To change parameters of a slice module that is in execution of online module change (while the
head module’s REL. LED is on), wait until the online module change is completed.

If any parameter setting is changed during online module change, upon completion of the online
module change, the modified setting is overwritten with the parameters saved into the head
module and does not take effect.

During an online module change, the ERR. LED of the head module turns on only when an error
related to the online module change occurs.
It will not turn on or flicker when any other error occurs.
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(10) While an online module change is being executed (while the REL. LED of the head module is
on), the following data of the slice module being replaced online all turn to 0 (OFF).

o Bit Input
o Error Information (PROFIBUS-DP only)
o @ Module Status (PROFIBUS-DP only)
o Word Input

(11) When the communication with the master station is disconnected, replacing the output module
online, whose CLEAR/HOLD setting is set to HOLD, turns the Bit Output value to 0 (OFF).
After the online module change is finished, the Bit Output value will not return to the held
value.

(12) When the forced output test is executed on the slice module being replaced online, only Ew.n
Error Clear can be tested ( Error Clear bits are available for PROFIBUS-DP only).

Bit Output and Word Output cannot be tested.
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12.2.2 Procedures for online module change

This section explains the procedures for the online module change.
Replace a module online as shown below.

y

Is the online module change No
executable in the system
configuration? *1
Has the preparation been No
done for the online module
change?*2
Is disconnection from the No
external device possible?™3
Yes Online module change is not executable. Shut off
all phases of the external power supply for the
MELSEC-ST system and replace the slice module.

Execution of online module change

|Preparati|:|n for the slice module replacement | ... Refer to 'Online module change from
; GX Configurator-ST', 1) to 3)hz\

|Discunnecﬁun from the external device | ... Refer to the corresponding SLICE module manual.
*3
|Slice module replacement | ... Refer to 'Online module change from

GX Configurator-ST', 5) and 6). /4!

v

|C|:|nnec:1i|:|n to the external device after replacement | ... Refer to the corresponding SLICE module manual.
*3
|0perati|:|ns after connecting the external device | ... Refer to 'Online module Change from

GX Configurator-ST', 8) to 10) /1451,

*1: Refer to the MELSEC-ST System User's Manual, "3.4 Precautions for System Configuration".
*2: Refer to "Preparations for online module change" in the corresponding slice module manual.
*3: Refer to "External device connection and disconnection procedures for online module change".
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12.2.3 Online module change from GX Configurator-ST

Here is an explanation of how to replace a module online from GX Configurator-ST.

If a slice module different from the target one is selected by mistake, restart the operation as
instructed below.

(1) To restart the operation at step 3)
Click the ‘Cancel button on the screen to terminate online module change.

(2) To restart the oieration at step 4)
Click the Next button without executing online module change, continue to step 10) and
then terminate online module change.

(3) To restart the operation at step 8)

Mount the removed slice module again, click the Next button, continue to step 10) and
then terminate online module change.

Preparation for replacing slice module |

‘""“‘" ——— 1) Select the slice module to be replaced online on the
el : s "System Monitor" screen.
Baw Hosds  STIB-“HRZ 1o

Select a slice LS

Forvinsicsion Siaks Wi Hotte Siair

Wit Saich

Fuakad tp Tl Mode
or o] wr

Irputiuine | Foszed Dt
Mok, Te

Dt | bl Dt
Goirg .| Irfematzn

Deia Mok | Futbsnelel
Chargn Seting.

2) Click the [ Online Module Change | hytton on the "System

[t Clatput Forced Output

by Tost Monitor"screen.
Then, confirm that the RUN LED of the selected slice
Offset/Gain | Module Detail module is flashing at 0.25s intervals.
Setting. .. Infarmation. ..
Onling Maodule F'arameler REMARKS
ooyl S In addition to above, the following operations are also

| available.
¢ Select [Diagnostics] = [Online Module Change].

- » Right-click the slice module selected at step 1), and
click [Online Module Change| on the menu.

Cloze

'

(To the next page)
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(From the previous page)

3) Confirm that the slice module displayed as

Target Module

Mo. 4

Slice Mo i

Module Name @ ST1DA1-
Label Mame -

Base Module : ST1B-*4IR2

Start Online Module Change.
1.Please confirm the module. 2

2 Please click "Mext" button,

Details of module
selected for i
replacement o

=

Cancal ]

'

(To the next page)

"Target Module" is the slice module to be
replaced and click the button.

(a) Clicking the button validates the

settings and the following will be performed.

¢ Puts the head module into the online
module change mode.

e Saves the parameters of the target slice
module into the head module.

(b) After clicking the button, confirm the

following module statuses.

e The REL. LED of the head module is on.

e The RUN LED of the target slice module is
off.

e The "Module Status" indicator of the target
module has turned purple (). This
applies only when monitoring from the
"System Monitor" screen.

(c) If the parameters cannot be read from the

slice module, the REL. LED and ERR. LEDs
of the head module will turn on, and an error
message will appear on the screen at step 8).
In this case, confirm the error details and take
corrective action.

For how to read error codes and error code
details, refer to the Head Module Manual.

When not executing online module change, click

the button.
(a) Clicking the button causes the

screen to show that online module change is
cancelled.

Clicking the button returns to the step 1).
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(From the previous page)

| Disconnection from external device

4) When the left screen appears, disconnect the

Larse' Modie \ external device from the slice module to be
Eioie replaced online.
Brindil i For details, refer to "External device connection
Base Mockie + 5718412 and disconnection procedures for online module
bt Ot Carce change" in the corresponding slice module
ZFlease ok Hent- putort manual.
— int
Mext » | Cancel ‘

If the disconnection procedure given in the
relevant slice module manual cannot be
executed, shut off all phases of the
external power supply for the MELSEC-ST
system to replace the slice module.

| Replacing slice module

5) Remove the slice module to be replaced from the
base module.

6) Mount a new slice module with the same model name
as the one of the removed.

(To the next page)
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(From the previous page)

| Connection to external device after replacement

7) After mounting a new slice module, connect it to the
external device.
For details, refer to "External device connection and
disconnection procedures for online module change".

[Ej!ﬂ\

onon®0 1‘
ononond

| Operations after external device connection |

8) After connecting the external device, click the
button on the screen in step 4).

(a) Clicking the button performs the following.

¢ Checks whether the module name of the newly
mounted slice module is the same as that of the
removed one.

» Writes the parameters saved into the head
module (at step 3)) to the newly mounted slice
module.

(b) After clicking the button, confirm the
following module statuses.
e The REL. LED of the head module is flashing.
e The RUN LED of the newly mounted slice
module is flashing (at 0.25s intervals).

Clicking the button, i.e., interrupting online

module change returns to step 1). In this case, select
the same slice module as selected before, and
complete online module change. Note that selecting
different one causes an error.

If the parameters could not be read from the

Lawwodu*e_ : removed slice module in step 3), the REL. and
Sheln s ERR. LEDs of the head module will turn on and the
itk e left screen will appear in GX Configurator-ST.

Base Module + 5T18-41R2 In this case, confirm the error details and take

corrective action.
For how to read error codes and error code details,
refer to the Head Module Manual.

Failed to wiite the paraneter
Pleaze click "Next" button to opsiate with default parameters,

I case of changing the parameter settings, please close with “Cancel button, write parameters

with "Parameter Selling” and after that sxecute "Onine Madule Change™ again, When Step 10) has Comp|eted in th|S Status' the
intelligent function module starts its operation with
sl Ei| the command parameters set as default.

'

(To the next page)
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(From the previous page)

Qnline Module Change
Target Module
No. 4
Slice No. i
todule Name ;. ST1DAT-
Lahel Narme
Base Module. @ ST1E-"4IR2

Pleasze click "Mest" button to start the changed module operations.

Online Module Change can be cancelled by "Cancel” button.

Mest > Cancel

MELSOFT

&) 9) Clicking the button releases the head

following.

module change mode.

y

Online Module Change |z,
Target Module
No, t 4
Slice No 7
Module Name : STIDAT
Label Name
Base Module : STIB4IR2
Onfine Moduls Changs is completed
Finish
(Completion)

module from the online module change mode.
(a) Clicking the button performs the

¢ Releases the head module from the online

¢ Restarts refreshing the 1/O data, etc.

(b) After clicking the button, confirm the
following module statuses.

e The REL. LED of the head module is off.
e The RUN LED of the newly mounted slice

module is on.

e The "Module Status" indicator of the target
slice module has turned white (). This
applies only when monitoring from the

"System Monitor" screen.

(c) If the head module cannot be released from the
online module change mode, both REL. LED
and ERR. LED of the head module turn on.

In this case, confirm the error details and take

corrective action.

For how to read error codes and error code
details, refer to the Head Module Manual.

When interrupting online module exchange, click

the button.

(a) Clicking the button, i.e., interrupting

online module change returns to step 1). In this
case, select the same slice module as selected
before, and complete online module change.
Note that selecting different one causes an

error.

10) The left screen appears showing that online module

change has been completed.

Click the button.
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13.1

147

Reference

Key operations list

File
Operation Contents|Key operation
New|ss] Ctrl + N
Open|ss| Ctrl+ 0O
Savess] Ctrl+S
Print/e7] Ctrl+P

Edit
Operation Contents|Key operation
Undols7] Ctrl +Z
Redolss| Ctrl+Y
Add 7] Ctrl + Insert
Delete|e! Ctrl + Delete
All Delete|ss| Shift + Del
Parameter Settingles! |F9
Option|ss] F10

Mode
Operation Contents|Key operation
Edit|2s] F2
Diagnosis |zl F3

MELSOFT

Some of the commonly-used menu items are also available on shortcut keys, listed below.
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13.2 Error messages

This section will list the error messages that can be shown by the program, with advice on
how to prevent or fix the errors.

13.2.1 Communication errors

These errors are shown when GX Configurator-ST has problems communicating with the
SLICE hardware.

Message

Cannot communicate with Head module for one of the following reasons:

¢ Communications timeout.

The preparation of communication environment is bad.

Cable error.

Cannot communicate with the transmission speed set up now.

To fix this, try:

¢ Checking the cable and selected port number
e Setting transmission speed to a lower value.
¢ Closing other communication software applications and trying again.

Description

This message occurs when it is not possible to make a connection to the
SLICE hardware.

Causes and
actions

This message will be shown if the connection to the SLICE hardware
cannot be opened. This could be due to a hardware or software problem:

e Hardware issues may include power failure to the SLICE hardware, the
cable becoming disconnected, the wrong type of cable being used, or the
cable being plugged into the wrong device.

o Software issues may include another program using the communication
port where the cable is connected.

Message

Cannot communicate with PLC.

Description

There was a problem communicating with the SLICE hardware.

Causes and
actions

¢ This message may be shown if the SLICE hardware does not respond
within a reasonable time. Check that the SLICE hardware is powered on
and that the correct cable is connected to the correct port on the intended
device.

148
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Message Cannot communicate with Head module for one of the following reasons:

e Bad connection to the head module.

e The preparation of communication environment is bad.

To fix this, try:

o Checking the connection to the head module

¢ Closing other communication software applications and trying again.

Description There was an error when sending / receiving data to or from the SLICE
hardware.

Causes and |This message will be shown if the connection to the SLICE hardware

actions cannot be opened. This could be due to a hardware or software problem:

e Hardware issues may include power failure to the SLICE hardware, the
cable becoming disconnected, the wrong type of cable being used, or the
cable being plugged into the wrong device.

o Software issues may include another program using the communication
port where the cable is connected.

Message Set data exceeds the range. Execute again after confirming set data. The
range that can be setis 1 - 9.

Description This message is shown on the 'Transfer setup’ dialog, when a timeout value
outside the range 1-9 is set.

Causes and |e Change the timeout value to a number from 1 to 9, and try again.

actions

Message Cannot process because of monitoring. Please stop all monitoring and
execute again.

Description Some online operations are not possible while monitoring is in progress.
This message is shown if one of these operations is initiated while
monitoring is in progress.

Causes and e Stop monitoring for the duration of the operation, and restart it afterwards.

actions
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13.2.2 Diagnostic errors

150

The errors in this section can occur when the system is in diagnosis mode.

Message This feature cannot be executed during monitoring. Please execute again
after stop monitoring.

Description This message is shown when the 'Copy to file' button is selected on the
PROFIBUS-DP Network parameter monitor s or Master station data
communications dialogl|, but monitoring is still active.

Cayses and e Stop monitoring before saving the data to a file. Monitoring can be

actions restarted after the file has been saved.

Message The module for the setting has not been selected. Please select the module
that is to be set in the System Monitor.

Description This error is shown on the system monitorlus| screen, when an action is
selected (such as module detail informationlws) without any module selected
for it to work on.

Causes and |e Select the module to use for the action, then try again.

actions

Message There is no monitor data to write to the file.

Description This error occurs when the 'Copy to file' button is selected on the
PROFIBUS-DP Network parameter monitorlsl or Master station data
communicationsll dialog, but there is no data available to save to the file.

Causes and [e Try again when there is some data available to write.

actions

Message Cannot monitor the Input/Output Data of the specified module.

Description I/O monitoring was selected for a module, but the module does not support
it.

Cayses and [e The selected module may not have any I/O to monitor. Check that the

actions correct module has been selected, then try again.

Message The module for the setting has not been selected. Please select the module
that is to be set in the System Monitor.

Description An attempt was made to start /O monitoring without first selecting a
module.

Cayses and |e Make sure that the correct module is selected by clicking on it in the

actions system monitor display, then try again.
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Message

The head module does not match, but the other modules are correct. Copy
the head module details from the live system and continue?

Description

When attempting to switch to diagnostics mode, it was discovered that the
head module type of the live system does not match the head module type
in the configuration, although the remaining modules do match. This could
happen if (for example) the head module in an existing SLICE system was
replaced with a different type of head module.

Causes and
actions

You can either:

e Answer 'Yes' at the prompt, in which case the system will copy the head
module details from the live system and continue - if you have replaced
the head module but wish to reuse the module parameters in an old
configuration file, this is the correct option.

o Answer 'No' at the prompt, if (for example) a connection has been made
to the wrong SLICE hardware. The 'wrong system configuration' error will
be shown (as below).

Message

The module configuration differs from the mounting state. Please check the
module configuration and execute again. Module No. ....

Description

This message is shown when switching to diagnostics mode, if the
configuration of the attached SLICE hardware does not match the
configuration being edited. The message shows the first module number
which is different.

Causes and
actions

o Check that the communication cable is connected to the right serial port
and the right SLICE hardware - there may be a connection to a different
system. 'Transfer setup'lesl can be used to change the serial port used.

o Make sure that the configuration file is up to date, in case new modules
have been added since the last time it was saved.

¢ If you do not need to keep any parameters in the local file, use 'Get
sxstem'@ to read the details of the connected system from the port.

Message

This will start monitoring of the Input/Output Monitor?

Description

When you switch from edit mode to diagnostics mode, and there are I/O
monitor windows open from a previous diagnostics mode session, you will
be prompted to restart monitoring.

Causes and
actions

Either answer:
¢ 'Yes' - to restart monitoring in these windows, or

¢ 'No' - in which case monitoring will not be switched on in the open I/O
monitor windows.
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Message This will stop monitoring of the Input/Output Monitor.

Description This is a warning shown when switching from diagnostics mode to edit
mode while there is an I/O monitor active.

Cagses and |e There is no action to take - when you click 'OK’, the active 1/0O monitors

actions will stop monitoring.

Message Module Detail Information cannot be executed in the specified module.

Description This error can appear on the system monitor dialog when an attempt is
made to start the 'module detail information' dialog for a module whose
details cannot be shown.

Cagses and |e Make sure that the right module is selected, by clicking on it in the system

actions monitor dialog, then try again.

13.2.3 File errors

152

These errors may occur when there are problems opening or reading from a file.

Message The file cannot be opened because the selected file is damaged.

Description An attempt was made to open a file which appears to be corrupted.

Causes and |e There may be a problem reading the file from a network drive, or the file

actions may have become corrupted.
¢ If you have a recent backup of the file, check if the backup is readable.

Message This file has been created in latest version of application. Cannot process it
in this application.

Description This message may be shown if you have created a file in a newer version of
GX Configurator-ST than this one (1.06G), and attempted to load it into this
version.

Causes and |e Open the file with the version of GX Configurator-ST in which it was

actions created.

Message The file cannot be opened because the selected file is damaged.

Description The file was found and opened, but discovered to be corrupt.

Cagses and |e It will not be possible to read the file - load a backup copy if you have one,

actions or if you have access to the SLICE hardware, use the 'Get sxstem‘@

feature to read the configuration from the hardware.
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Message The following error occurred during processing of the file. ...

Description While processing the file, the operating system reported an error. The error
description returned by the operating system is shown at the end of the
message.

Cayses and |e The message should show what the problem was, and from this it should

actions be possible to work out the correct action to take.

Message Cannot use the specified file because it is being write protected. Please
check the attribute and try again.

Description Permission was denied to use the file.

Causes and |e Make sure that the file has not been opened elsewhere

actions o . , . ,
¢ Check that the file is not write protected - files can sometimes be left write

protected when (for example) they are copied from a backup CD.

Message Cannot find the file.

Description The file to be opened was not found.

Ca_uses and |e Make sure that the file exists, and is not (for example) on an inaccessible

actions network drive.

Message Cannot use the specified file because it is being used by some other
application.

Description Another application has the file open, so GX Configurator-ST cannot use it.

Cayses and e Look for other files that may be using the file, then switch to the other

actions application and close the file.

o If the file still appears to be locked and there is no application apparently
using it, rebooting the PC may fix the problem.

Message The allowable No. of characters has been exceeded. Set to less than 150
characters.

Description A file name was selected which is too long to use.

Causes and |e Enter a shorter file name, then try again.

actions
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13.2.4 Forced output / offset and gain errors

154

These errors can occur when using the forced output / offset and gain settings dialogs. For
more information, see 'Forced output test'71 and 'Offset/Gain setting of intelligent function

module'fis!,

Message The module for the setting has not been selected. Please select the module
that is to be set in the System Monitor.

Description An attempt was made to start the forced output test dialog without first
selecting a module whose outputs are to be written.

Cagses and |e Make sure that a module is selected by clicking on it in the system

actions monitor dialog, then try again.

Message The selected module cannot execute the Forced Output Test function.

Description An attempt was made to start the forced output test dialog for a module that
does not support forced output tests (e.g. because it has no suitable
outputs).

Cagses and |e Select a module which does support forced output tests, by clicking on it

actions in the system monitor dialog, then try again.

Message Cannot change into the Forced Output Test Mode because the
communication error has occurred. Please execute again.

If selecting the "Cancel” button, please reset the head module because the
last value may be outputted when you next execute the Forced Output Test
function.

Description This message is shown when trying to switch on the ‘forced output test'
mode, if there is a communication error before the operation can be
completed. Pressing 'OK" will retry the connection, or pressing ‘Cancel’ will
abandon the attempt.

Cayses and |e Check the connections and try again. As the message suggests, if you

actions select 'Cancel' it is advisable to reset the head module to make sure that

there are no 'left over' output values the next time you switch to forced
output test mode.

Message Head module is in the status of the Forced Output Test Mode. Do you want
to release the Forced Output Test Mode?

Description This message is shown when the operating mode is about to be switched
from 'diagnostics mode' to 'edit mode’', while the ‘forced output test' mode is
active.

Cagses and |e This is a warning message - if you wish to continue using forced output

actions mode, cancel the change.
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Message This will release the Forced Output Test Mode. Is it OK?

Description This prompt is shown when closing a forced output test dialog window while
the test is active.

Causes and |Either answer:

actions , , . .

e 'Yes' - to switch off forced output test mode before returning, or
¢ 'NO' - to leave the forced output test mode active

Message Mode setting is in the Forced Output Test Mode. Do you want to close in
the Forced Output Test Mode?

Description This message is shown when the project file is about to be closed, but the
‘forced output test' mode is active.

Cagses and |e This is just a warning message - if you wish to continue using forced

actions output mode, use the 'cancel’ option.

Message It is possible to set Offset/Gain only during the Forced Output Test Mode.
Change into the Forced Output Test Mode?

Description This message is shown when trying to set the offset and gain settings for a
module, when the system is not in forced output test mode.

Cagses and |e Offset/gain settings can only be set in forced output mode. Answer 'Yes'

actions at the prompt to switch to forced output test mode, or 'No' to cancel the

operation.

Message The selected module cannot set Offset/Gain.

Description An attempt was made to change the offset/gain settings of a module which
does not have offset/gain settings to change (such as the head module or a
power supply module).

Cayses and [e Itis likely that the wrong module is selected - make sure that the correct

actions module (one which has offset/gain settings) is selected, and then try

again.

Message The module to be set has not been selected. Please select a module to be
set in the System Monitor.

Description This message is shown when attempting to show the offset/gain settings
dialog without first selecting a module for which the offset/gain settings
should be changed.

Cayses and |e Make sure that a module has been selected by clicking on it in the

actions 'system monitor' dialog, then try again.
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Message The Window is closed during Offset/Gain Setting Mode. Please open the
Offset/Gain Setting and close again.

Description The offset/gain dialog window was closed unexpectedly while setting offset/
gain settings.

Causes and |e Open the offset/gain settings window and try the operation again.

actions

Message Channel has not been selected. Please select a channel.

Description This error is shown on the offset/gain settings dialog, when trying to write
the settings without first selecting one or more channels.

Causes and [e Select the channel(s) to which the new setting values should be applied,

actions

Message Please set the Offset/Gain Value.

Description On the offset/gain settings dialog, the 'Set' button was used without
entering a valid value.

Cayses and [e Make sure that a valid number has been entered for the new offset/gain

actions value, then try again.

Message Value input is out of range.

Description The value entered for the offset or gain setting is out of range, i.e. it is
below the lower limit for values, or above the upper limit for values.

Causes and |e Enter a value which is within the limits, then try again.

actions

Message Please select an Output Data.

Description On the forced output test dialog, the 'settings' button was clicked without
first selecting one or more outputs.

Causes and |e Make sure that at least one output is selected (checked) and try again.

actions
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Message The value besides the range is set as the setting value.

Description This error is shown on the forced output dialog, if the output value selected
is not permitted. The value may be lower than the minimum permitted,
higher than the maximum permitted, or too large for the data type (e.g.
when trying to store a 32-bit value in a 16-bit setting).

Causes and |e Enter a value within the permitted ranges, then try again.

actions

13.2.5 Module addition and copying errors

These errors may be shown when new modules are being added to the system, or copied
from another file.

Message Cannot add the module. Modules can be added to the maximum of ....
Description No more modules can be added to the system - the limit on the number of
modules in a SLICE system has been reached.
Cagses and |e You may be able to reduce the number of modules needed by using
actions different types of modules.
o If there is no way to reduce the number of modules needed, the only
solution is to install an additional SLICE system in a new rack with a
separate head module.
Message Cannot add the module. Bit Input/Output range exceeds ... points.
Description It is not possible to add the module, because the total number of bit I/O
points in the system would exceed the limit.
Causesand |e In a PROFIBUS-DP system, the point mode is selectable, so you may be
actions able to change to a higher point mode and continue.
e If there is no way to reduce the number of bit input/output points used, the
only solution is to install an additional SLICE system in a new rack with a
separate head module.
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Message Cannot add the module. Word Input/Output range exceeds ... points.
Description It is not possible to add the module, because the total number of word 1/O
points in the system would exceed the limit.
Cagses and |e In a PROFIBUS-DP system, you may sometimes be able to switch to a
actions lower point mode to increase the number of word 1/O items that can be
used.
¢ If there is no way to reduce the number of word input/output items used,
the only solution is to install an additional SLICE system in a new rack
with a separate head module.
Message Cannot add the module. Intelligent modules can be added to the maximum
of ...
Description It is not possible to add the module, because the maximum number of
intelligent modules has already been reached.
Cayses and e In a PROFIBUS-DP system, the number of intelligent modules permitted
actions is affected by the point mode selected. You may be able to change the
point mode to allow more intelligent modules to be used.
e You may be able to install different types of intelligent modules in the
system to get the same results with a lower number of modules.
¢ You may be able to install one or more non-intelligent modules in the
system to get the same results.
o If more intelligent modules are still needed, the only solution is to install
an additional SLICE system in a new rack with a separate head module.
Message The module could not be recognized. Module:... No...
Description GX Configurator-ST does not recognise the module.
Cayses and e This message should not normally be shown. Uninstalling and reinstalling
actions the application may solve the problem.
Message The module isn't selected. Please select the module.
Description In the 'Add module' dialog, ‘add' was pressed before a module was
selected.
Causes and |e Select a module from the drop-down list, then try again.
actions
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Message It cannot add the module in the specified position.

Description In the 'Add module' or 'Copy module' dialog, an attempt was made to add a
module at an invalid slot number.

Cagses and |e Correct the slot number and try the action again. The slot number should

actions not be before or at the head module slot, or beyond the end of the rack.

Message A missing number will be made. Is it OK to change the No. to ...?

Description In the ‘add module’ or 'copy modules' dialog, an attempt was made to add a
module after the end of the rack. For example, if the last module in the rack
is in slot 8, an attempt to add a new module in slot 10 would cause this
error.

Causes and |e Either select 'Yes' to accept the suggested alternative (normally the slot

actions number just after the right hand end of the rack), or 'No' to cancel the

addition and re-enter the slot number manually.

Message Warning - after adding this module, the supply current is not sufficient.
Supply current : ... mA, Consumption : ... mA. Select 'OK' to add the module
anyway.

Description This message is shown after adding a module in the wizard area, if there
was previously sufficient power supply to the modules in the configuration,
but adding the new module would cause more current to be drawn than is
being supplied.

Causesand [e Select 'OK' to add the module anyway and fix the power supply issue

actions later, or
e Select 'Cancel' to prevent the addition, so that another power supply

module (e.g. ST1PSD) can be added in the correct place.

Message There is no file path settings. Please check it again.

Description This occurs when trying to use the '‘Add' button on the 'Copy' dialog without
having selected a valid path for the source file.

Cayses and e Select the source file to copy from using the 'Browse' button. There are

actions further instructions available in 'Copying the module information'[ss).
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Message Cannot add the head module. Please select the other module.

Description This error is shown when adding to use the 'Copy' dialog to copy the head
module.

Cagses and |e The wrong module may have been accidentally selected, in which case

actions select the correct module to copy.

o The head module cannot be directly copied - however you can obtain the
same result by entering items such as the label name and parameters
manually.

13.2.6 Module configuration errors

If a problem is detected with the module configuration, the affected module will be
highlighted in red in the module list. When the context menu is shown (e.g. by clicking on
the module with the right mouse button), the descriptions of the module errors will appear at
the top of the context menu.

The possible errors are:

Message Slot 1 should always contain a "..." module
Description In a valid configuration, the first slot after the head module should always
contain a power supply module of the type shown in the message. This
provides power to the head module itself, as well as to the remaining
modules.
Cagses and |e The power supply module is either missing, or in the wrong place. Either
actions move an existing power supply module to the slot immediately after the
head module, or install a new power supply module after the head
module.
Message The power supply module in slot 1 should have an 'H-SET' base type
Description The first power supply module has the wrong base type selected - for the
first power supply after the head module, the base type should always be
'H-SET'. The remaining power supply modules have 'R-SET' base types.
Cagses and |e Ensure that a power supply with 'H-SET' base type is installed
actions immediately after the head module. You can change the base module
type by right clicking on the slot and selecting 'Option' from the pop-up
menu. For more information see 'Option setting'lesl.
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Message The power supply module in this slot should have an 'R-SET' base type
Description The power supply module in this slot has the wrong base type selected - for
power supply modules other than the first power supply after the head
module, the base type should always be 'R-SET".
Causes and e Ensure that a power supply with 'R-SET' base type is used in this slot.
actions You can change the base module type by right clicking on the slot and
selecting 'Option’ from the pop-up menu. For more information see
'Option setting'[es].
Message Power consumption exceeds supply from power supply module in slot "..."
Description With the current configuration, there is not enough power being supplied to
the module. The message shows the number of the slot containing the
power supply which feeds this module.
Causes and [e There may not be enough power supply modules in the system. To fix
actions this, you will need to install an additional power supply just before the first
module that reports this error.
e Depending on your configuration, you may be able to rearrange the other
modules to make better use of the existing power supplies.
Message ST1X1616-DE1-S1-L module required after this module
Description The ST1X1616-DE-S1 module is presented in the software as two
modules, ST1X1616-DE1-S1-F and ST1X1616-DE1-S1-L. These modules
are one physical unit and so they must always appear as a pair with the
ST1X1616-DE1-S1-F module followed by the ST1X1616-DE1-S1-L module.
This message appears when there is a ST1X1616-DE1-S1-F module which
is not followed by a ST1X1616-DE1-S1-L module.
Cagses and |e Either add an ST1X1616-DE1-S1-L module if it is missing, or rearrange
actions the existing modules so that the two modules are adjacent with the

ST1X1616-DE1-S1-F module followed by the ST1X1616-DE1-S1-L
module.
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Message

ST1X1616-DE1-S1-F module required before this module

Description

The ST1X1616-DE-S1 module is presented in the software as two
modules, ST1X1616-DE1-S1-F and ST1X1616-DE1-S1-L. These modules
are one physical unit and so they must always appear as a pair with the
ST1X1616-DE1-S1-F module followed by the ST1X1616-DE1-S1-L module.
This message appears when there is a ST1X1616-DE1-S1-L module which
does not have a ST1X1616-DE1-S1-F module before it.

Causes and
actions

e Either add an ST1X1616-DE1-S1-F module if it is missing, or rearrange
the existing modules so that the two modules are adjacent with the
ST1X1616-DE1-S1-F module followed by the ST1X1616-DE1-S1-L
module.

13.2.7 Module deletion errors

These errors can occur when deleting modules. For more information, see 'Deleting a
module'[s2] or 'Deleting all modules'/ss).

Message Cannot delete head module.
Description An attempt was made to delete the head module.
Cagses and |e The head module cannot be deleted - all valid systems must have a head
actions module in the first slot. If you wish to start again and reconfigure the
system with a different head module, select 'File -> New'[ss|. Alternatively,
use the 'Edit' menu item 'Change head module'l to select another head
module type while leaving the remaining modules in place.
Message The module to be deleted has not been selected. Please select the module
to delete in the Module Information List.
Description The 'Delete module' action was selected, but there is no module selected
for deletion.
Causes and |e Select a module by clicking on it, then try again.
actions
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13.2.8 Module parameter errors

163

These errors can occur when setting or reading parameter values.

Message There are some errors. The following reasons may be responsible:
o The invalid setting value is selected.
e The value besides the range is set as the setting value.
Description When checking the parameter settings for errors on the parameter settings
screen, some of the parameters were not valid.
For more information about parameter settings, see '‘Checking the
parameters for errors'[ss).
Cayses and |e The most likely cause is that the parameter value is out of range. For
actions example, a number has been entered which is below the lower limit for
the parameter value or above the upper limit for the parameter value.
Message The parameter item for the corresponding Read/Write/Verify has not been
selected. Please select the parameter item.
Description In the parameter settings dialog, an action (such as upload / download /
verify) was selected without first selecting the parameters to work on.
Cagses and |e To prevent this happening, select one or more parameters from the list
actions before selecting an action. For more information, see 'Parameter setting'
[92] or 'Uploading/Downloading the parameters'|ss!.
Message The setting value that cannot be changed is read only. The setting value for
the read only cannot be downloaded.
Description In the parameter settings dialog, an attempt was made to download an item
which is read only.
Cayses and [e Read only items cannot be downloaded by GX Configurator-ST. If there
actions are other parameters to download which are not read only, deselect the

read only item and try again.

¢ In some cases, it may be possible to change the parameter by sending a
command from the master station.
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Message The module differs from the mounted module.

Description This error can occur when trying to download parameters to a module in a
given slot using the parameter settings dialog. The problem is that the
module in that slot in the connected SLICE system is not the same type as
the module in that slot in the configuration file. For more information, see
'Parameter setting'[e2).

Cayses and e This normally means that there is a mismatch between the configuration

actions file and the connected hardware. Check that the PC is connected to the

right hardware, i.e. that the cable is not in the wrong port on the computer
or connected to a different SLICE system.

e The configuration file may be out of date. If the connected system was
expected to match, it may be easier to use 'Get system' to read the
details from the connected hardware, and then try again.

Message Cannot set the parameter of the specified module.

Description An attempt was made to show the parameter settings of a module which
does not have parameters (such as a power supply module).

Causes and |e There are no parameters for the type of module selected.

actions _
¢ If you were expecting the module to have parameters, please check that

the right module is selected.

Message The module to be set has not been selected. Please select the module to
be set in the Module Information List or the System Monitor.

Description An attempt was made to show the parameter settings dialog without first
selecting the module to view.

Causes and |e Select a module, and then try again.

actions

Message Please select modules

Description When performing a parameter block write, no modules have been selected
for download.

Cagses and |e Select the modules whose parameters should be downloaded to the

actions SLICE system by clicking in the 'Select' column, then try again.
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Message Download canceled.

Description This message is shown when a parameter block write is canceled before
the parameters have been downloaded for all modules.

Cagses and |e To continue with the download, make sure that all the required modules

actions are selected (modules whose status is marked as ‘completed’ have

already been downloaded in full and can be deselected) and try again.

13.2.9 Module selection errors

165

These errors can occur when it is not possible to tell which module was selected.

Message The Module Information List is not displayed. Please activate the Module
Information List in the menu.

Description This error is shown in edit mode when an attempt is made to use a feature
that needs a selected module, but the module configuration window is not
shown, or no module is selected. The module configuration window must be
visible to allow modules to be selected.

Cagses and |e Use the 'View' menu 'Module configuration'/+:] item to show the window,

actions then click on a module in the module list or rack display to select it, and

try again.

Message The module to be set has not been selected. Please select the module to
be set in the Module Information List.

Description An attempt was made to show the module option dialog without first
selecting a module to work with.

Cayses and |e Make sure that a module has been selected in the module list or rack

actions display by clicking on it, then try again.
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13.2.10 Module verify (compare) errors

166

These errors can occur while verifying (comparing) modules against another configuration
file. For more information about this feature, see the 'Verifying the projects'/s] section.

Message The system configuration of the file opened for verification and the file
under editing is different. Cannot execute verification for all the selected
modules.

Description This error can be shown when the destination file is first opened in the
verify dialog, when the 'Verify all modules' tab is active. When 'Verify all
modules' is used, the source and target systems are expected to be very
similar, with the same number and type of modules, and this is not the case
for the selected file.

Cayses and |e If you do not intend to use the 'Verify all modules' feature, you can ignore

actions this message and activate the 'Verify selected modules' tab instead, as

this will still work even if the configurations are different.
¢ If you were expecting the two configurations to be comparable, check that
you have opened the correct file.

Message Is it OK to clear the selected module?

Description This message is shown when using the 'Verify selected modules' tab to set
up the list(s) of modules to compare. It appears when the source is
changed after some modules have been selected, and is a warning that all
the module selections will be reset if the source is changed.

Cagses and |e Either confirm the prompt, in which case the selections will be cleared

actions and you will have to enter them again, or
e Cancel, in which case the source will not be changed.

Message Module at the verification source has not been selected.

Description With the 'Verify selected modules' tab active, an attempt was made to start
the comparison before selecting a source module.

Cayses and |e One source module needs to be selected before starting the comparison.

actions This module will be compared against each of the destination modules in

turn.

Message Module at the verification destination has not been selected.

Description With the 'Verify selected modules' tab active, an attempt was made to start
the comparison before selecting any destination modules.

Cayses and |e One or more destination modules need to be selected before starting the

actions comparison. Each of these will be compared against the source module.
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Message The specified module does not exist.

Description In the verify results dialog, after trying to edit the parameter settings by
double clicking a module row or pressing the 'Parameter settings' button,
GX Configurator-ST could not find the module whose settings should be
edited.

Causes and |e¢ Make sure that a valid row is selected.

actions _
¢ Make sure that the module at the selected row has editable parameters.
e Try closing the results dialog and using the module list/ss! or rack display

471 to edit the parameters of the module instead.

13.2.11 Online change errors

These errors can occur during online module change. For more information about the online
change procedure, see the head module documentation and the sections 'Online module

change'lisl and 'Online module change from GX Configurator-ST'l:«l

Message The module for the setting has not been selected. Please select the module
that is to be set in the System Monitor.

Description The 'online change' feature was started without first selecting the module to
be changed.

Cayses and e Select a module to change by clicking on it in the system monitor dialog,

actions then try again.

Message The selected module cannot execute Online Module Change.

Description This message is shown when an attempt is made to use the online change
feature on a module which does not support online change. For example,
the head module and power supply modules cannot be exchanged while the
system is running.

Cagses and |e Select a module which supports online changes and try again. If you do

actions need to replace a module that does not support online change, the only

safe way is to power down the system and replace the module while the
whole system is switched off.

167

167



13 Reference

MELSOFT

Message Online Module Change was stopped. This module does not operate. Please
execute "Online Module Change" again.

Description This message is shown if the online change procedure is cancelled part
way through the exchange. It indicates that the selected module is not
operating as a result of stopping the exchange procedure.

Cagses and |e Go through the online change procedure again for the same module (it

actions does not actually have to be replaced). If you try to select a different

module, an error will be shown.

Message There is some other module that is performing Online Module Change.
Please execute Online Module Change for one module of at a time.

Description An attempt was made to start an online change operation, but there is
already a module part way through the online change process. This can
occur if a previous online change (either from GX Configurator-ST or using
the buttons on the front of the head module) has not fully completed or was
cancelled part way through.

Cagses and |e Select the module that is part way through online change (the module will

actions have a purple () status colour in the system monitor), and complete its

online change procedure first. Online change can only be used for one
module at a time.

13.2.12 Printing errors

The errors in this section can occur during printing. For more information, see 'Printing the

project data'le7.

Message Please close GX Configurator-ST after closing Print Preview.

Description If the print preview dialog is open, it must be closed before trying to close
GX Configurator-ST.

Causes and |e Close the print preview dialog, then select the 'File' menu 'Exit'[+] item to

actions quit.

Message Please select one or more modules.

Description This message is shown on the print dialog, if the print range is 'selected
modules' but no modules have been seleced.

Causes and |Either:

actions

o Select some modules by clicking on them in the list on the left, then using
the '->' button to add them to the list of modules to print, or

¢ Select the 'All modules' option for the print range instead, in which case
all the modules will be included in the printout.
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Message Please specify the print item.
Description The print dialog has three options for sections that can be included in the
printout:
¢ Module configuration
e Module information list
¢ Individual module information
This error message is shown when all three options have been deselected,
and there is nothing remaining to print.
Cagses and |e Select at least one section to be printed. If you do not want to print
actions anything, cancel the dialog.
Message Please set the Module Turning Position within the range of 1-99.
Description The module turning position gives the number of modules printed per row
on the module configuration page of the printout. It must be a number from
1-99.
Causes and |e Enter a number from 1-99 for this value, then try again.
actions
Message The initial page value is outside the range.\nThe initial page value should be
set within the range 1-32767.
Description This error is shown on the page setup dialog, if the first page number is not
within the range 1-32767.
Causes and e Enter an initial page number from 1-32767 and try again.
actions

13.2.13 System errors

These errors occur when there are other issues with the system, or problems with the

installation.

Message Insufficient memory. Please close other applications to increase memory.
Description There is not enough free memory available to complete the current activity.
Cagses and e If possible, try to close other applications which you are not using, to
actions release memory.

e You may also be able to increase the amount of memory available by
increasing the size of the page file, or by installing additional memory in
the computer.
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Message There is not enough memory, so the GX Configurator-ST cannot be
activated. Quit other applications, then activate the GX Configurator-ST.

Description There is not enough free memory available to start the application.

Cagses and e If possible, try to close other applications which you are not using, to

actions release memory.

e You may also be able to increase the amount of memory available by
increasing the size of the page file, or by installing additional memory in
the computer.

Message Some of the necessary files for running the application are not found.
Please reinstall.

Description This message normally means that GX Configurator-ST did not install
correctly, or some of the application files or registry settings have been
damaged.

Causes and [e A file is missing, or part of the application failed to load or initialise.

actions

¢ In general, uninstalling the program (from 'Control Panel -> Add or
remove programs') and then reinstalling should fix the problem.

Message Failed to read the registry data. There is some possibility for some error in
the operating environment of the application.

Please do reinstall. Administrator authorization is required in case of using

Windows NT® 4.0, Windows® 2000, Windows® XP and Windows Vista®.

Description The application was unable to read settings from the system registry.

Cagses and |e The currently logged-on user may not have Administrator rights. Log back

actions on as a user with Administrator access.

o The application may not be correctly installed, in which case it should be
uninstalled (from 'Control Panel -> Add or remove programs') and then
reinstalled.

Message Cannot execute online operations in this application. Online operation is
possible only in the application that started in the beginning.

Description The system cannot make connections to the device hardware, as the
connection is already in use.

Cagses and |e This message will be shown if GX Configurator-ST is run twice. Use the

actions instance that was started first for online operations.
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Message Failed to open the database. Please reinstall.

Description This message normally means that GX Configurator-ST did not install
correctly, or some of the application files or registry settings have been
damaged.

Causes and |e A file is missing, or part of the application failed to load or initialise.

actions

¢ In general, uninstalling the program (from 'Control Panel -> Add or
remove programs') and then reinstalling should fix the problem.

Message Cannot access the database, The database may be damaged or old.
Please update to the latest database.

Description This message normally means that GX Configurator-ST did not install
correctly, or some of the application files or registry settings have been
damaged.

Causes and |e A file is missing, or part of the application failed to load or initialise.

actions . . . . :

o If restarting the application or rebooting the PC does not help, uninstalling
the program (from 'Control Panel -> Add or remove programs’) and then
reinstalling it may fix the problem.

Message Failed to access some necessary information from database. The database
may be damaged or old. Please update to the latest database.

Description This message normally means that GX Configurator-ST did not install
correctly, or some of the application files or registry settings have been
damaged.

Causes and |e A file is missing, or part of the application failed to load or initialise.

actions . . . . :

o If restarting the application or rebooting the PC does not help, uninstalling
the program (from 'Control Panel -> Add or remove programs’) and then
reinstalling it may fix the problem.

Message Cannot read the database because it is of an old version. Please renew the
database.

Description This message normally means that GX Configurator-ST did not install
correctly, or some of the application files or registry settings have been
damaged.

Causes and |e A file is missing, or part of the application failed to load or initialise.

actions

¢ In general, uninstalling the program (from 'Control Panel -> Add or
remove programs') and then reinstalling should fix the problem.
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Message Cannot read the database because it is of a new version. Please update the
application.

Description This message normally means that GX Configurator-ST did not install
correctly, or some of the application files or registry settings have been
damaged.

Cagses and |e In addition to trying to uninstall and reinstall GX Configurator-ST, check

actions that there is only one version installed on the computer. This error could

occur if two versions of the software are installed into the same directory.

Message Application becomes unstable. Please restart.

Description This message may be shown if the application is not able to load a key file.

Cayses and [e If the message is only shown when opening a particular file, the file may

actions be corrupt, have an invalid path, or could have been created by a much

earlier or much later version of GX Configurator-ST.
o If this message is shown regularly, try uninstalling and reinstalling the
application.

Message A MELSOFT application error has occurred. Please restart.

Description This message may be shown if an unknown error occurs, i.e. an error which
does not have its own error message. This is normally related to online
operations or data communications.

Cayses and e This message may just be an unusual communications error. Make sure

actions that the communication link is correct, and that you are connected to the

right SLICE system.

e Check that the configuration being edited does actually match the SLICE
hardware.

¢ Restarting the application may fix the problem.

¢ If this message is shown regularly, try uninstalling and reinstalling the
application.
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Bit output area 9, 12
I n d eX Bit output data 127
Bit outputs 124
Block download of parameters 111
1 Block write - no module selected error 164
= = Block write cancelled error 165
) Br 48,50, 53, 131, 132
Linverity 60, 65 Brn 120, 122, 139
Br.n bit inputarea 9, 12
- A - Bus cycle time 12
Bus refreshing module 8
Al1SJ71PB92D 11 Bus terminator 11
Abbreviations 8 Buttons
About (Help menu) 27 Add 52
Access denied error (file) 153 Delete 52
Add (Edit menu) 77 Toolbar 44
Add button 52 Bw 48,50, 53, 127, 131, 132
Add module dialog 77 Bw.n 15,120, 122, 127, 139
Add modules 77, 79 Bw.n bit output area 9, 12
Add modules using the wizard area 79 Bw.n+1 127
Adding modules 77, 79 Bw.n+2 127
Adding modules with "Add module" 77 Bw.n+3 127
AJ65BT-64AD 9
AJ65BT-64DAI 9 _ C _
AJ65BT-64DAV 9
AJ65BTB1-16D 9 Cable 22
AJ65SBTB1-16D 9 Cancel download 111
A‘],71P592D 1 Cancel forced output test mode error 155
Alignment 67, 69 Cannot access database error 171
All delete 8,5 Cannot add more modules error 157
All delete (Edit menu) 85 Cannot add the head module 160

Already running error 170

Another module is performing online change error
168

Application error 172
Application unstable error
Areas
Information 12
Request 12
Arrange icons (Window menu) 43

_B -

172

Base module 8, 47, 100, 101, 120, 122, 139, 142
Batch write cancelled error 165
Baud rate 106

Bit I/0 range limit exceeded error 157
Bitinputarea 9,12

Bitinputs 124

174

Cannot delete head module error 162
Cannot execute while monitoring active error
Cannot set parameters of this module error
Cannot show detail of module error 152
Cascade (Window menu) 43
CC-Link 8, 48, 104

Change head module (Edit menu)
Change head module type 104
Change to diagnosis mode 116
Changing modules online 139, 141, 142
Channel 94, 96, 98, 113

Channel not selected error (offset/gain)
Check parameters 92, 98

Check power distribution 102

Checking the parameters for errors 98

104

156

Clear 127,139
Clearlog 121,123
Close 40

149

164
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Close (File menu) 57 Creating a new PROFIBUS-DP configuration 55
Close all (Window menu) 43 Creating a new project 55
Close file while forced output test mode active error Creating projects 54
155 Cw 132
Closing the program 40 Cw.n Command execution area 10
Closing the project 57 Cycle time
Columnar writing 67, 75 Bus 12
COM port 106 STbus 10,12
Command 10, 12 Cyclic transmission 9
Command execution area 10
Command parameter 10
Command result area 9 = D =

Communication baud rate 120

Communication error 28 Damaged file error - 152
Communication errors 148 Data
Communication port 108 Vo 12
Communications Input 11

Errors 148 OL_’tpUt 12

Settingup 106 Data link status 9
Communications setup 106 Database error 171
Compare 60 Database version error 171

Default parameters 95
Delete (Edit menu) 84
Delete all (Edit menu) 85

Compare module errors 166
Compare projects 60
Comparing two configurations 60

Compatibility with earlier versions 14 Delete all modules 85

Configuration Deletg button 52
Printing 67 Delet!ng amodule 84
System 22 Deleting all modules 85

Configuration does not match error (verify) 166 Dele.tmg_mod.ules 84, 162
Configuration errors 47, 48, 50 Destination directory 59

Configuration mismatch error 151 Dest!nat!on folder 32 ,
Configuration software 8 Destination module not selected error (verify) 166

Configurations Deta!ls of information grea . 53 .
Comparing 60 Deta!ls of module gonflguratmn window 45
Creating CC-Link 55 Details of module list 48

Creating PROFIBUS-DP 55 Details of rack display 47
Consumption 102 Details of toolbar 44

Contents (Help menu) 27 Details of wizard area 52

Control panel 36 D?agnos?s (Menu mode) 30
Copy 85 Diagnosis mode 30, 38, 93, 116
Copy (File menu) 85 Diagnosis mode operation procedure 30

Copy to file (master station data communication Diagnostics 116

monitor) 133 Errors 150

Copy to file (network parameter monitor) 136 Forced output test 127

Copying module information 85 I/O monitoring 124

Copying modules from another file 85 Input/Output monitor 124

CPU 23 Master station data communication monitor
o 130 130, 133

Cr.n Command result area 9 Module detail information 120

Creating a new CC-Link configuration 55
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Diagnostics 116

Module detail information (head module) 120,

122

Module detail information (other modules) 120,
122

Monitoring 116, 124, 130, 133, 134, 136

Offset/gain settings 113

PROFIBUS-DP network parameter monitor
134, 136

Saving communication data 133

Saving PROFIBUS-DP network parameter
monitor data 136

System monitor 116
Diagnostics errors 150
Diagnostics menu 27

Master station data communication monitor
130

Module detail information 120

Online module change 139

Profibus-DP network parameter monitor 134
Different head module type error 151
Different module configuration error 151
Display position 116
Display switching 42, 43
Documentation layout 3
Download 38
Download cancelled error 165
Download parameters 92
Download parameters as a block 111
Downloading a read only item error 163
Downloading and uploading the parameters 106
Downloading parameters 96
Drag and drop 90
Drop down menu 42

_E -

Edit (Mode menu) 29

Edit footer 71

Edit header 71

Edit menu 26
Add 77
All delete 85
Change head module 104
Delete 84
Delete all 85
Option 99
Parameter setting 92, 93
Power distribution check 102
Rearrange 88

176

Redo 88

Undo 87
Edit mode 29, 93
Edit mode only 42
Edit mode operation procedure 29
Editing the project 77
Environment of MELSOFT 32
Er 132
Er.n 139
Error check (parameters) 98
Error messages 148

Errors 154
0180840b 107, 148
0x0180840b 107, 148

A missing number will be made 159
Access denied (file) 153
Already running 170

Another module is performing online change
168

Application error 172

Application unstable 172

Batch write cancelled 165

Bit I/0 range limit exceeded 157

Block write - no module selected 164
Block write cancelled 165

Cancel forced output test mode 155
Cannot access database 171

Cannot add more modules 157

Cannot add the head module 160

Cannot delete head module 162

Cannot execute while monitoring active 149
Cannot set parameters of this module 164
Cannot show detail of module 152
Channel not selected (offset/gain) 156
Clearlog 121,123

Close file while forced output test mode active
155

Communication 148

Configuration does not match (verify) 166
Configuration mismatch 151

Damaged file 152

Database 171

Database version 171

Destination module not selected (verify) 166
Diagnostics 150

Different head module type 151

Different module configuration 151
Download cancelled 165

Downloading a read only item 163

Failed to read database 171
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Errors 154
File 152
File name too long 153
File not found 153
File sharing violation 153
File version 152
Forced output 154
I/O monitor will be started 151
Initial page no. out of range 169
Insufficient memory 169
Intelligent module limit exceeded 158
Invalid forced output value 157
Memory 169
Messages 148
Missing files 170
Missing power supply module 160
Module addition 157
Module cannot be added at position 159
Module change already in progress 168
Module configuration 160
Module configuration not shown 165
Module copy 157
Module deletion 162
Module different from mounted module 164

Module does not support forced output test
154

Module does not support I/O monitoring 150
Module isn't selected 158

Module limit exceeded 157

Module parameters 163

Module selection 165

Module to delete is not selected 162
Module turning position out of range 169
Module verify (compare) 166

Monitoring will be stopped 152

Multiple instances 170

Must close print preview before exiting 168
Must switch to forced output test mode 155
No file path setting 159

No module selected 150, 164

No module selected (forced output test) 154
No module selected (I/O monitoring) 150
No module selected (offset/gain settings) 155
No module selected (online change) 167
No module selected (options) 165

No module selected (printing) 168

No monitor data to write 150

No output selected (forced output test) 156
No parameters selected 163

177

No power supply module inslot1 160
No print item selected 169

Not enough memory 169

Offset and gain 154

Offset/gain input error 156
Offset/gain settings not supported 155
Offset/gain value out of range 156
Online change 167

Online change not supported 167
Online module change stopped 168
Parameter 163

Power consumption error 161

Power consumption exceeded after adding
module 159

Power supply in slot 1 should have 'H-SET' base
type 160

Power supply in this slot should have 'R-SET'
base type 161

Printing 168

Registry 170

Restart application 172

Send / receive error 149

Source module not selected (verify) 166
Specified module does not exist (verify) 167

ST1X1616-DE1-S1-F required before
ST1X1616-DE1-S1-L 162

ST1X1616-DE1-S1-L required before
ST1X1616-DE1-S1-F 161

Stop monitoring before save 150

Switch mode while forced output test active
154

System 169
Timeout range error (transfer setup) 149
Unknown module 158
W I/O range limit exceeded 158
Window closed during offset/gain setting 156
Word I/O range limit exceeded 158
Wrong head module type 151
X/Y 1/0 range limit exceeded 157

Ew 132

Ew.n 15,113, 124,127, 139

Example printouts 75

Exit (File menu) 40, 57

Exiting GX Configurator-ST 40

Extended cyclic 120

Extended cyclic setting 48

Extended diagnostic information 11

External power supply 8
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_F -

F1lhelp 14,47, 48,50
Failed to read database error 171
Fast user switching 23
FDL address 11, 43, 122
Features 15
File compatibility 14
File errors 152
File menu 26

Close 57

Copy 85

Exit 40, 57

New 55

Open 56

Print 67

Recent files 26

Save 58

Saveas 59

Verify 60, 61, 65
File name 56, 59
File name too long error 153
File not found error 153
File sharing violation error 153
File version error 152
Footer 71
Forced output errors 154
Forced output test 2
Forced output test (diagnostics) 127
Forced output test (Online menu) 127
Function list 25

-G -

G.RDMSG 8

Gain 113

Get input / output data settings 110
Get input/output data settings (online menu) 110
Get system 38, 108

Get system (online menu) 108
Global control 12

Glossary 8

GP.RDMSG 8

GSDfile 11

GX Configurator-DP 11

GX Configurator-ST 8

178

_H -

Hard drive space 23

Head module 2, 8, 47, 55, 90, 116, 120, 122, 130,
138, 139, 141, 142

Change type 104
Changing to CC-Link 104
Changing to PROFIBUS-DP 104
Resetting 138
Header 71
Help menu 27
About 27
Contents 27
Key operation list 147
Hold 127,139
Horizontal writing 67, 75
Howdol... 20
Howto 20

I/Odata 9,12

I/O module 2,8

I/O monitor will be started error 151
I/O monitoring 124

I/O occupation points 48, 50
Information area 12, 45, 53

Initial page no. out of range error 169

Initialize Module Configuration View Position (view
menu) 43, 45

Inputdata 11
Input module 8
Input/output module 120, 122
Input/Output monitor 124
Input/Output monitor (online menu) 124
Insert position 77
Installation 31, 32
Installation procedure 31
Installing GX Configurator-ST 32
Insufficient memory error 169
Intelligent function module 8, 120, 122
Intelligent module limit exceeded error 158
Intelligent modules 113
Interface modules

A1SJ71PB92D 11

AJ71PB92D 11

QJ71PB92D 11
Introduction 1
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Invalid forced output value error 157 Mode 48
Mode menu 27
_ K _ Diagnosis 30
Edit 29
Key operation list (Help menu) 147 Module 157, 160, 162, 163, 166
Key operations list 147 Labg Is 99
Options 99

Keyboard shortcuts 147
y N Module addition 157

Module addition errors 157

- L - Module cannot be added at position error 159
Module change already in progress error 168
Label name 48, 50, 100, 101 Module compare 166
Labels 100, 101 Module configuration 160
Landscape 67,69, 71 Module configuration (View menu) 43
Layout 3,42 Module configuration errors 160
Link special relay 9 Module configuration not shown error 165
List of modules 48, 50 Module configuration window 42, 43, 45, 55, 77,
Local station 9 84, 85
Module copy errors 157
_ M _ Module copying 157
Module deletion errors 162

Master module 8 Module detail information (Diagnostics menu) 120
u Module different from mounted module error 164

Master modules
Module does not support forced output test error
QJ71PB92V 11 154

Master station 9, 11

Master station data communication monitor 130,
133

Module does not support I/O monitoring error 150
Module isn't selected error 158

. L . Module limit exceeded error 157
Master station data communication monitor

(Diagnostics menu) 130 Module list ‘_15’ 48, 77,84
42 Module operating status 9

Maximize i

Maximum input/output points 77, 101, 122 Module options 99

MELSEC-ST system 8 Module parameter errors 163

Memory 23 Module selection errors 165

Memory errors 169 Module status .116, 142

Menu bar 42 Module to dglete |s.n.ot selected error 162
Menu list 26 Module turning position 67

Menus Module turning position out of range error 169

Diagnostics 27 Module verification 166

Edit 26 Module verify (compare) errors 166
File 26 Modules 2, 157, 160, 162, 163, 166
Help 27 AlSJ?lPB92D 11

Mode 27 Add.dlalog 77

Online 27 Add!ng 77,79 .

View 26 Add!ng u§|ng the wizard area 79
Window 27 Adding with "Add module" 77

Adding with wizard 79
AJ71PB92D 11

Base module 139, 142
Changing online 139, 141, 142
Changing order 88, 90

Minimize 42

Missing files error 170

Missing number will be made error 159
Missing power supply module error 160
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Modules 2,157, 160, 162, 163, 166
Checking parameters 98

Copying 85
Copying from another file 85
Deleting 84

Deleting all 85

Downloading parameters 96
Drag and drop 90

Head 2, 8,47

Head module 90, 116, 120, 122, 130, 138,
139, 142

/o 2
Input/Output 77,79
Input/output module 120, 122
Intelligent 77, 79, 94, 113, 120, 122
Master 8
Online change 139, 142
Online change precautions 139
Online change procedures 141
Parameters 92, 93, 96, 98
Power distribution 77, 79, 102, 139
Power distribution module 120, 122
Power supply 47,77
Power supply module 90
QJ61BT11IN 8
QJ71PB92D 11
QJ71PB92V 11
Rearranging 88, 90
Rearranging with drag and drop 90
Rearranging with the rearrange dialog 88
Reorder 88, 90
Replacing 142
Setting parameters 92, 93, 96
ST1AD2-1 113
ST1AD2-V 113
ST1DA1-l 113
ST1DA1-I-FO1 113
ST1DA2-V 113
ST1DA2-V-FO1 113
ST1H-BT 55
ST1H-PB 55
ST1PSD 47,88, 102, 159
ST1X1616-DE1-S1 139
ST1X1616-DE1-S1-F 161
ST1X1616-DE1-S1-L 162
Uploading parameters 96
Verifying parameters 96

Monitor 116

Monitor and test 116

180

Monitoring 116, 130, 133

Monitoring the system 116

Monitoring will be stopped error 152

Mr 132

Mr.n 139

Multiple configurators 38, 42

Multiple instances 38, 42

Multiple instances running 170

Must close print preview before exiting error 168
Must switch to forced output test mode error 155

_N -

n:n verify 60, 61

Network parameter monitor (PROFIBUS-DP) 134
Network parameters 134

New (File menu) 55

New features 13

Next window 42

No file path setting error 159

No module selected error 150, 164

No module selected error (forced output test) 154
No module selected error (I/O monitoring) 150
No module selected error (offset/gain settings) 155
No module selected error (online change) 167
No module selected error (options) 165

No module selected error (printing) 168

No monitor data to write error 150

No output selected error (forced output test) 156
No parameters selected error 163

No power supply module in slot 1 error 160

No print item selected error 169

No. of stations 48, 120

Not enough memory error 169

Notes for upgrading users 14

Number of occupied I/O points 10, 12

Number of stations 48, 120

_0 -

Occupied I/O points 10, 12

Occupied stations 120

Offset 113

Offset / gain settings 113

Offset and gain errors 154

Offset/gain input error 156

Offset/Gain setting (Online menu) 113
Offset/gain settings not supported error 155
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Offset/gain value out of range error 156
Online change errors 167
Online change not supported error 167
Online menu 27
Forced output test 127
Get input/output data settings 110
Get system 108
Input/Output monitor 124
Offset/Gain setting 113
Parameter block write 111
Reset head module 138
Transfer setup 106
Online module change 2, 139, 142

Connection to external device after replacement
145

Disconnect external device 144

Operations after external device connection
145

Preparation for replacing slice module 142
Replacing slice module 144
Online module change (Diagnostics menu) 139
Online module change precautions 139
Online module change procedures 141
Online module change stopped error 168
Online module operation 138
Open (File menu) 56
Opening an existing project 56
Opening projects 56
Operating environment 23, 32
Operating systems 32, 36, 38
Supported 23
Operation history 87, 88
Operation procedures 28
Option (Edit menu) 99
Option setting 99
Options 99
Orientation 67, 69, 71
Output data 12
Output module 8
Overview 15

_P-

Page layout (printing) 71

Page number format 71

Parameter block write 38, 111

Parameter block write (Online menu) 111
Parameter error check 98

Parameter errors 163

181

Parameter setting 93
Parameter setting (Edit menu) 92, 93
Parameter settings 92, 93, 96, 98, 163
Parameter settings dialog 94
Parameters 61, 63, 65, 85

Block download 111

Block write 111

Checking 92

Checking for errors 98

Download as a block 111

Downloading 92, 96, 106

Error check 98

Network 134

Read from device 108

Reset to default 95

Setting 92, 93, 94

Slave 134

Uploading 92, 96, 106

Verifying 92

Verifying edited parameters 96
Point mode 50, 83, 101, 110
Point mode change warning 83
Portrait 67, 69, 71
Power consumption 77, 79, 102
Power consumption error 161

Power consumption exceeded after adding module
error 159

Power distribution check 19, 102
Power distribution check (Edit menu) 102
Power distribution module 8, 77, 120, 122, 139
Power feeding module 8
Power saving function 28
Power supply 102
External 8
Power supply module 47, 77, 79, 90
Power supply modules 102
Precautions 2, 28
Precautions for online module change 139
Preset 127
Preview printing 74
Previous versions 14
Previous window 42
Print (File menu) 67
Print examples 75
Print orientation 67, 69, 71
Print preview 40, 74, 168
Printer setup 69, 71
Printing 67
Examples 75

181

MELSOFT



13 Reference

MELSOFT

Printing 67
Page layout 71
Previewing 74
Printing errors 168
Printing the configuration 67
Procedures for online module change 141
PROFIBUS-DP 8, 50, 104, 110, 134, 136

PROFIBUS-DP network parameter (diagnostics)
134, 136

PROFIBUS-DPVO 11
PROFIBUS-DPV1 11
PROFIBUS-DPV2 11
Project
Editing 77
Printing 67
Project creation 54
Projects
Closing 57
Comparing 60
Creating 54,55
Opening 56
Saving 58
Saving with a different name 59
Verifying 60
Protocol 55

QJ61BT11 9
QJ61BT1IN 8,9

QJ71PB92D 11
QJ71PB92V 11

R -

rack display 45, 47, 77, 84, 90

RAM 96,98, 108, 111

RDMSG 8

Read configuration from device 108

Read only 163

Read parameters 108

Rearrange (Edit menu) 88

Rearrange dialog 88, 90

Rearranging modules 88, 90

Rearranging modules with drag and drop 90
Rearranging modules with the rearrange dialog 88
Recent files (File menu) 26

Recommended speed 106

182

Redo 88

Redo (Edit menu) 88
Registry error 170

Release all 96, 111, 127
Remote desktop 23

Remote device station 9
Remote 1/O station 9
Remote input 9

Remote net Ver. 1 mode 9
Remote net Ver. 2 mode 9
Remote output 9

Remote register 9

Remote station 9

Removing GX Configurator-ST 36
Reordering modules 88, 90
Repeater 11

Replacing modules online 142
Requestarea 12

Reset head module 2

Reset head module (Online menu) 138
Reset the head module 138
Resize 45, 48, 50
Resolution 23

Restart application error 172
Resume 28

ROM 96, 98, 106, 108, 111
RS232 22

RS232 cable 22

RWr 48,53, 120

RWw 48, 53, 120

RX 48,53, 120

RY 48,53, 120

_S -

Safety precautions 2

Save (File menu) 58

Saveas 40

Save as (File menu) 59

Save changes 57,58

Save project with a different name 59
Save the project 58

Saving communication data 133

Saving network parameter monitor PROFIBUS-DP)
136

Saving PROFIBUS-DP network parameter monitor
data 136

Screen layout 42
Scroll bar 47

182



13 Reference

MELSOFT

Segments 11

Selectall 96,111, 127
Select base module 100, 101
Send / receive error 149
Serial port 106

Setting a page layout 71
Setting gain 113

Setting module parameters 92, 93
Setting offset 113
Setting parameters 92, 93, 94

Setting up communications 106
Setting up the printer 69
Setup
Printer 69
Shared files 36
Slave parameter 11
Slave parameters 134
Slave station 11
Slice module 8
Slice No. 10, 12
Slice number 10, 12
Slice position number 10
Slices 53
Software licence 32
Source module not selected error (verify) 166
Specified module does not exist error (verify) 167

ST bus cycle time 10, 12
ST1H-BT 13,55
ST1H-PB 55

ST1PSD 47,88, 102, 159
ST1X1616-DE1-S1 module 139
Standby mode 28
Start menu 32, 38
Start more than once
Start slice No. 10
Starting GX Configurator-ST 38
Station address 43
Station number 120
Stations 48, 120

Local 9

Master 9

Remote 9

Remote device 9

Remote /1O 9
Status bar 43
Status bar (View menu) 43
Stop monitoring before save error 150
Supply check 102
Supply current 102

38, 42
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Supported Operating Systems 23
Suspend 28
Sw 132

Switch mode while forced output test active error
154

Switch to diagnosis mode 116
Switch windows 42
SWnD5C-PROFID-E 11
SWnD5C-STPB-E 8
Symbols used 4
System

Read from device 108
System Configuration 22
System errors 169
System monitor 43, 116
System monitor (View menu)
System monitoring 116

- T -

Target memory 98, 111
Terminator 11
Terms 8
Terms and abbreviations 8
Test 116
Tile horizontally (Window menu) 43
Tile vertically (Window menu) 43
Timeout 106
Timeout range error (transfer setup) 149
Titlebar 40, 42
Toolbar 42, 43, 44
Toolbar (View menu) 43
Toolbar buttons 44
Toolbar icons 44
Topic layout 3
Transfer setup 106, 149
Transfer setup (Online menu) 106
Transmission

Cyclic 9
Transmission speed 122
Turning position 67

- U -

Undo 87

Undo (Edit menu) 87
Uninstallation 31, 36

Uninstalling GX Configurator-ST 36

43, 116
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Unknown module error 158

Upgrading 14

Upload 38

Upload parameters 92

Uploading parameters 96

Use word input data 77, 79, 101, 104
Use word outputdata 77, 79, 101, 104
Using the status bar 43

Using the toolbar 44

_V -

Verify 38, 60

1:n 60,65

n:n 60, 61

Projects 60

Result 63
Verify (File menu) 60, 61, 65
Verify all modules 61, 166
Verify parameters 92
Verify result 63
Verify results 63, 93
Verify selected modules 65, 166
Verifying parameters 96
Verifying projects 60
Verifying the parameters being edited 96
View menu 26, 43

Initialize module configuration view position
45

Module configuration 43
Status bar 43

System monitor 43, 116
Toolbar 43

~\W -

W I/O range limit exceeded error 158
What's new 13
Window 42
Window closed during offset/gain setting error
Window menu 27, 43
Arrange icons 43
Cascade 43
Close all 43
Tile horizontally 43
Tile vertically 43
Window rearranging 43
Windows

184

Module configuration 45
Without Wr 77, 79, 100, 101, 104, 110
Without Ww 77, 79, 100, 101, 104, 110
wizard area 45,52, 79
Word I/O range limit exceeded 158
Word input area 9, 12
Word inputs 124
Word output area 9, 12
Word output data 127
Word outputs 124
Wr 48,50, 53, 131, 132
Wr.n 100, 101, 110, 120, 122, 124, 139
Wr.n word input area 9, 12
Wrong head module type error 151
Ww 48,50, 53, 127, 131, 132

MELSOFT

Ww.n 15, 100, 101, 110, 120, 122, 124, 127, 139

Ww.n word output area 9, 12
Ww.n+1 127

_X -

X/Y 1/0 range limit exceeded error 157

_7 -

Zoomin 74
Zoomout 74
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